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WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and service
conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been defective.
The purchaser is responsible for all transportation charges involving the shipment of materials for warranty repairs.
Failure of any instrument or product due to operator error, improper installation, unauthorized repair or alteration, failure
of utilities, or environmental contamination will not constitute a warranty claim. The materials of construction used in
MICROMERITICS instruments and other products were chosen after extensive testing and experience for their reliability
and durability. However, these materials cannot be totally guaranteed against wear and / or decomposition by chemical
action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and
authorization to return the instrument or product. All repairs or replacements are made subject to factory inspection of
returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are
made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their respect-
ive brand names or trade names. We, therefore, make no express or implied warranty as to such products. We
shall use our best efforts to obtain from the manufacturer, in accordance with his customary practice, the repair or
replacement of such of his products that may prove defective in workmanship or materials. Service charges made
by such manufacturer are the responsibility of the ultimate purchaser. This states our entire liability in respect to
such products, except as an authorized person of MICROMERITICS may otherwise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the discretion
of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves, seals,
etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and stems,
seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such items
which perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of man-
ufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its
products other than the liability stated above. This warranty is in lieu of all other warranties, express or implied,
including but not limited to, the implied warranties of merchantability or fitness for use.
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CONTACT Us

Micromeritics Instrument Corporation
4356 Communications Drive

Norcross, GA / USA /30093-2901

Phone: 1-770-662-3636

Fax: 1-770-662-3696

www.Micromeritics.com

U.S. Inquiries
U.S. Sales Phone: 1-770-662-3636

USSales@Micromeritics.com

Quotes, Orders, and Customer Satisfaction
Customer Service Phone: 1-770-662-3636

Orders@Micromeritics.com

U.S. Instrument Service Department

U.S. Service Department Phone: 1-770-662-3666

ii
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ABOUT THIS MANUAL

The following formats are used throughout this manual:

/ NOTE - Notes contain important information pertinent to the subject matter.

CAUTION - Cautions contain information to help prevent actions that may damage the ana-
lyzer or components.

WARNING - Warnings contain information to help prevent actions that may cause per-
sonal injury.

| I’_,!u Keypad Function - The keypad icon indicates the section is applicable only when using
JLIC )

)
-
[ the keypad.

Field Labels and Screen Titles

Labels and Buttons | Description

Buttons (in the applic- | Buttons in the application are represented as bold font and blue letters —
ation) such as: Save, Edit, and Replace All.

Field Labels Field Labels are represented as italicized words — such as: Sample, Auto-
matically Collected, and Analysis Conditions.

Keyboard Commands |Keyboard commands are represented as bold font and black letters — such
as: F2 and Alt+F4.

Menu Instructions Menu instructions are represented as bold and italicized words — such as:
File > New Sample and Reports > Start Report.
Screen Tabs Screen Tabs are represented as italicized words — such as: Sample Descrip-

tion, Analysis Conditions, and Report Options.

Screen Titles Screen Titles are represented as italicized words — such as: Analysis
Adsorptive Properties, Free Space, and Sample Tube.
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1 ABouT THE AccuPyc Il 1340 PYCNOMETER
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[fi micromeritics
AccuPyc 1340

The AccuPyc Il Pycnometer is an easy to use, fully automatic gas displacement pycnometer. It
determines density and volume by measuring the pressure change of helium within calibrated volumes. It
also reports the chamber temperature at the end of the requested cycles. The AccuPyc Il can be operated
using the analysis program installed on an attached computer, or if no computer is attached to the
pycnometer, the keypad can be used to start and run analyses. The analyzer may be operated in English,
French, German, Italian, or Spanish.

The AccuPyc II Pycnometer consists of a control module and an analysis module. When ordering a
single unit, the control module is built into the same unit as the analysis module for convenience. The
analysis modules are also available in a standalone configuration, allowing multiple analysis modules to
be attached to a single controlling unit. A maximum of five analysis modules can be installed to one
controller (six total). Each module has its own gas connection. The pycnometer can be controlled by
either:

« a Windows interface. The operational status of the pycnometer can be continually monitored in a
status window shown on the computer monitor. If the Windows interface is used, the keypad is dis-
abled.

« the keypad if not running the Windows interface. A separate keyboard and printer can be attached to
the pycnometer using USB ports.

AccuPyc II Operator Manual — (Rev -) 1-1
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ABouUT THE TEC MODULE

Density measurements at specific temperatures are required for certain applications. The AccuPyc 11
Thermo Electric Cooling (TEC) Module maintains an accurate temperature control during analysis using
the principle of Peltier cooling.

TEC Modules, also known as Peltier coolers, are solid-state heat pumps that utilize the Peltier effect to
move heat. By passing a current through the TEC Module, heat is transferred from one side of the
module to the other, typically producing a heat differential of approximately 40° C.

The transferred heat is then removed from the system through the combination of a heat sink and fan,
cooling the system to maintain a set temperature for accurate analysis.

TEC systems feature:
» fast dynamic response
* long-life

* no moving parts
* no use of refrigerants or circulated liquids/antifreeze

ASPHALT DENSITY APPLICATION

The AccuPyc II TEC Module can measure asphalt density using disposable cups to limit cross-
contamination of samples. See ""Asphalt Density Measurement" on page H - 4.

This solution can be closely correlated ( <0.15% difference) to results obtained with ASTM Test Method
D70-09. The AccuPyc asphalt density measurement is completed much faster than the ASTM method
while virtually eliminating operator error. The Peltier thermoelectric cooling control (15 to 36 °C)
provides stability for handling of samples.

Performing an asphalt density measurement requires the AccuPyc II Asphalt software and disposable
sample cups. Refer to "Parts and Accessories" on page 13 - 1 for ordering information.

1-2 AccuPyc II Operator Manual — (Rev -)
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ABoUT THE FoAMPYC MODULE

A FoamPyc option for measuring open and closed cell foam materials is available for both standard and
temperature controlled pycnometers. This unit can be ordered initially with the FoamPyc application
installed, or can be upgraded from the standard AccuPyc with a software enhancement via USB media.
Configuration options are:

o 100 cm3 nominal cell volume (recommended)
o 10 cm? nominal cell volume

The FoamPyc option performs analyses on materials such as polystyrene, urethane, and rubber foams
using five different methods:

o Method A. Measures the closed cell fraction and corrects for the cells damaged while cutting the
sample to the necessary size and shape. This is accomplished by using either the average cell dia-
meter or the cell chord length (as defined in ASTM method D-3576) and the measurements of the
sample to determine the volume of the cut cells. This volume is deducted from the total volume of the
open cells measured by the pycnometer.

o Method B. Corrects for the cut cells by using two separate measurements. For the 2nd measurement,
the sample is recut to double the amount of cut surface. The observed difference in cut open cell
volume is applied as a correction to the initial measured volume. This method offers the distinct
advantage that no assumptions are needed about the relative amounts of open and closed cells.

o Method C. Does not correct for cut cells. It is used for materials with predominantly open cells
where good accuracy can be achieved without correction. The accuracy level deteriorates as the per-
centage of closed cells increases.

o Method D. Is a compressibility test. The fill pressure is increased incrementally over the sample with
each repeat of the Pl,P2l ) cycle. The apparent variation of the measured sample volume with the
average pressure is determined. This test is an approximate indication. It is not intended to be an
exact measure of the volume compressibility.

o Method E. Is a cell fracture test; a perfectly rigid foam is assumed. First, a P1,P2 cycle is performed
at the lower of two specified P1 pressures, and the results stored. A second cycle is performed at a
higher specified value of P1, then a third cycle identical to the first cycle is performed. The dif-
ference between the volume of the sample on the first measurement and on the third measurement is
reported as the volume of fractured cells. It is assumed that cells fracture by exposure to the highest
pressure (2nd cycle) so that when the third measurement is made, the measured sample volume has
decreased from the first cycle by the amount of the closed cell volume which was fractured.

1) Where P1 is the initial pressure to which the sample is charged, and P2 the final pressure after
expansion.

AccuPyc II Operator Manual — (Rev -) 1-3
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The 100 cm3 AccuPyc II has been designed and tested to follow the procedure in ASTM Method D 6226
for FoamPyc analyses. The 10 cm3 and 350 cm? units can be used for some types of foam materials;
however, analyses on these AccuPycs will not conform to the ASTM method. The 1 cm3 AccuPyc II
cannot be used to perform FoamPyc analyses.

The FoamPyc software also provides the capability to perform analyses in the Standard mode of
operation. This is especially convenient for users who have upgraded to the FoamPyc method from the
standard method. For example, a 100 cm® AccuPyc on which FoamPyc analyses are performed and a 1
cm? analysis module attached on which standard analyses are performed.

INSTRUMENT COMPONENTS

FRONT

Sample Chamber

Power
indicator

Keypad

Active
indicator

Display

The sample chamber, located on the top panel, is where the sample container is placed for analysis, or
the standard for calibration.

The sample chamber should remain capped except when inserting or removing a sample. When left
uncapped, water vapor adsorbs on the inner surface of the chamber or the chamber temperature becomes
unstable; either condition can affect analysis results. If water vapor accumulates in the chamber, the
pycnometer must be purged.

The standalone control module, often used for the Glove Box pycnometer, does not contain a sample
chamber.

Component Description

Active indicator A blue LED which illuminates when an operation is in progress. It is included on
all analysis modules. It is not included on standalone control modules.

Display window Displays Remote Operation when the Windows application is being used.
The AccuPyc can be operated in the keypad mode when the Windows application
is closed.

Keypad Not used with AccuPyc software application.

Power indicator A green LED which illuminates when the analyzer is powered on.

1-4 AccuPyc II Operator Manual — (Rev -)
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Rear

REAR

Brightness
controller

Ethernet port
USB port
RS-232 port

Power
connection

Analysis
module

connector

) Gas Inlet
Power switch Port

Component

Description

Analysis module
connector

Used to connect up to five analysis modules to the initial control / analysis mod-
ule. Each module contains analysis module input and output connectors.

Brightness control

Used to adjust the brightness of the display. See ""Brightness Control" on page J
-9

Dust filter (not
shown)

(For 2000 cm? units only.) Traps sample dust to protect internal valves.

Ethernet port

Provides for setting up for e-mailing reports, sending data to a web browser, or
interfacing with the AccuPyc Windows application.

Gas inlet port

Use to connect the analysis gas; helium is recommended. If multiple analysis
modules are attached, each module contains a gas inlet port. Multiple gases can
be attached using the Multigas option. See ""Multigas Option" on page I - 1.

On/Off switch For powering the analyzer on and off.
Power connector | For connecting the power source to the instrument.
RS-232 port Used to transmit data only when using the keypad function.

USB connectors

Use for connecting a keyboard, printer, or balance to the isntrument.

AccuPyc II Operator Manual — (Rev -) 1-5
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ABOUT THE SOFTWARE

The AccuPyc Il Pycnometer’s unique run precision reports data from five consecutive runs that are
within a user-specified tolerance. This feature allows early termination of analyses, thereby decreasing
the number of runs needed for accurate results.

Analysis provides the measurement of sample volume, from which density can be derived automatically
if the sample mass is entered. The unit comes preprogrammed with default conditions and ready to
perform analyses. It can be reprogrammed to meet specific needs. Analyses can be modified by entering
the number of purges and purge fill pressure, number of cycles and cycle fill pressure, equilibration rate,
and run precision. Modifying these parameters allow control of the primary portions of the analysis;
purge and run.

When the PC software is not running, the AccuPyc II can be operated in keypad mode. For example; if
the computer is inoperative for some reason, analyses can be performed using the keypad.

If running the FoamPyc module, an option to select a Standard method is available so that analyses on
other types of sample materials can be performed.

Hardware and software installation instructions are found in "Installation Instructions' on page J - 1.

1-6 AccuPyc II Operator Manual — (Rev -)
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EQUIPMENT OPTIONS

HIGH PRESSURE CORE PYCNOMETER

Gas pycnometry is recognized as one of the most reliable techniques for obtaining skeletal volume and
density. The fully automatic AccuPyc High Pressure pycnometer provides high speed, high precision
volume measurements and density determinations on intact or crushed shale core samples.

The high pressure pycnometer:

o Operates at a pressure of 500 psi to provide a better diffusion of the gas into the rock.
« Has a stainless steel sample chamber with a volume of 100 cm?.

o Has a sample chamber that can accommodate a 48 mm (1.85 in.) diameter core of up to 60 mm (2.40
in.) in length.

LARGE VOLUME CORE PYCNOMETER

The AccuPyc Large Volume pycnometer sample chamber addresses the specific needs of operations that
require pore volume knowledge of intact drilling cores. This instrument eliminates the need to break core
samples into smaller pieces prior to analysis.

The large volume pycnometer:

« Has a large sample chamber with a volume of approximately 2000 cm?.

o Has a sample chamber that can accommodate a 95 mm (3.74 in.) diameter core of up to 278 mm (10.9
in.) in length.

MULTIVOLUME INSERTS

The MultiVolume option is used to analyze smaller sized samples. Options are:

o 1 cm3 nominal cell volume; contains a 0.1 cm? cup

o 10 cm? nominal cell volume; contains 1 cm3 and a 3.5 cm? cups

o 100 cm3 nominal cell volume; contains 10 cm3 and 35 cm3 cups

e 2000 cm?® nominal cell volume, contains 650 cm3 and 1300 cm3 cups

Each kit includes inserts, reference standards, and sample cups. See "Parts and Accessories" on
page 13 - 1.

MULTIGAS OPTION

The Multigas Option allows connection of up to four gases to one analyzer. See "Multigas Option' on
page I - 1 and "Parts and Accessories" on page 13 - 1.
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CONFIGURATION OPTIONS

For best fit with a sample, the AccuPyc II is available in multiple configurations.

/ All sample chamber volumes are nominal unless otherwise specified.

o 1 cm3 sample chamber

o 10 cm? sample chamber

o 100 cm3 sample chamber
e 350 cm3 sample chamber
« 2000 cm?® sample chamber

Best fit means the sample nearly fills the sample chamber and, therefore, optimizes the precision of the
results.

GLOVE Box

Provides for analysis of samples in which a controlled environment is required.

Options Description

Configuration « 1 cm3 sample chamber

e 10 cm? sample chamber
« 100 cm? sample chamber
e 350 cm? sample chamber

¢ 2000 cm? sample chamber

This unit consists of two separate modules. The controller is placed outside the glove box, while the
analysis module is placed inside the glove box. Up to six analysis modules may be placed in the glove
box, all controlled by one external control module.
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Temperature Controlled Module

TEMPERATURE CONTROLLED MODULE

Provides for the attachment of an external circulating bath.

Options

Description

Configuration

e 10 cm? sample chamber

o 100 cm? sample chamber

The temperature controlled unit is specifically designed for temperature sensitive materials. This unit is
ideally suited for laboratories in which ambient temperature varies during normal work hours, or in

which subambient cooling is required.
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SPECIFICATIONS
Characteristic Specification
Analysis
Precision Reproducibility typically to within + 0.01% of the nominal full scale cell
chamber volume. Reproducibility guaranteed to within + 0.02% of the
nominal full scale volume on clean, dry, thermally equilibrated samples
using helium in the 15° to 35 °C range (15° to 50 °C for temperature con-
trolled models).
Accuracy Accurate to within 0.03% of reading, plus 0.03% of sample capacity
Electrical
Voltage 90 to 264 VAC
Power 30 VA
Frequency 50 to 60 Hz
Environment
Temperature Stable between 15° and 35 °C (59° to 96 °F)
Temperature controlled AccuPyc - temperature stability is dependent
upon specifications of the installed circulator. Recommended range: 15°
to 50 °C (59° to 122 °F)
Humidity 20 to 80% relative, non-condensing

Gases

Research grade helium or nitrogen is recommended. If unavailable, use helium with a dew point of -67
°C (-88 °F) or lower. Carbon dioxide, dry air, or argon can also be used for different applications. A
multigas option is available for connection of multiple gases.

Physical

Analysis Module
(1, 10, 100 cm3)

Height. 17.9 cm (7.0 in.)
Width. 22.2 cm (8.7 in.)
Weight. 7.9 kg (17.4 lbs)
Depth. 36.2 cm (14.3 in.)

Analysis Module
(350 cm3)

Height. 25.9 cm (10.2 in.)
Width. 22.2 cm (8.7 in.)
Weight. 10.5 kg (23.2 1bs)
Depth. 36.2 cm (14.3 in.)

Analysis Module

Height. 43 cm (17 in.)

cm idth. cm (10.6 1n.
2000 cm3 Width. 27 10.6 1
Weight. 26 kg (57.0 Ibs)
Depth. 36.2 cm (14.3 in.)
1-10 AccuPyc II Operator Manual — (Rev -)
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Characteristic Specification

Control Module Height. 17.9 cm (7.0 in.)
Width. 27.3 cm (10.7 in.)
Weight. 3.6 kg (8.0 Ibs)

Depth. 36.2 cm (14.3 in.)

Control Analysis Module |Height. 17.9 cm (7.0 in.)
Width. 27.3 cm (10.7 in.)
Weight. 9.3 kg (20.5 Ibs)
Depth. 36.2 cm (14.3 in.)

TEC Module Height. 27.3 ¢cm (10.7 in.)
Width. 28.7 cm (11.3 in.)
Weight. 13.8 kg (30.5 1bs)
Depth. 36.1 cm (14.2 in.)

Printers

Requirements: o must be USB 2.00 (or newer)
« must have a printer language supported by one of the printer drivers

o cannot be host based

Supported printers o Canon Bubble Jet « HPPCL 3
o Epson ESCP « HP PL 6XL
o Epson ESCP Raster o Postscript

e Epson ESCP2

Sample Chamber

1 cm? chamber 1.15cm ID X 1.1 cm Deep (0.45 in. ID x 0.44 in. Deep)
10 cm3 chamber 1.8 cm ID x 3.93 cm Deep (0.72 in. ID x 1.55 in. Deep)
100 cm3 chamber 4.62 cm ID x 6.17 cm Deep (1.82 in. ID X 0.2.43 in. Deep)
350 cm3 chamber 5.84 cm ID % 13.94 cm Deep (2.30 in. ID x 5.49 in. Deep)
2000 cm3 chamber 9.7 cm ID x 26 cm Deep (3.8 in. ID x 10.2 in. Deep)

Computer Requirements

Windows 7 Professional or higher operating system is recommended for the best user
experience. If the computer is to be connected to a network, a second Ethernet port on the
computer must be used for that purpose.

All users of the application will need Read / Write permission to all directories and
/ subdirectories where the application is installed.

In keeping with a policy of ongoing product improvement, specifications are subject to change without
notice.
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POWER THE ANALYZER ON AND OFF

temperature could alter analysis results. We recommend that the pycnometer remain

/ It is important that a constant temperature be maintained inside the unit because a change in
powered on at all times to maintain thermal stability.

Do not turn off the analyzer while initialization is in progress. Doing so may damage the
instrument.

When the analyzer is powered on, after a few seconds, the system vents automatically and the green
indicator light on the front panel illuminates. Allow approximately 30 minutes for the analyzer to warm
before performing analyses. For analyses that require very precise results, allow the analyzer to warm a
minimum of two hours. If running the analyzer with a computer:

o Power ON. Power on the equipment in the following order:

o Computer

o Monitor

o Printer

o Analyzer

o Start software application

o Power OFF. Power off the equipment in the following order:

o Analyzer. Allow any analyses in progress to complete prior to powering off.

o Software application. Always exit the analysis program before powering off. Failure to
do so could result in loss of data.

o Computer
o  Monitor

o Printer

If running the analyzer without a computer:
e Power ON

o Analyzer.
o Power OFF. Power off the equipment in the following order:

o Allow any analyses in progress to complete prior to powering off the analyzer.
o Printer

o Analyzer
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2 Data Entry with Keypad

2 DATA ENTRY WITH KEYPAD

Data can be entered into the system using either a:

o Keypad (or a keyboard). Used if a computer with the analyzer software installed is not connected to
the analyzer. In this case, any section of this manual referring to software can be omitted. All instruc-
tions specific to the keypad are designated with the icon specified in the section ""About this Manual"

on page iii.

o Computer. Used if the computer with analysis software is installed and connected to the analysis
module. In this case, this section of this manual can be skipped.

ABOUT THE DISPLAY

The display provides information about the analyzer and the current operation. During operations,
different types of information are shown in lines two, three, and four. Line one always displays the unit
and serial number. If the Alt key is pressed, the 3 in 10 cm3 will change to a + (plus sign). This is an
example of the display when the analyzer is in an idle state, or the Reload prompt.

Unit[n]> SN 1234> 10 cm3
X - X X

Reload

P = (current pressure)

Line Description

First Displays the unit number, serial number, and nominal cell volume of the
selected unit. Up to five analysis modules may be attached; though the ini-
tial module, containing the keypad and display, will control all units.

Second At the Reload prompt, manual control, or an automatic operation, this line
contains three characters, separated with dashes. The first character
represents the Fill valve, the second represents the Expand valve, and the
third represents the Vent valve.
Valve states: X = Closed, O = Open
During user interface, this line shows the command currently in use.

Third Displays status of the current operation, or Reload when in an idle state.
When the Reload prompt is displayed, this line may also contain an aster-
isk (*), indicating there is a message in the queue. Refer to ""Error Mes-
sages' on page A - 1. During certain functions (such as Setup), this line
contains a prompt for additional information.
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Line Description

Fourth At the Reload prompt, shows the current pressure and temperature
alternately, where:
o P =Pressure
o T = Temperature
This line is also used to choose options, enter information, or provide
information about the current operation.

ABOUT THE KEYPAD

A keyboard can be connected to the USB port on the rear panel of the AccuPyc II. Com-
/ mands can be entered from either the keypad or the keyboard.

Fill Expand Vent Alt

7 8 9 Alt key
Alternate u [_] [_] .’

function [ Anaiyze  Review  Print

e e

Manual SetUp Transmit Escape

Primary @ @

function
Zero Calibrate Unit

oo @

Most keys on the keypad perform one primary and one alternate function. The primary function of any
key is indicated by the number or command on the face of the key. The alternate function is indicated by
the command above the key. The top right corner of the display screen will show a + (plus sign) when
the Alt key is pressed and the alternate function mode is entered. See ""About the Display" on the

previous page.

To select the:

o Primary function. Press only the key. Primary functions are labeled on the key face. For example;
press 4 to enter the number 4.

o Alternate function. Press Alt, then press the key. Alternate functions have blue labels above the
key. For example; press Alt + 4 to start an analysis. If the Alt key is pressed accidentally, pressing it
a second time will cancel its function.

The alternate functions for keys 7 (FILL), 8 (EXPAND), and 9 (VENT) are executed differently. Press
Alt + 1 first to enter Manual mode then press the alternate key. For example: press Alt +1 + 7 to
manually control the Fill valve. Press Alt + CLEAR to exit Manual mode.
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About the Keypad

Functions can be entered from the keyboard.

Keypad and Keyboard Functions

Keypad Function

Key Sequences

Keypad

Keyboard

Description

Decimal (.)

Enter a decimal point, a dash for sample or
instrument ID, a slash for date, or a colon for
time

Number keys ( 0
through 9)

0-9

Enters the numbers 0 through 9

Calibrate

Alt+.
(decimal)

Ctrl+ O

Calibrates the pycnometer.

Zero

Alt+0

Ctrl+Z

Zeroes the pressure transducer.

Manual

Alt+1

Cul+Y

Provides manual control to open and close
valves.

o Fill (Key 7)

o Expand (Key 8)

o Vent (Key9)

Unit[n]> SN 1234>

X - X - X

10 cm3

Reload
P = (current pressure)

The state of the valve is shown on the second
line of the display, where X=Closed and
O=0Open.

Alt + CLEAR exits manual mode.

Set Up

Alt+2

Ctrl + U

Display or edit:

o Analysis parameters

o Report options

« Calibration data

o Data transmission parameters
o Unit types

o Operating language

o Date and time
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Keypad and Keyboard Functions (continued)

Keypad Function Key Sequences Description
Keypad Keyboard
Transmit Alt+3 Ctrl+T Transmits analysis or calibration data. Transmits
a partial report if an automatic operation is in
progress.
Analyze Alt+4 Cul+ A Performs an analysis.
Review Alt+5 Ctrl + R Review completed analysis or calibration data.
Print Alt+6 Ctrl + P Prints an analysis or calibration report. If an auto-
matic operation is in progress, prints a partial
report.
Unit Alt + N/A Selects unit (when multiple analysis modules are
CHOICE + attached).
(unit number)
Escape Alt + Esc Discards all data entered in the current mode
CLEAR and returns to display mode. Cancels an auto-
matic operation in progress. Exits manual mode.
CHOICE CHOICE Ctrl + N Display the next message when in display mode.
Display the next multiple choice item when in
command mode.
CLEAR CLEAR Cul+X Clear a message when in display mode.
Clear an entry when in command mode.
ENTER ENTER Enter or Ctrl + | Complete an entry or begin an action.
M
SAVE SAVE Cul+W Save the information and return to display mode.
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CANCEL AN ANALYSIS

To cancel an analysis, press Alt + CLEAR.

Unit[n]> SN1234> 10 cm3
Analyze
[Enter] to cancel

automatic operation

Press ENTER within five seconds to cancel the operation. A notification that the automatic operation
has been canceled will be displayed.

When canceling an operation, messages are displayed indicating that termination is in progress. The
termination process, which vents the system, takes about 30 seconds and returns to the Reload prompt.

To view the data that have been collected, press CHOICE.

The following prompt is displayed if no cycles have been completed.

Unit[n]>  SN1234>  10cm3
X - X - X
DTA_ERR:

No data to compute

MANUAL MODE

Press Alt + 1 to enter manual mode, allowing manual control of the Bypass, Fill, Expansion, and Vent
valves.

Unit[n]> SN1234> 10 cm3
X - X - X
Manual
p=(pressuz) / \
FiIIvaIve, Expansi'onvalve \/‘entvalve

; The Bypass valve is only available on the 2000 cm? units and the High Pressure Core Pycno-
meter units.
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Display Text Description
Manual When Manual is shown, manually open and close the Fill, Expansion,
and Vent valves by pressing:

e 5- Opens and closes the Bypass valve

e 7 - Opens and closes the Fill valve

o 8- Opens and closes the Expansion valve
e 9-Opens and closes the Vent valve

The three characters in the second line of the display show the state of
the valves (Fill, Expansion, Vent). X = Closed. O = Open.

Press SAVE to exit Manual mode and return to display mode.

/ Prolonged opening of all three valves at one time may cause excessive loss of helium.

TRANSMIT

The AccuPyc RS-232 interface transmits report data to a computer using the standard ASCII file format.
Reports may be transmitted in a single column format or a spreadsheet format. See ""Transmitted Data"

onpage D - 1.

Press Alt + 3 to transmit report data.

Press Alt + CLEAR to cancel report data transmission.
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Analysis Parameters

ANALYSIS PARAMETERS

This option enables specific analysis and calibration parameters. Although the Sefup Type is shown as
Analysis Parameters, these same prompts are used to specify calibration parameters. The pycnometer is
shipped with default values; however, these settings may be modified to meet laboratory requirements.

After each selection, press Enter to display the next prompt. If data results are to be e-mailed
automatically after analysis, specify e-mail parameters in "Setup Reports" on page 2 - 9.

Enter appropriate analysis and report parameters for the current analysis. The chosen or specified
parameters in Set Up determine what prompts and information are displayed for the analysis.

Display Text

Description

Setup Type?
Analysis Parameters

Press ENTER to accept Analysis Parameters.

Number of Purges:

Key in the number of purges to be performed. Purging cleans the sample
cell and expansion chambers before an analysis begins. The greater the
number of purges, the cleaner the sample will be when analyzed.

The range is 0 to 999. For calibration, 10 is sufficient.

Purges Fill Pressure

Key in the fill pressure. For most applications, the default of 19.500 psig
is adequate. Typically, the greater the fill pressure, the easier it is to
measure the volume precisely. However, a lower pressure may be
required for some samples.

The range is psig is 0 to 19.850.
The range in kPag is 0 to 136.86.

Number of Cycles

Key in the number of cycles to be performed. A cycle is a series of
functions which equal to a single volume measurement.

The range is 1 to 999. For calibration, 10 is sufficient.

Cycle Fill Pressure

Key in the fill pressure. For most applications, the default of 19.500 psig
is adequate.

The range is psig is 0 to 19.850.
The range in kPag is 0 to 136.86.

P1, P2 end by?

Choose the manner in which to end the pressure measurement. Press

[selection] CHOICE to make a selection.
The available options are Equilibrate and Fixed interval.
AccuPyc II Operator Manual — (Rev -) 2-7
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Display Text

Description

Equilibration Rate: (Does
not display for Fixed
Intervals)

Select Equilibrate at the P1, P2 end by? prompt. Pressure measurement
will end when the entered rate is obtained. Key in the equilibration rate.

A high rate will produce faster results, but results may not be as precise
as desired. The lowest rates may cause errors when some materials (such
as those with appreciable vapor pressures or organics) are analyzed.

The default setting is 0.0050 psig/min.
The range in psig/min is 0.0001 to 9.0000.
The range in kPag/min is 0.0007 to 62.0500.

Interval Time: (Does not
display for Equilibrate)

Select the Fixed interval at the P1, P2 end by? prompt. Pressure
measurement ends when the specified time is reached. Key in the interval
time.

The range is 10 to 99999 s (seconds).

Use Run Precision?

Allows early termination of the analysis when certain criteria are met.

o Yes. The analysis terminates after five consecutive cycles are within
the specified tolerance. Always request a large number (50 to 99) of
runs. The number of runs is determined through the Number of Cycles
option. With a small number of runs, the analysis stops when the selec-
ted number is reached, even if the specified tolerance has not been
met.

e No. Run Precision is not used.

Percent Full Scale:

This prompt only displays if Yes is selected for Run Precision and more
than five cycles have been requested.

Enter the run precision volume tolerance which is expressed as a
percentage of nominal cell volume (sample capacity).

The range is 0.01% to 50.00%.
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Setup Reports

SETUP REPORTS

The Report Options command enables the report mode (density or volume for analysis) and specification
of the report destination. After analysis or calibration, the display returns to the Reload prompt. An
asterisk (*) in the third line of the display indicates an error message exists.

Unit[n]> SN1234>
X - X
Reload

P = (current pressure)

10 cm3

X

A report is generated automatically to the destination selected at the Setup > Report Options as follows:

o Printer. Report is automatically sent to the printer.

o Transmission line. Report is automatically sent through the serial line to an attached device for this

purpose.

o E-mail. Report is e-mailed to the address specified (when connected to a network).

To view report data by points, use the Review function. See ""Review Data' on page 2 - 11.

Field or Button

Description

Setup Type?
Report Options

Press CHOICE until Report Options is displayed.

Report Options
Anls Display Mode?
Density

Press CHOICE to select Density, Volume or Specific Gravity, the mode
in which the analysis report will be displayed. When Density is selected,
a Sample Mass? prompt displays during the Analysis function. Enter a
value for the sample mass. For accurate data, the sample mass must be
entered when choosing Density.

Report Options
Request Sample ID?

A sample ID (identification) is a unique identifier of the sample. Using
sample IDs can help keep track of data from multiple analyses and can
be used as a date and time stamp. A Sample ID prompt displays during
the analysis operation, allowing entry of the identification when after
selecting Yes to this prompt. Press CHOICE to select Yes or No.

Report Options
Request Description?

Provides entry of additional descriptive information. This prompt
typically is used when a computer keyboard is attached. All system
commands can be executed on the keyboard. Press CHOICE to select
Yes or No.

Report Options
Print Report?

Provides automatic generating of a report after an analysis or cal-
ibration. The type of printer is selected at the Printer? prompt. Press
CHOICE to select Yes or No.
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Field or Button

Description

Report Options
Transmit Report?

Provides transmission of analysis or calibration data automatically after
the operation. Press CHOICE to select Yes or No. See "Transmitted
Data' on page D - 1.

Report Options
E-mail Report?

Select Yes at this prompt to automatically send an e-mail at the con-
clusion of an analysis or calibration operation. An e-mail address and
server must be specified in order to select Yes. Press CHOICE to select
Yes or No.

Report Options
Printer?
[printer name]

Provides selection of the report printer. This is a system option and does
not have to be specified for each analysis (or calibration). It also applies
for all units when multiple analysis modules are attached. Press
CHOICE to select the appropriate printer. See ""Printer Setup' on

page J - 11.

Report Options
Transmission Format?

Select the format of data to be used when transmitting reports. Press
CHOICE to select either the Single Column format or the Spreadsheet
format. See "Transmitted Data" on page D - 1.

Report Options
Request Insert?

Prompts for a MultiVolume insert during analysis or calibration
operations. An insert is a device that can be placed in a sample
chamber, allowing use of a smaller sample cup for analysis of smaller
sample quantities. Inserts are available in MultiVolume Kits for the 1.0,
10, and 100 cm3 pycnometers. Press CHOICE to select Yes or No.

If MultiVolume inserts are not used, select No.

Report Options
Request Cup
Mass?

If Yes is selected, prompts user to enter the mass of the sample cup at
start of analysis.

and analysis.

/

Request Cup Mass? is only necessary if different size cups are used for calibration
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REVIEW DATA

The Review function allows review of and editing of the results of the last operation — analysis or
calibration — along with its entered parameters. It is important to review and print the report before
starting another operation. Data are no longer available for review on the display when another operation
is started; however, data results are saved in the control module and can be reviewed using a web
browser.

Review Data with a Web Browser

Data results for the last five analyses are saved in the control module for each attached unit. These
results can be viewed by accessing a web browser. To use this feature, connect to a network.

1. Press Alt + 2 to access Setup. Then press CHOICE until Communications is displayed.
2. Press ENTER to display a prompt showing that the IP Address mode is DHCP.

/ The display may show Specify, depending on how the IP address was assigned.

3. Press ENTER to view the assigned address on the display. If the address was specified, the dis-
play shows IP Address? and the entered address. This line is editable since it is specified and not
assigned automatically. An assigned address cannot be edited.

4. Make a note of the IP address.

5. Press Alt + CLEAR to return to the Reload prompt.

6. Access the web browser and type in the IP address.

7. Press Enter to display the serial number(s) of the attached unit(s).

(E=8 BB ==
A % ¥
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2 snagit B &1
Index of /2343/

Directories
Parent Directory

Files
untitled-2 html Mon Oct 20 08:37:09 2014 1583 bytes
ed- Mon Oct 20 09:33:00 2014 1583 bytes
Wed Oct 8 09:47:45 2014 917 bytes

untitled-6 html Fri Oct 17 10:38:09 2014 1583 bytes
untitled htm] Fri Oct 17 11:41:03 2014 1583 bytes

Index generated Mon Oct 20 18:38:00 2014 UTC

8. Click on the serial number of the unit containing the data to review. A window displaying the data
files for the last five analyses, and for the zero (slope) and volume offset files is displayed.
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Index of /2343/

Directories

Parent Directorv.

Files

untitled-2 html Mon Oct 20 08:37:09 2014 1583 bytes
untitled-3 html Mon Oct 20 09:33:00 2014 1583 bytes
untitled-5 html Wed Oct 8 09:47:45 2014 917 bytes
untitled-6 html Fri Oct 17 10:38:09 2014 1583 bytes
untitled html Fri Oct 17 11:41:03 2014 1583 bytes

Index generated Mon Oct 20 18:38:00 2014 UTC

The files are in . HTML format and are assigned the name used as the Sample ID. If
sample identifications are not used, Untfitled is assigned and appended for each file.

9. Click the file to view the data results. The progress of a current operation can be monitored by

reloading the page.

R p-ol;% 10 ‘

AccuPyeII 1340 V1.07
Serial Number: 2343
Density and Volume Report

Sample ID: Starced: 20/10/14 08:24:47
Sample Mass: 2.7357 g Completed: 20/10/1¢ 08:57:08
Temperature: 23.0 °C

Number of Purges: 10 Equilibration Rate: 0.0050 psig/min
Cell Volume: 11.7995 cm3 Expansion Volume: L4838 cm3

Volume  Deviation Density Deviation Elapsed Temperature
cyelet g/cm3

1 4. 0.5840

2 4. 0.5%40

3 5.6055 .0013 0.5840

4 4.6055  -0.0013 0.5240

5 4.6068  -0.0000 0.se38

6 4.6069 0.0001 0.5838

7 4.6071 0.0003 0.5838

8 5.6082 0.0012 0.5837

9 4.6085 0.0017 0.5936

10 4.6091 0.0023 0.5935 23.0
Average Volume: 4.6068 cm3 Standard Deviation: 0.0014 em3
Average Density: 0.5938 g/cm3 Standard Deviation: 0.0002 g/cm3

10. Use the File > Print option to print a copy of the results.
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VIEw DATA RESULTS

Press Alt + 5 to view data results.

Reports are generated after analysis and calibration, and remain available for viewing or printing until
another automatic operation (other than zero) is performed. When an automatic operation is performed,
data from the previous operation are no longer available for viewing on the display.

A display report is always generated regardless of the specified destination and contains:
o Analysis. The average density (or volume) and the deviation from the mean.

« Calibration. Average cell (or expansion volume) and the deviation from the mean.
PRINT A FILE

Press Alt + 6 to print a report of the last operation; analysis or calibration. If Alt + 6 is pressed during an
automatic operation, a partial report is printed.

Reports are generated after analysis and calibration, and remain available for viewing or printing until
another automatic operation (other than zero pressure) is performed. Previously generated reports are
deleted whenever a new automatic operation begins.

For each attached analysis module, the data for up to five analyses are stored in the control module.
These data sets can be viewed using a web browser when connected to a network.

An asterisk next to a cycle number indicates that it has not been included in calculations.

o Analysis. Volume, density, deviation for each cycle, an average of all cycles, the date and time the
analysis was started and completed, and the temperature of the cell chamber.

« Calibration. Cell and expansion volumes and deviations for each cycle, an average of all cycles, and
the date and time the calibration started and completed.
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3 ABOUT THE SOFTWARE

The AccuPyc Il Pycnometer’s unique run precision reports data from five consecutive runs that are
within a user-specified tolerance. This feature allows early termination of analyses, thereby decreasing
the number of runs needed for accurate results.

Analysis provides the measurement of sample volume, from which density can be derived automatically
if the sample mass is entered. The unit comes preprogrammed with default conditions and ready to
perform analyses. It can be reprogrammed to meet specific needs. Analyses can be modified by entering
the number of purges and purge fill pressure, number of cycles and cycle fill pressure, equilibration rate,
and run precision. Modifying these parameters allow control of the primary portions of the analysis;
purge and run.

When the PC software is not running, the AccuPyc II can be operated in keypad mode. For example; if
the computer is inoperative for some reason, analyses can be performed using the keypad.

If running the FoamPyc module, an option to select a Standard method is available so that analyses on
other types of sample materials can be performed.

Hardware and software installation instructions are found in "Installation Instructions" on page J - 1.

MENU STRUCTURE

All program functions use standard Windows menu functionality. The title bar contains a Unit Number.
If multiple units (analyzers) are installed, ensure the appropriate unit is selected before continuing.

Main Menu Bar Options

Option Description

File Use to manage files.

Unit [n] Use to perform analyses, calibrations, and other analyzer operations.
A Unit [n] displays on the menu bar for each analyzer attached to the
computer.

Reports Use to run reports and view the results.

Options Use to edit the default method, specify system configuration, and change
presentation options.

Window Use to manage open windows and display a list of open windows. A
checkmark appears to the left of the active window.

Help Provides access to the operator manual and information about the ana-
lyzer.
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COMMON FIELDS AND BUTTONS

The fields and buttons in the following table are located in multiple windows throughout the analyzer
application and have the same description or function. Fields and button descriptions not listed in this
table are found in tables in their respective sections.

Common Fields and Buttons Table

Field or Button Description

Add Log Entry Use to enter information to appear in the sample log report that cannot be
recorded automatically through the application. Click the button again to
enter multiple log entries.

Autoscale checkbox When enabled on report parameters windows, allows the x- and y-axes to
be scaled automatically. Aufoscale means that the x- and y- ranges will
be set so that all the data is shown. If Aufoscale is not selected, the
entered range is used.

Axis Range On report parameters windows, the From / To fields are enabled when
Autoscale options are not selected. Enter the starting and ending values
for the x- and / or y-axes.

Bar Code Enter bar code reader information if a bar code reader is connected to the
computer’s USB port. If a bar code reader is not used, this alphanumeric
field can be used to enter additional information about the sample, such as
a sample lot number, sample ID, etc.

Browse Searches for a file. Select a file from the Name column or from the
library, then click Open. Alternatively, double click the file name to
open (or import) the file.

Cancel Discards any changes or cancels the current process.

Close Closes the active window.

Close All Closes all active windows. If changes were made and not yet saved, a
prompt displays for each changed file providing the option to save the file.

Comments Enter comments about the sample or analysis. Comments display in the
report header.

Delete When working with report parameters, Delete removes the selected
report. Deleted reports will have to be regenerated if deleted in error.
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Common Fields and Buttons

Common Fields and Buttons Table (continued)

Field or Button

Description

Destination group box

o Preview. Previews the predefined report on the screen.
« Print. Sends the report to the default printer.

« Copies. Select the number of copies to print. This field is only enabled
when Print is selected.

« File. Select the destination directory. Enter a new file name in the File
name field, or accept the default. Select to save the file as a report sys-
tem (.REP), a spreadsheet (.XLS), a portable document format (.PDF),
or an ASCII text (.TXT) file format.

Edit When working with report parameters, highlight the item in the Selected
Reports list box and click Edit to modify the report details.

Exit If a file is open with unsaved changes, a prompt displays providing the
option to save the changes and exit or to exit the application without sav-
ing the changes.

Export Exports isotherm data in a sample information file as a .TXT or .XLS

file. When saved to a file, the data can be imported into other applic-
ations.

File name text box

Select a file from either the Name column or from the library. The file
name displays in the File name text box. Click Open or double click the
file name to open the file. To select more than one file, hold down the
Ctrl key on the keyboard while selecting the files, or hold down the Shift
key to select a range of files.

From / To text boxes

When working with report parameters windows, enter the From and To
range for x- and / or y-axes.

List

Provides the option to create a list of sample or report options file inform-
ation, for example, file name, date / time the file was created or last
edited, file identification and file status.

Name column

A list of files in the selected directory or library.

Next Click to move to the next window or next step.

OK Saves and closes the active window.

Open Opens the selected file. Alternatively, double click the file name in the
Name column to open the file.

Prev Click to move to the previous window.

Print Sends the report to the selected destination (screen, printer or file).

Remove Click to remove an item from the list.

Replace Click to select another file where the values will replace the current
file’s values.
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Common Fields and Buttons Table (continued)

Field or Button Description

Replace All Click to select another .SMP file where the values will replace all values
for the active Sample Information file. The original file will remain
unchanged.

Report Click to display a window to specify report output options.

« Start Date. Displays a calendar to select the start date for the report.
o Preview. Previews the predefined report on the screen.
« Print. Sends the report to the default printer.

« Copies. Select the number of copies to print. This field is only enabled
when Print is selected.

« File. Select the destination directory. Enter a new file name in the File
name field, or accept the default. Select to save the file as a report sys-

tem (.REP), a spreadsheet (.XLS), a portable document format (.PDF),
or an ASCII text (.TXT) file format.

Save Saves changes to the active window.
Save As Saves a file in the active window under a different file name.
Start Starts the report, test, analysis, or operation.
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OPTION PRESENTATION

Options > Option Presentation

Use to change the way sample files and parameter files display: Advanced, Basic, or Restricted. Each
display option shows sample information and options differently.

Presentation Display Table

Presentation Display Description

Advanced Displays all parts of sample information and parameter files. Navigate to
parameter windows by selecting the tabs across the top of the window.

Basic Displays sample information in a single window. This display option is
used after the parameter files have been created. The previously entered
or default parameter files are then accessible using drop-down lists.

Restricted Displays the sample information file in a single window similar to the
Basic display option with certain functions disabled. A password is set
when the Restricted option is selected. That same password must be
entered to change to the Basic or Advanced display option. This display
type is typically used in laboratories where analysis conditions must
remain constant — such as the pharmaceutical industry. The Advanced
option is not available at the bottom of the window when using the
Restricted display option.
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FILE STATUS, DESCRIPTION, EXTENSION, AND LOCATION

In the File Selector window, the Mic Description column and the Mic Status column display file
description and file status. The File Selector incorporates standard Windows features for resizing
windows, reordering and repositioning columns, and right clicking an entry to display a menu of standard
Windows functions.

File Status and Description Table

File Status Description

Analyzing Sample information files that are currently being used for analysis.

Complete Sample information files used in an analysis that has been completed.

No Analysis Sample information files which have not been used to perform an
analysis.

File Type, Extension, and Location Table

File Type File Name Exten- | Default Location
sion
Analysis conditions ANC Param Directory
Report options .RPO Param Directory
Sample cup .CUP Param Directory
Sample information .SMP Param Directory
The following file types are available when printing or exporting reports:
Spreadsheet XLS
Unicode TXT
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APPLICATION SHORTCUTS

MENU SHORTCUTS

Shortcut menus are available for:

« the analyzer schematic when manual control is enabled

« onscreen graphs and tabular reports.
KEYBOARD SHORTCUTS

Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations (when
applicable) are listed to the right of the menu item.

Certain menus or functions can also be accessed using the Alt key plus the underlined letter in the menu
command. For example, to access the File menu, press Alt + F, then press the underlined letter on the
submenu. For example, Alt + F opens the File menu, then press O to access the File Selector for
opening files.

If the underscore does not display beneath the letter on the menu or window, press the Alt
key on the keyboard.

Keyboard Shortcut Table

Key Description

F1 Access the operator manual.

F2 Opens the File Selector window listing sample information files.
F3 Opens the File Selector window listing analysis conditions files.
F5 Opens the File Selector window listing report options files.

Fé6 Tile windows.

F7 Cascade windows.

F8 Start a report.

F9 Close all open reports.

Alt + F4 Exit the program.

Shift + F2 List sample information files.

Shift + F3 List analysis conditions files.

Shift + F5 List report options files.
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SAMPLE DEFAULTS

Options > Sample Defaults

A Sample Default determines the default sample identification format and sequence number. A Sample
Default is a template of specifications that go into a newly created sample file. It allows for the
definition of complete sets of parameters for each type of sample commonly analyzed, so that only a
single selection is required for each new sample file created.

EDIT A SAMPLE DEFAULT FILE

Options > Sample Defaults

See ""Create Sample Files using Advanced Presentation Option" on page 4 - 2.

ANALYZER STATUS

SHOW INSTRUMENT LOG

Unit [n] > Show Instrument Log

Use to display a log of recent analyses, calibrations, errors, or messages.

Instrument Log Fields and Buttons Table

Field Description

Analysis / Select the logs to display.
Calibration /

Message

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

3-8 AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



[M] micromeritics’

Show Instrument Schematic

SHOW INSTRUMENT SCHEMATIC

Unit [n] > Show Instrument Schematic

Use to display an analyzer schematic. To operate the valves and elevator from this window, manual
control must be enabled (Unit [n] > Enable Manual Control).

Sample Expansion

chamber \ chamber

Expansion Sample

chamber / chamber

18,500 psig

10, 100, and 350 cm? unit

Analyzer Schematic Icon Table

1 and 2000 cm? unit

Icon or Symbol |Description

Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve with manual control enabled.

Closed Valve. White indicates a closed valve with manual control not enabled

s e

Sample Chamber.

L

Expansion Chamber.

20.5 psig max.

| 28.00 °C|

[ 18500 psig] Pressure and temperature re?dings. Disp.lays for eith.er the expansion chamber
or the sample chamber, depending on the unit configuration.

! Gas flow direction.
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Instrument Schematic Shortcut Menus

Each manually controlled schematic component has a shortcut menu displaying the operations available
for that particular component. To access the shortcut menu, hover the mouse pointer over the component
and right click.

Schematic Shortcuts Table

Schematic Shortcut Icon | Available Options:

Valve options ¢ Close. Closes the selected valve.

o Open. Opens the selected valve.

SHow STATUS

Unit [n] > Show Status

Use to show the current status for each port. If multiple units are attached to the computer, go to Unit [n]
> Show Status for the indicated unit.

Sample: Pressure: 18.500 psig
Operation: Idle Temperature: 28.00 "C
Elapsed Time: Cycle:

Equilibration:

Density:

Sow Status Fields and Buttons Table

Field or Button Description

Cycles The current cycle and the number of cycles requested. For example, 2
(current) of 10 (requested).

Density Last computed density and standard deviation, if applicable.

Elapsed Time The elapsed time of the current step.

Equilibration The measured equilibration rate and the limit.

Operation The operation, task, and the step in progress.

Pressure The pressure in the sample chamber.

Sample The name of the sample file being analyzed.

Temperature The temperature of the sample chamber.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
/ tion of this operator manual.
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PRINT, LIST, OR EXPORT FILES

File > Print > [File Type]
File > List > [File Type]
File > Export > [File Type]

===

‘yele Data [l D
1k "™ These fields display only
i ey« When using File > Export

Files:

Directories:

000-004_smp  000-004 Bi=]
000-010.smp  000-010 —|Fe1
000-016.smp  000-018 [-d]
000-017 smp  000-018 4]
000-018.smp  000-018
000-019.smp  000-020
000-020 smp  000-020
000-021.smp  000-024 -
000-022.smp ~ 000-024
000-023 smp  000-024

000-024 smp  000-024
TANRAZS. mn SN 968 1ce Valime: Check Jﬂ

=

File Print, List or Export Fields and Buttons Table

Field or Button Description
Date Range Click to filter by a date range.
(El Select Dates ﬁ
" Show Date Range:
iz )l 1170171550 [
LCancel
Directories: Displays directories where files are found.
c:\...\data
Export Type (Export fea- | « Cycle Data. Exports as five columns containing the elapsed time, P1
ture only) (fill pressure), P2 (expansion pressure), Volume, and Temperature.
o P[n] Equil Data. Exports as one column of equilibration data.
File name Enter the name of a new sample file.
File Type (Export feature | Select either .XLS or .TXT.
only)
Files Displays the files that fit the search criteria. To select more than one file,

hold down the Ctrl key on the keyboard while selecting the files, or hold
down the Shift key to select a range of files.
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File Print, List or Export Fields and Buttons Table (continued)

Field or Button Description

Status To filter by file status, select a status from the drop-down list.

« All Displays all files

« Analyzing. Sample information files that are currently being used for
analysis.

« Complete. Sample information files used in an analysis that has been
completed.

« No Analysis. Sample information files which have not been used to
perform an analysis.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

OPEN A FILE

File > Open > [File Type]

When working with an existing file, it is recommended that a copy of the file be used rather
than the original.

7 | Open Sample Information File x|

File name: |000-000.SHP

Selection Criteria

Status: |All j
Date Range...
Directories:

Files: c:h_Adata
gamet_smp Garnet Powder J 11
glass.smp Glass Powder [-c]
refanly.smp  REFANLY [d]

I-o-]

Fields and buttons will vary depending on the file type selected.
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Field or Button Description

Date Range Click to filter by a date range.

(ﬂ Select Dates ﬁ

Directories: Displays directories where files are found.

c:\...\data

File name Enter the name of a new sample file.

Files Displays the files that fit the search criteria.

Status To filter by file status, select a status from the drop-down list.

o AlL Displays all files

o Analyzing. Sample information files that are currently being used for ana-
lysis.

o Complete. Sample information files used in an analysis that has been com-
pleted.

o No Analysis. Sample information files which have not been used to per-
form an analysis.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

UNINSTALL THE SOFTWARE

When the software is uninstalled, only the files required to run the application are removed. Parameter
files, sample files, reports, calibration files, and data files are not removed.

1. Insert the Setup CD into the CD drive.

2. Select the Uninstall option.

3. Follow the prompts.
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INSTALLING ANALYZER SOFTWARE UPGRADE

To install software upgrade on the AccuPyc Il module:

1. Turn the On/Off switch on the rear panel in the Off ( O ) position.

2. Insert the USB stick containing the software update into one of the USB connectors on the rear
panel.

3. Place the On/Off switch in the On (| ) position.

4. After approximately 1-2 minutes of initialization, the software starts to load. The following prompt
is displayed:

Updating Application
from USB Media

5. Once the software is successfully installed, the display will read:

Update Successful
Remove USB Media

6. Remove the USB stick and store in a secure location.
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4 ABOUT SAMPLE FILES

Sample files include the information required by the analyzer to perform analyses and collect data. It
identifies the sample, guides the analysis, and specifies report options and may be created in either
Advanced, Basic, or Restricted presentation display option.

A sample information file can consist of parameter sets; however, parameter sets can also stand alone.
A sample information file may be created either prior to or at the time of analysis.

Parameter sets allow repeated use of the file. For example, if the same analysis conditions exist for
multiple analyses, an Analysis Conditions file containing the recurring conditions can be created. When
the sample file is created, the Analysis Conditions file can be selected for the analysis conditions. Once
it becomes part of the new sample file, the new file can be edited as needed without affecting the
original Analysis Conditions file.

The analysis software contains a sample default method. A default method is a template for sample files
that contains the parameters to be used for an analysis. When a new sample information file is created,
all the parameters are filled with the values in the sample default. See ""Create Sample Files' on the

next page.

Specify or change the default presentation option by selecting Options > Option Present-
/ ation, or sclect Basic or Advanced from the drop-down list at the bottom of the window.
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CREATE SAMPLE FILES

CREATE SAMPLE FILES USING ADVANCED PRESENTATION OPTION

-0 x| -0 x| -0 x|
<< Prev ‘[Samv\ew aaaaaaaa }Ana\ys\s[and \\\\\\ {R eeeee Optons H «Prev ‘[Samp\ew aaaaaaaa WAna\ys\sEand \\\\\\ {R eeeee Dptions. H <<Prev ‘[Samp\ew aaaaaaaa WAna\ys\sEand \\\\\\ {R eeeee Dptions. H
Sample: Sample: Sample:
Operator Operator

ters
0.000
0.000

ters
0.000
0.000

Parameter R ( ‘Geometry. | [[Porometer 3 [ oo00 j
Connents Add Log Entry ‘ B Add Log Entry o _Add Log Enty |
Replace A Replace A Replace A
\ \ \
Save. Close Basic Save. Close Basic Save. Close Basic
Standard Asphalt FoamPyc

Each analysis must be linked with a sample information file before the analysis can proceed. A sample
information file can consist of parameter files; however, parameter files can also stand alone. See
"About Parameter Files' on page 5 - 1.

Specify or change the default display option by selecting Options > Option Presentation or click Basic
or Advanced at the bottom of the window.

The values specified in the parameter portions of the default sample file are saved as the defaults for
new sample files. To navigate from one set of parameters to another, select the parameter tab across the
top of the window.

Go to Options > Option Presentation > Advanced and ensure Advanced has a checkmark.

Go to File > Open > Sample Information.

Enter a new file name in the File name text box. Click OK.

Enter a sample description in the Sample text box.

A e

Enter Operator, Submitter, and Bar Code identification information in the respective text boxes.
This information will display on the Sample Information tab of new sample files. This option may
not display (or may have a different field label) if modified in the sample default method. See
""Sample Defaults" on page 3 - 8.

6. If running the TEC module, select the Sample Cup from the drop-down list and enter the cup mas
in the Cup Mass field. See "Sample Cup " on page 4 - 5. If not running the TEC module, skip this
step.

7. Inthe Sample Mass field, enter the sample mass.

8. Click Material Parameters to specify material parameters using the Standard method. See
""Material Parameters' on page 4 - 6.

9. The optional user-defined fields in the User Parameters group box may be used to enter and track
information from another analyzer or source, along with other statistical process control (SPC)
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Create Sample Files using Advanced Presentation Option

10.

I1.

12.

13.

14.

data.

Enter any pertinent information about the sample information file in the Comments text box.
Entered comments are displayed in the report header.

Click Add Log Entry to enter notes for the analyzer log report. Create entries that cannot be
recorded automatically through the software.

To auto-populate fields from another .SMP file, click Replace All, then select a .SMP file that
contains the preferred parameters. Select the file, then click OK.

After completing the Sample Information tab, click the other parameter tabs to edit more sample
information file parameters See ""About Parameter Files" on page 5 - 1.

Click Save, then click Close. To save as a different file name, go to File > Save As and enter a
new file name. The file can also be saved as a different file type such as Analysis Conditions,
Report Options, etc.

Sample File Fields and Buttons Table

Field or Button Description
Cup mass Enter the cup mass.
Geometry * Enter material properties when using the FoamPyc Method.
CSSmpGemety) x|
R S

Active Area (method A only): 1.0000 |cne] Chord Length: 10000 om
Ccell
Coll

 Compute

 Cube

dge gt [ 7.0000 on Humben of Sk [——-

=

« User Computed. Select to enter the geometric volume and when
using Method A, the Active Area. Active Area is the total geometric
surface area of the sample - excluding any sides that contain a skin.

« Compute. Select the shape of the sample and enter the dimensions.

o Number of Pieces. The number of pieces making up the sample.

Operator Enter operator identification information. This field label may have been
renamed or may not display if modified in Options > Sample Defaults.

Sample Enter a sample description.

Sample cup Select a sample cup file from the drop down list or click Edit to create
and save a new file for sample cup properties. See "Sample Cup " on
page 4 - 5.

AccuPyc II Operator Manual — (Rev -) 4-3

134-42800-01 — Dec 2014



4 About Sample Files

[M] micromeritics®

Sample File Fields and Buttons Table (continued)

Field or Button

Description

Sample mass

Enter the sample mass.

Submitter

Enter submitter identification information. This text box may have been
renamed or may not display if modified in Options > Sample Defaults.

User Parameters group
box

These fields are primarily used for the SPC (Statistical Process Control)
reporting to specify sample characteristics or its manufacturing process
but may be used for other data by entering specific analysis conditions or
sample criteria.

The entered parameters display on the Summary Report. This option may
not display (or may have a different field label) if modified in the through
Options > Sample Defaults.

* Option displays only in the FoamPyc application.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
/ tion of this operator manual.

CREATE SAMPLE FILES USING BASIC OR RESTRICTED PRESENTATION OPTION

File > Open > Sample Information

The Basic and Restricted formats use predefined parameter files to create a sample information file.

When using the Basic presentation option, switch to Advanced to edit parameter file values.
/ When using the Restricted presentation option, parameter files cannot be edited.

N kD=

Go to Options > Option Presentation > Basic (or Restricted).

Go to File > Open > Sample Information.

Enter a new file name in the File name text box. Click OK.

In the Sample field, enter a sample description.

In the Sample mass field, enter the sample mass.

Click the down arrows to select default parameter files Analysis Conditions and Report Options.

Click Material Parameters to specify material parameters using the Standard method. See

"Material Parameters' on page 4 - 6.

*®

In the Selected Reports list box, double click reports applicable to this sample file.

9. Click Save, then click Close.
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Sample Cup

SAMPLE CUP

File > Open > Sample Cup

(or click the Sample Information tab when in Advanced presentation display)

Use to set the sample cup mass and density. This option is available if enabled in Options > Option
Presentation > Show Cup Properties.

o =10 x|
| Sample Cup Properties
Sample Cup: |Sample Cup Properties Replace___
ﬂas::l 0.0000 g
Density: I 2.7000 gfcm?®
Save Close

Sample Cup Properties Fields and Buttons Table

Field or Button

Description

Density Enter the density of the sample cup.
Mass Enter the sample cup mass.
Sample Cup Enter a description of the sample cup.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

To have multiple cup selections available in the Sample Cup drop down list:

. Go to File > Open > Sample Cup.

. Enter a file name, click OK.

1
2
3. Complete the fields for the new sample cup.
4

. Click Save and the selection will be available in the Sample Cup drop down list.
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MATERIAL PARAMETERS
File > Open > [.SMP File]

Click Material Parameters on the Sample Description window. Material parameters are used to report
porosity or total solids concentration when using the Standard analysis method.

m Material Parameters ﬂ

Porosity and Pore Yolume

{* Envelope Density I 1.0000 g/cm®
" Bulk Density I 1.0000 | gfcm®

Total Solids Concentration

Liquid Density I 1.0000 gfcm?®
Solids Density I 1.0000 gfcm®

Cancel

Material Parameters Fields and Buttons Table

Field or Button Description

Bulk Density / Envelope Calculated from a volume that includes pores.
Density

Liquid Density Density of the liquid.

Solids Density Density of the solid sample.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.
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5 ABoUT PARAMETER FILES

Parameter sets allow repeated use of the file. For example, if the same analysis conditions exist for
multiple analyses, an Analysis Conditions file containing the recurring conditions can be created. When
the sample file is created, the Analysis Conditions file can be selected for the analysis conditions. Once
it becomes part of the new sample file, the new file can be edited as needed without affecting the
original Analysis Conditions file.

The following file types can exist as part of the sample information file as well as individual parameter
files:

File Type File Extension

Analysis Conditions .ANC file extension
Material Parameters .MTP file extension
Report Options .RPO file extension
Sample Cup .CUP file extension

PARAMETER FILES DIRECTORY

Options > Parameter Files Directory

Use to select the location for the predefined parameter files displayed in the drop-down lists when using
the Basic or Restricted presentation option. This configuration option is not available if using the
Restricted presentation option.

The system default directory is the recommended location for saving report options files.
/ The default directory is ..\param, if accessed from the top-level installation directory.
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ANALYSIS CONDITIONS

File > Open > Analysis Conditions

(or click the Analysis Conditions tab when in Advanced presentation display)

=10l x|

Analysis Conditions

anditions [Reference Analysis

ofpurges: [ 10
we [ 19500 psio
we: [ 19500 peig

End equilibration by:

" Time

I Use

Percent full scale:

ecord P1 eguilibration data

Record first: |5 | cycles

Record last: [ 50p | points

Replace.

 Rate 0.0050 psig/min
10)s

0.03 %

=lolx|
Analysis Conditions
Analysis Conditions [Reference Analysis | Replace.
Analysis gas: [Helium | End equilibration by:
Ny urges: 10  Rate 0.0050 psig/min

" Time

re: 19.500 psig 105
10 ¥ Use n o
re: 19.500 psig Percent ful

e- [ 0.03/%

@ Standard A B D CE

I” Record P2 eguilibration data
Record first: [ 5] cycles

Record last: [ 500 points

Entera value between 1 and 999,

Save Close

Entera

value between 1 and 999,

Save Close

Standard application
Asphalt application

FoamPyc application

Analysis conditions specify the data used to guide an analysis.

1. Go to File > Open > Analysis Conditions and open the analysis conditions (.ANC) file.

2.

Click Replace to overwrite analysis conditions with parameters from another Analysis Conditions

file. Select the file containing replacement parameters and click OK.

3. Use the Analysis Conditions Fields and Buttons Table to complete the remaining options.

4.

Click Save, then click Close.

Analysis Conditions Fields and Buttons Table

Field or Button

Description

Analysis Conditions

Displays the description of the file. If this is a new file, the
description specified in sample defaults is displayed.

Analysis gas

The gas to be used for analysis gas (helium is recommended).

Analysis method

See "FoamPyc Application' on page 5 - 4.

Cycle fill pressure

Enter the fill pressure for the cycles. Typically, the default of 19.500
psig is appropriate for most samples.

End equilibration by:

Rate. Equilibration ends when the rate of pressure change drops
below the entered amount.

Time. Equilibration ends when the specified time interval is
attained.

Number of cycles

The number of cycles to be performed. A cycle is a series of func-
tions which equals to a single volume measurement.
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Analysis Conditions

Analysis Conditions Fields and Buttons Table (continued)

Field or Button

Description

Number of purges

The number of purges to be performed. A higher number of purges
will mean a cleaner sample.

Percent full scale

Enabled when Use run precision is selected. Enter the run precision
volume tolerance which is expressed as a percent of nominal cell
volume (sample capacity).

Purge fill pressure

The purge fill pressure (in psig or kPa). For FoamPyc analyses, the
typical pressure is 3.5 psig. For analyses on standard samples, the
measured volume is more precise if a greater fill pressure is used.
The default of 19.500 is appropriate for most standard analyses. Some
materials, such as organic polymers, may require a lower pressure in
order to limit permeability into the sample matrix.

Record P1 equilibration data

Record P2 equilibration data

o Record first. Enter the number of cycles to be recorded at the
beginning of the analysis.

« Record last. Enter the number of points to be recorded at the end
of equilibration.

Use run precision

Select to use run precision. This feature provides early termination of
the analysis when certain criteria are met. The analysis terminates
after five consecutive cycles are within the specified tolerance. Typ-
ically, a large number (50 to 99) of cycles is requested. If a small num-
ber of runs is selected, the analysis stops when the entered number is
reached even though the specified tolerance has not been met. If
fewer than five cycles are requested, this feature is disabled. See
"Run Precision' on page B - 6.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

AccuPyc II Operator Manual — (Rev -) 5-3

134-42800-01 — Dec 2014



5 About Parameter Files

[M] micromeritics’

FOAMPYC APPLICATION

1. Select File > Open > Analysis Conditions to display the Open Analysis Conditions File dialog.
Enter a name in the File name field, then click OK.
Click Yes to create the file; the Analysis Conditions dialog is displayed.

Enter a description in the Analysis Conditions field.

ARSI

Complete the following fields:
o Number of purges

o Purge fill pressure
o Number of cycles
o Cycle fill pressure

6. Choose whether to have equilibration end by rate or time, then enter a value in the adjacent field.

7. If using the run precision feature, select the option and enter an appropriate value in the Percent
full scale field.
8. Choose the Analysis method for this file, then complete the fields that display for that method.

Analysis Methods (FoamPyc Only)

Choice Required Action

Standard Select Record equilibration data then enter the criteria (if recording equilibration
data).

A,B,or C Enter the Resin density.

D Enter the initial and final pressure, and the pressure increment.

Enter Resin density.

E Enter the Low pressure and the Fracture pressure.

Enter Resin density.

9. Click Save, then Close.
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Report Options

REPORT OPTIONS

File > Open > Report Options

(or click the Report Options tab when in Advanced presentation display)

created or selected from within the application.

/ If using the FoamPyc application, reports for all FoamPyc Methods are fixed and cannot be

o/

Report Options

v Show graphic

Overlays.__ |

¥ Show report title |

Report Options |De[ault Report Options

Replace...

Graphic

|miclngo.em[
Height I 0.250  in

Selected Reports

Combined Report

45 p Report

Volume vz Cycle #
Density vs Time

Density vs Cycle #
Options Report

P1 Equilibration
P2 Equilibration
Sample Log

+ Density and Yolume Table
Presszure and Yolume Table -
Edit._.

Total Pore ¥olume vs Temperature

Browse.._

Width 2.000 in

Save

Cloze

Report options specify the types of reports to be generated from an analysis and allow for customization
of reports such as axis scale, axis range, and column headings.

Report Options files can be customized to accommodate standard analysis requirements. Reports can be
generated automatically after each analysis or at any time during or after an analysis. A report generated
during an analysis only includes data collected up to the time of the report.

Report Options files may be defined to include overlay options. This system allows the overlay of up to 8
plots of different samples onto a plot of the same type or overlay one plot type onto a different plot type
from the same analysis. See "Graph Overlays" on page 7 - 20.

1. Go to File > Open > Report Options and open the report options (.RPO) file.

2. Click Replace to overwrite report options with parameters from another Report Options file.
Select the file containing replacement parameters and click OK.

3. Use the Report Options Fields and Buttons Table to complete the remaining options.
4. Click Save, then click Close.
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5. The Selected Reports list box displays the reports that may be generated.

o To include a report in this file, double click the report name and ensure a check mark

appears to the left.

o To specify report options, highlight the report in the Selected Reports list box, then click
Edit. Make changes as necessary. Click OK. See "Selected Reports" on page 8 - 1 for

details.

8. Click Save, then click Close.

Report Options Fields and Buttons Table

Field or Button

Description

Overlays

Click to open the Graph Overlay Samples window. Click Browse to
select sample files to overlay into a plot. See "Graph Overlays' on

page 7 - 20.

Report Options

Displays the description of the file. If this is a new file, the description
specified in sample defaults is displayed.

Selected Reports list box

Select the report names to include in the report.

Show graphic

Use to show a graphic on the report header. Click Browse to locate the
graphic.

« Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title

Select and enter a report title to appear on the report header.

; For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.
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The Collected Data tab displays after an analysis has been completed.
= N =]
<< Prev ( Sample Information [Analysis Conditions [ Report Options [ Collected Data 1 Next z>
Elapsed P1 P2 =]
Time Pressure Piessuie ‘Wolume Temperature -
[mm:ss] (psig] [psig) [er] [EE; Exclude
1 736 19,807 9873 27418 272
| 2] 555 19834 9690 22446 2374
BER 1228 19,784 9,668 22410 2375
| 1506 19812 9,002 22418 2277
| 5| 17:43 19817 2,683 22423 2378
6 | 2011 19849 9698 22437 2380
| 7 | 2226 19907 9928 22434 2383
| 5 | 2450 19,900 9923 22457 2383
R 27:20 19,867 2809 22417 2385
B 2946 19,850 4800 22428 2387
Chamber Insert: = None Cell Volume: [ 11.2990 cn®
: ?3 Z$ Expansion Volume: I cm®
Enter a value between 0.5000 and 9399.9999.
Save Close Basic
Collected Data Fields and Buttons Table
Field or Button Description
Cell Volume Nominal cell volume for the unit or for the selected insert.
Chamber Insert Select the chamber insert size, if applicable. Options will vary depending

on the type of unit being used.

Values in the Volume column are recalculated automatically if the
Chamber Insert selection is changed.

Expansion Volume Expansion volume for the current unit or for the selected insert.
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Collected Data Fields and Buttons Table (continued)

Field or Button

Description

Pressure Table Columns

Displays information collected during analysis:

Elapsed Time

P1 Pressure (fill)

P2 Pressure (expansion)
Volume

Temperature

Exclude. Click the cell for each cycle to exclude in the average cal-
culations. An x in the cell indicates the cycle will be excluded.
Excluded parameters are marked with an asterisk (*) in the generated
report.

; For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.
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6 PERFORM AN ANALYSIS

An analysis can be performed from either the computer application or directly from the keypad on the
analyzer. If using the keypad only, see ""About the Keypad' on page 2 - 2.

See "Handling System Components' on page J - 1.

PREPARING AND LOADING SAMPLE

FoAmMPYCc METHODS

FoamPyc Methods are intended to conform to the procedures detailed in ASTM Test Methods D-6226
and D-3576. Prepare samples according to the methods outlined in these procedures. Once the sample is
prepared and placed it into the sample chamber, see "Start an Analysis' on page 6 - 3.

STANDARD METHOD

Samples must be properly prepared to obtain accurate results. Samples must be free of moisture in order
to obtain true sample mass and to avoid the distorting effect of water vapor on the volume measurement.
The following procedures are recommended; however, modifications may be necessary for some
materials.

o Heat-sensitive materials may have to be dried by long-time exposure to silica gel, freeze drying, etc.

o Materials having a low melting point may be dried using the purge process. In this case, do not weigh
the sample and cup until after the purge and analysis have been completed.

Avoid exposure of the dried sample to atmospheric moisture during each step of the preparation process.
This means weighing as rapidly as possible and installing in the instrument without unnecessary delay.

Keep the cap on the cell chamber except when actually inserting or removing a sample. If
the chamber remains uncapped, water vapor will adsorb on the inner surface of the chamber
and temperature instability will occur; either condition can affect analysis results.

1. Weigh the empty sample cup.

2. Place as large a quantity of sample as is possible in the cup (cup should be two-thirds full). Pack
powders and fluffy materials (if permissible) to obtain maximum sample weight in the cup.

3. Place the sample cup with sample in a drying oven. The amount of time the sample must be
heated depends on the material and the temperature it will tolerate; this may have to be estab-
lished by other tests.

4. Remove the sample cup from the oven and transfer it to a desiccator provided with active desic-
cant. Allow it to cool until near room temperature. Minimize air exposure of the sample.

5. Use this equation to determine the sample mass. (If volume only is to be measured, skip this step.)
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Mass

- Masssample#cup N cup

Mass =
sample

6. Remove the cell chamber cap, place the sample cup (with sample) into the cell chamber, then
replace the cap.

It is best not to lay the cap down while loading the sample. Immediately replace the cap when the
sample is loaded. This will prevent particles from accumulating on the greased surface (see
"Handling System Components'' on page J - 1 for guidelines on handling system components).

7. If using a temperature-controlled AccuPyc, perform the following steps before proceeding, see
"Start an Analysis"’ on the facing page.
a. Turn on the bath circulator and specify the temperature for analysis. (Refer to the man-
ufacturer manual for instructions on operating the bath circulator.)

b. Allow the temperature to stabilize to the set temperature. Observe the temperature reading
on instrument schematic.

8. If using a TEC module, ensure the temperature reading has stabilized at the specified point.
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Start an Analysis

START AN ANALYSIS

START AN ANALYSIS USING THE SOFTWARE

Unit [n] > Sample Analysis

After the sample has been properly prepared and loaded into the sample chamber, start the analysis.

-0 x|
View: Operation j Browse
Sample | Replace...
Sample mass: I 1.0000 g
nalysis Conditi |. lysis Conditi j|
Report Options |Delaull Report Options j|
Selected Reports
- Combined Report
HatesiallEaramsters=> | 75 v Report Report After Analysis. .
+ Density and Yolume Table
Pressure and Yolume Table Export After Analysis___
Volume vs Cycle #
Chamber Insert: Density ¥s Time
* None Total Pore Yolume vs Temperal
Density vs Cycle #
35 c® Options Report
10 cm? P1 Equilibration
P2 Equilibration h
Start Close
Sample: 000-D04: DOD-D04 Pressure: 14.500 psig
Operation: Idle Temperature: 32.00 *C
Elapsed Time: Cycle:
Equilibration:
Density:
1. Go to Unit [n] > Sample Analysis. Select the sample file to run and click OK. To select a dif-

ferent sample file, click Browse and locate the correct file. If sample file parameters exist in
another file, rather than re-enter them again, click Replace to locate and replace parameters in
the current file with those of the selected file.

Edit or enter information for the analysis.

Click Report after analysis to generate reports automatically when the analysis is complete.
On the Report Settings window, select the report destination. Click OK to return to the previous
window.

Click Export after Analysis analysis to have data exported automatically after the analysis. Or,
if exporting equilibration or cycle data, data can be exported after the analysis using the File >
Export.

Ensure the correct Chamber Insert is selected.

Click Start to start the analysis. A window displays data as they are collected. A short delay is
encountered before the port status at the bottom of the window changes from the /dle state.
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7. If running a FoamPyc analysis, a message displays indicating the sample should be cut.
a. Remove the sample chamber cap, then remove the cap before performing the next step.

b. Cut the sample and return it to the cup.

c. Remove the cap, place the cup back into the samle chamber. Replace the cap.

d. Click OK to complete the second analysis.

o pnalysis (Unit 1 - 5/N: 0102)

View: | Operation L" ‘ Yolume L" Report I
Analysis Plot
B.372 :
6370 ;
> |
@ N
E |
= :
= :
> 8.368— ]
== T SR Uy RyUpRPE U s o s e P .................._......q: .....
L B e e e B R RS R R R
oo o5 410 15 20 25 30 35 40 45 50 55 60 65 7O 75 80 85 80
Cycle Mumber
<z Prey Nexlz} Cancel Close
Sample: 000-005: REFAMLY Pressure: 0.001 psig
Dperation: Temperature: 2463 °'C
Elapsed Time: Cycle:
Equilibration:
Dengity:

START AN ANALYSIS USING THE KEYPAD

Prerequisites:

« specify analysis and report parameters

 prepare and load sample

The prompts that display for an analysis depend on the options selected in Setup >Analysis Parameters

and Report Options; therefore, the analysis may not display all of the prompts referenced in this
procedure.

1. Press Alt + 4 to display the Sample ID prompt. Enter an appropriate identification. Press .

(decimal) to insert a dash.

2. Press ENTER to display the Description prompt.

/ Most users display this prompt only when a keyboard is attached to the pycnometer.
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Start an Analysis using the Keypad

3. Press ENTER to display the Sample Mass prompt. At the Anls Display Mode prompt in the Setup
> Report Options choose Density. Enter the sample mass.

4. If an analytical balance is connected to the module, press the appropriate button on the balance to
transfer the sample mass while this prompt is displayed.

5. Press ENTER to display the Chamber Insert prompt if using an insert. Press CHOICE until the
appropriate insert is displayed, then press ENTER.

6. Press ENTER to begin the analysis. Operational status messages display during analysis.

7. When the analysis has finished, the pycnometer beeps three times and the display returns to the

Reload prompt.

be discharged from the chamber.

@ Do not remove the cell chamber cap when the pycnometer is pressurized. The sample may

8. Ensure the pressure reads approximately 0 (zero), then remove the cell chamber cap and remove
the sample from the chamber.

9. Replace the cell chamber cap or load another sample.

Display Text

Description

Analyze
Sample ID:

Enter sample identification for the current analysis. Sample ID can be up
to 20 numbers and dashes. Press . (decimal) to insert a dash.

Analyze
Description Line 1:

Enter the description for the current sample. A prompt for Line 2 of the
description is displayed.

Analyze
Sample Mass:

Enter a value for the sample mass. Displays only when Density is
selected for Analysis display mode. It does not display if Volume is
selected.

The range is 000.0000 to 10000.0000 g.
The range for the 2000 cm3 AccuPyc is 000.0000 to 25000.0000 g.

This field will also accept input from a connected analytical balance.
While this prompt is displayed, press the appropriate button on the
analytical balance to transfer the mass (refer to the manufacturer’s
manual for the appropriate command).
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Display Text Description
Analyze Select the insert to be used.

Chamber insert?
« None, 0.1 cm3 (for 1 cm? unit)

« None, 3.5 cm3, 1.0 cm? (for 10 cm’ unit)
« None, 35 cm?3, 10.0 cm3 (for 100 cm3 unit)
« None, 650 cm?, 1300 cm? (for 2000 cm3 pycnometer)

Press CHOICE until the appropriate insert is displayed or None if an
insert is not being used.

Analyze Enter the mass of the sample cup.

Cup Mass?

Analyze « ENTER. Starts the analysis. The analysis begins and operational
[ENTER] to start status messages are continually displayed during analysis

[ESCAPE] to cancel

« ESCAPE. Cancels the analysis.

For keypad and / or keyboard functions or commands not listed in this table, see the
/ Keypad and Keyboard Functions section of this operator manual.

QUICKSTART ANALYSIS
Unit [n] > QuickStart Analysis

Use to analyze a series of samples of the same type and same analysis conditions. Sample files will be
created using default values.

Sample [000-0131nsert Replace.._ |

)

AN

Sample Cup field
viewable only if selected
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QuickStart Analysis

QuickStart Analysis Fields and Buttons Table

Field or Button

Description

Analysis Conditions

Select the Analysis Conditions file to be used for analysis. See "Analysis
Conditions' on page 5 - 2.

Chamber Insert

Select the chamber insert size to be used in this analysis.

Export after analysis

Exports reports automatically to the specified destination and in the
selected format when the analysis is complete.

Material Parameters

Click to verify or change the material properties to be used for analysis.
See "Material Parameters' on page 4 - 6.

Report after analysis

Generates reports automatically to the specified destination when the
analysis is complete.

Report Options

Select the Report Options file to be used for analysis. See ""Report
Options' on page 5 - 5.

Sample

Displays the sample description specified in the Sample Defaults.

Sample Cup

Select the sample cup properties file to be used for analysis. See "Sample
Cup " on page 4 - 5.

Sample Mass

Enter the sample mass.

; For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.
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SEQUENCE ANALYSIS
Unit [n] > Sequence Analysis

Use to analyze the same sample using up to eight different sample files.

Sequence Analysis Fields and Buttons Table

Field or Button Description

Chamber Insert Select the chamber insert to be used for analysis.

Clear Removes all entries from the Sample Files list box.

Export After Analysis Exports reports automatically to the specified destination and in the selec-

ted format when the analysis is complete.

Insert Click to browse and select a file to be added to the sequence analysis.
The selected file displays in the Sample Files list box.

Pause between analyses | When using multiple sample files and this option is selected, the system
will return to the sample selection window after each analysis. When the
previous analysis completes, click Start to run the next analysis. As each
analysis is run, the sample file is removed from the Samples Files list

box.

Remove Select a file in the Samples Files list box then click Remove to delete
the file from the list.

Replace Select a file in the Samples Files list box then click Replace to substitute

a sample file for the selected one.

Report After Analysis Generates reports automatically to the specified destination when the ana-
lysis is complete.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.
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REVIEW ANALYSIS

(.
=~ Keypad Function

L]
(.
The Review function allows review of the results of the last analysis operation. Press Alt + 5 to review
or edit analysis results. The analysis information can also be edited through the prompts. The prompts
that display during the analysis review depend on the options selected in Setup > Analysis Parameters
and Report Options.
1. Press Alt + 5 to display the Sample ID prompt containing the sample identification.

2. Press ENTER to display the Description prompt containing an additional description. This prompt
typically is not used unless a keyboard is connected to the analyzer.

Press ENTER to display the Sample Mass prompt containing the sample’s mass.
Press ENTER. The Start prompt containing the start date and time of the analysis is displayed.
Press ENTER. The End prompt containing the ending date and time of the analysis is displayed.

S koW

Press ENTER. The first of the prompts containing data is displayed. The [#] displayed in the
example prompts represents the cycle number.

7. Continue pressing ENTER to view data. Press CHOICE to exclude data from report cal-
culations. An asterisk will display indicating that it will be excluded. Press CHOICE again to
remove the asterisk.

8. Press SAVE to return to the Reload prompt.
9. Press Alt + 6 to print report results.

Display Text Description

Sample ID: Identification entered for the analysis.

(sample identification)

Sample Mass: Sample mass for the analysis (if Density was chosen as Analysis display
(mass) mode).

Temperature: Sample chamber temperature.

(sample chamber temp)

Start: Time and date the analysis began.

(time) (date)
Time: HH:MM:SS

Date: DD/MM/YY
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Display Text

Description

End:
(time) (date)

Time and date the analysis completed.

Time: HH:MM:SS
Date: DD/MM/YY

Dn[#n] = (density)
Dv[n] = (deviation)

or

V|[n] = (volume)
Dv[n] = (deviation)

Density or Volume (depending on the selection made for Analysis display
mode).

[7]: cycle number.

Press CHOICE to exclude the displayed density (or volume) from the
calculated average. An asterisk indicates that it has been excluded. Press
CHOICE again to remove the asterisk. Each time CHOICE is pressed
to exclude (or include) the value, a new deviation is calculated and
displayed.

Press SAVE to return to the Reload prompt. Press SAVE to automatically
recalculate the collected data and update data reduction messages in the
queue.

For keypad and / or keyboard functions or commands not listed in this table, see the
Keypad and Keyboard Functions section of this operator manual.
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7 ABOUT REPORTS

Review this section for information on the Reports menu options as well as customizing and running
reports.

Reports can be generated for data:

o collected on a sample that has completed analysis

o collected on a sample currently being analyzed

OPEN AND CLOSE REPORTS
Reports > Open Report... > [.REP File]
Opens saved reports.

Reports > Close Reports

Closes all open reports. This option is unavailable if reports are being generated.

START REPORTS

Reports > Start Report

1. Click Reports, then Start Report.

2. Select a file from the Files list. Ensure the selected file has a status of either Complete or Ana-
lyzing.. To select more than one file, hold down the Ctrl key on the keyboard while selecting the
files, or hold down the Shift key to select a range of files.

ing the option to select additional reports. Select additional reports as needed, then click

/ If only one report file was selected in Step 1, the Selected Reports window displays allow-
OK. If multiple files were selected, the reports are displayed in a tiled format.

3. Select the report destination in the Settings group box, then click OK.

4. When the Selected Reports box appears, check the reports to be displayed, then click OK. The
reports will display at the selected destination.
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SPC REPORT

Reports > SPC Report Options

Use to generate reports with various Statistical Process Control (SPC) options. All selected variables
must be computed for each sample file used in an SPC report; therefore, it is more efficient to select
only the necessary variables.

5] SPC Report Options S|
¥ ¥olume| [~ Std.Dev. [ CV.
¥ Density [" StdDev. | CV.
v Specific Gravity " Std.Dev. | CV.
[” Total Pore Yolume [~ Sid.Dev. | CV.
™ Total Solids Concentration | Std.Dev. | CV.
[~ Percent Porosity [~ Std.Dev. | C¥.
[ Temperature [~ Sid.Dev. | CV.
[ Sample mass ™ Equilibration Rate
™ Solids density I Equilibration Interval
™ Liguids density [~ Number of Purges
" Envelope Density " Number of Cycles
" Bulk density I Purge Fill Pressure
[~ Parameter 1 ™ Cycle Fill Pressure
[~ Parameter 2 ™ Cell Yolume
[ Parameter 3 [” Expansion Yolume

oK I LCancel

The selected items display as graph variable selections in Reports > Regression Report and graph
selections in Reports > Control Chart.

REGRESSION REPORT

Use to generate a Statistical Process Control (SPC) Regression report to determine the interdependency
between two variables. Up to three dependent variables (y-axis) may be plotted against a single
independent variable (x-axis). The degree of correlation between the variables is also reported.

(2.1 Regression Report ==
IV Show report title | Regression Repory
Graphic
7 Show araphic micloga. emf Browse....
Height: [~ 0.250 in = Width: [ 2.000 in
Axis Range Auto-
Variable Fiom To scale
X-anis |Mone - 0.0000] [ 1.000.0000 %
First graph [ oo
Y-auis: [None = 0.0000 || 1,000.0000 ¥
Sevond srash [y one -l 0.0000/ [ 1.000_0000 %
Third graph [—o.0000 [ .000.0000]
-auis: [one ~| 0.0000| [ 1.000.0000 |
I~ Tabular report I” Recalculate archived SPC results
I Label data Report Setlings
Copies: 1
File ~RPT
Save as Default Cancel
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Regression Report

Regression Report Fields and Buttons Table

Field or Button Description

Autoscale When enabled, allows the x- and y-axes to be scaled automatically.

Axis Range Enter the beginning and ending values for the x- and y-axis ranges. These
fields are disabled if Autoscale is selected.

Label data Use to label the points on the plot to correspond with the values in the

sample files.

Recalculate archived SPC
results

Use to have archived SPC values recalculated ensuring any changes
made to the SPC Report Options are included in the new report. This
option lengthens the time required to generate the report.

an earlier application version are selected, it is recom-
mended that copies of the archived sample files be used
rather than the original. Selecting this option will make some
archived sample files unreadable by the original application.

/ If this recalculation option is enabled and sample files from

When this option is selected, the following message displays:

Saving the recalculated SPC data may render some files
unreadable by the original application. Saving the SPC
data speeds up future SPC reports.

Do not show me this message again.

sage cannot be redisplayed without Micromeritics assist-
ance.

/ If Do not show me this message again is selected, the mes-

The first time this option is used, the time it takes to generate the report is
lengthened. The second time the report is generated, if using the same
sample files used in the initial calculation, it is recommended that this
option not be selected since the data was recalculated previously. If a
sample file is added or removed from the report after the initial
recalculation, this option should be selected again to ensure the data from
the newly added or removed sample file is recalculated.
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7 About Reports

[M] micromeritics’

Regression Report Fields and Buttons Table (continued)

Field or Button Description

Samples To select more than one file, hold down the Ctrl key on the keyboard
while selecting the files, or hold down the Shift key to select a range of
files.

« Available Files. Contains files located in the directory specified in the
Look In text box.

o Selected Files. Files added from the Available Files list box.

o Add/ Remove. Select a file in the Available Files list box, then click
Add to move the file to the Selected Files list box. Or select a file in
the Selected Files list box, then click Remove to move the file back
to the Available Files list box. Or double click the file name to move
the file from one list box to the other.

Save as Default Click to save selected report options as default report settings.
Show graphic Use to show a graphic on the report header. Click Browse to locate the
graphic.

« Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated

report.
Show report title Select and enter a report title to appear on the report header.
Tabular report Generates a tabular report of the included samples. A tabular report

contains the numeric values contributed by each sample.

X- and Y-Axis Variable | Use to designate the x- and y-axes variables. The variables in the drop-
down lists are those selected in the Reports > SPC Report Options
window. Use these options to plot the regression of up to three y-axis
variables against the x-axis variable.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.
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Control Chart Report

[M] micromeritics’

CONTROL CHART REPORT

Reports > Control Chart

[ Show report title |[:U“l'ﬂ| Char
Graphic

|miclngo.eml Browse.___
Height: 0.250  in Width: I 2.000 in

[¥ Show graphic
X Axis Order By
@ Time ¢ File name ( Date { Minutes ¢ Days

Y Axis Label

Graph 1... None
Graph 2... None
Graph 3... None

" Recalculate archived SPC results

™ Tabular report
Report Settings
Copies: 1[E]
Samples2 | Destination: | Screen j

File name: ||*.RPT

Save as Default | Beport Cancel |

Use to generate a Statistical Process Control (SPC) control chart report which plots the changes in a

statistic.
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[M] micromeritics’

Control Chart Fields and Buttons Table

Field or Button

Description

Graph [n]

Click to define the y-axis of each graph.

Control Chart Graph 1 Options o]

¥ s
statistic: [None -

[ autoscale

3 Cancel

« Statistic. Displays the SPC variables selected on the Reports > SPC
Report Options window. The selected variable will be plotted against
time. This selection also becomes the y-axis label.

« Autoscale. Allows the y-axis to be scaled automatically. To specify a
range, deselect this option and enter a range in the From and To fields.

« Center Line. Displays placement options for the center line in the
graph. Choose Entered to specify placement of the line.

« Limit Lines group box. Displays limiting lines options. Lines can be
placed at some multiple of the standard deviation or at specified pos-
itions (Entered). When Entered is selected, enter the High limit and
Low limit fields with appropriate values.
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[M] micromeritics’

Control Chart Report

Control Chart Fields and Buttons Table (continued)

Field or Button

Description

Recalculate archived SPC
results

Use to have archived SPC values recalculated ensuring any changes
made to the SPC Report Options are included in the new report. This
option lengthens the time required to generate the report.

an earlier application version are selected, it is recom-
mended that copies of the archived sample files be used
rather than the original. Selecting this option will make some
archived sample files unreadable by the original application.

/ If this recalculation option is enabled and sample files from

When this option is selected, the following message displays:

Saving the recalculated SPC data may render some files
unreadable by the original application. Saving the SPC
data speeds up future SPC reports.

Do not show me this message again.

If Do not show me this message again is selected, the mes-
sage cannot be redisplayed without Micromeritics assist-
ance.

The first time this option is used, the time it takes to generate the report is
lengthened. The second time the report is generated, if using the same
sample files used in the initial calculation, it is recommended that this
option not be selected since the data was recalculated previously. If a
sample file is added or removed from the report after the initial
recalculation, this option should be selected again to ensure the data from
the newly added or removed sample file is recalculated.
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[M] micromeritics’

Control Chart Fields and Buttons Table (continued)

Field or Button Description

Samples To select more than one file, hold down the Ctrl key on the keyboard
while selecting the files, or hold down the Shift key to select a range of
files.

« Available Files. Contains files located in the directory specified in the
Look In text box.

o Selected Files. Files added from the Available Files list box.

o Add/ Remove. Select a file in the Available Files list box, then click
Add to move the file to the Selected Files list box. Or select a file in
the Selected Files list box, then click Remove to move the file back
to the Available Files list box. Or double click the file name to move
the file from one list box to the other.

Save as Default Click to save selected report options as default report settings.
Show graphic Use to show a graphic on the report header. Click Browse to locate the
graphic.

« Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated

report.
Show report title Select and enter a report title to appear on the report header.
Tabular report Generates a tabular report of the included samples. A tabular report con-
tains the numeric values contributed by each sample.
X Axis Order by Select the order in which x-axis statistics are placed. Sort by:

o Time. Time the files were analyzed.
« File name. Alphanumeric order.
o Date. Date the files were analyzed.

o Minutes. Minutes elapsed from the first file placed on the list, which
is the earliest-analyzed file.

o Days. Number of days elapsed from the first file placed on the list,
which is the earliest-analyzed file.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
/ tion of this operator manual.
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[M] micromeritics’

Report Features and Shortcuts

REPORT FEATURES AND SHORTCUTS

Reports can be customized and manipulated using the toolbar, shortcut menus, the zoom feature, or axis

cross-hairs.

o After analysis, reports can be viewed, printed, and / or copied and pasted into other documents.

o The report zoom feature provides the viewing of fine graph details and the ability to shift the axes.

o All reports contain a header displaying file statistics.

. Report
Report title por
graphic
Summary Report | Density and Vohume Repii Density v Time {Density vs Cycie 3 /
Generated icromeritics® ol
report tabs Garnet Analysis me ] -
p AccuPyc |l 1340 Asphalt unit2 Serial # 107 \ Reports IISt
box
Report |~ |
header Density vs Cycle # Show Delet:
Average: 0.3553 gicm®  Standard Deviation: 0.0002 gicm* Hide
—6— Densityvs Cycle #
— Temp. vs Cydle # Open_|[_Frint
B Save || Savess
e F: B Default 5t
%U - - T § glmy \
2 q 9 ;‘]
z?ﬂ/ 5 Reports
1 ] €
Data display ] toolbar
(graph or Cycle Number !
text)

If configured, the report header can also contain a graphic and / or a title.

« Tabular and graphical reports contain sample and analyzer statistics such as analysis date / time, ana-

lysis conditions, etc.

o The headers contain notes of sample file changes occurring after analysis.

o Summary report headers contain the same information as tabular and graphical reports with the excep-

tion of notes.
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[M] micromeritics’

REPORT HEADER SHORTCUTS

Display header shortcuts by right clicking in the report header.

Sunman | Isothen ol Fiepn | e e P lobem Log lt| BET Tabuat Repor | BET Tansom Pl Honal

[Mi micromeritics®

Edit
Copy header as text

Report header Shortcut Field and Button Table

Field or Button Description

Copy header as text Use to copy the report header as text. Text is copied to the clipboard and
then can be pasted into other documents.

Edit Use to edit the report title and / or graphic in the report header.
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[M] micromeritics’ Report Toolbar

REPORT TOOLBAR

The Report window has a toolbar on the right portion of the window and selectable tabs at the top of the

report header. To view a specific report, either select the tab or the report in the Reports list box, then
click Show.

mmmmmmmmm

Al
sﬁ\ Report
att

graphic
|

et Tt e e Lo [
Generated /
report tabs

N Reports list
box

Report |~

Report title
header

et

N

Reports
toolbar

Data display (]
(graph or
text)

Report Toolbar Fields and Buttons Table

Field or Button Description

Default Style Click to specify default report parameters for fonts and curve properties.

« Font Type. Use to edit the font type and attributes for the selected

item. Select an item in the list, click Edit, and select from various font
options.

o Thickness. Enter a thickness number for the curve.
« Histogram Fill Style. Select a histogram fill option.

o Graph border line thickness. Enter a thickness number for the graph
border.

Delete Deletes the selected report in the Reports list box. Deleted reports will
have to be regenerated if deleted in error.

Hide Hides (or temporarily removes) the selected report from the tabbed view.
The report name remains in the Reports list box.

Print Displays the Print window for report output.

« Name drop-down list and Properties. Select the printer from the drop-
down list and click Properties to change printer setup, etc.

« Copies. Select the number of copies and collate option.
o Current. Selects the active report (or selected tab).

o AlL Selects all reports in the Reports list box.

« Shown. Selects only the reports not hidden.

e Clear. Clears all selections.
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7 About Reports

[M] micromeritics®

Report Toolbar Fields and Buttons Table (continued)

Field or Button Description
Reports list box

Contains a list of all generated reports. The same reports display as tabs

at the top of the report header unless the report has been hidden using the
Hide button.

Show Displays the selected or hidden report in the Reports list box.

; For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.
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Graph Features and Shortcuts

[M] micromeritics’

GRAPH FEATURES AND SHORTCUTS

Display graph report shortcuts by right clicking in the body of the graph report.

Autoscale

Redraw

Show Curve

Hide curve 4

Edit curve »
Edit axis »
Edit legend

Edit title

Copy as metafile
Copy as text

Graph Shortcuts Options and Description Table

Field or Button Description

Autoscale Returns the report to full view after using the zoom feature.

Copy as Metafile Copies the report data as a metafile ((WMF)

Copy as Text Copies the report data to the clipboard. It can then be pasted into
other software programs as tab-delimited columns or copied as an
overlay onto another graph.
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[M] micromeritics’

Graph Shortcuts Options and Description Table (continued)

Field or Button Description
Edit axis Use to edit the selected axis properties.
f Axis Properties @

Title
Title  |Cycle Humber Title: font...
Scale
* Linear [ Irvert Scale Scale font.
" Logarithmic:

W Autoscale minimum

’17
W Autoscale maximum 10

Gridlines: Major: |Dolted ﬂ
Minor:  |Nane |
’Tl Cancel |

o Title. Use to edit the selected axis label.

« Title font. Use to modify the font for the selected axis label.
Deselect the Use default font to enable font options. Select new
font attributes for the report data. To return to the default fonts,
enable Use default font.

o Linear / Logarithmic. Select the option to scale the graph as lin-
ear or logarithmic.

« Autoscale minimum / maximum. To manually specify minimum
/ maximum autoscale, deselect the option and enter the new
amount in the text box.

« Invert scale. Use to invert the scale.

o Scale font. Use to modify the font for the scale label. Deselect
Use default font to enable font options.

o Grid lines. Use to change how to display major / minor grid
lines.
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Ei m icromeritics‘” Graph Features and Shortcuts

Graph Shortcuts Options and Description Table (continued)

Field or Button

Description

Edit curve

Use to edit selected curve properties.

Curve Properties [Ee]
Title: d Carbon Tube C3 Butane Port 1]
Curve
nterpdaton [Admasoine A
s ET—

resti

| Histogram
Use default fill style

Solid

Center

a0 (o=

« Title. Use to change the title of the selected curve.
« Style. Use to select another style for the collected data curve.

o Curve group box. Use to change the interpolation, point style
and pen style for the selected curve. These options are disabled
if Use default fill style is selected in the Histogram group box.

Color. Click to change the curve color.

Use default thickness. Uses the default curve thickness.
Deselect to enter a new thickness number in the Thickness text
box.

« Histogram group box. Enabled only if Histogram is selected in
the Style drop-down list. Use to specify the type of fill, fill color
and label position for the selected curve.

« Label. Select where the graph point labels will display (left,
right, center, etc.) on the SPC report.
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[M] micromeritics’

Graph Shortcuts Options and Description Table (continued)

Field or Button Description

Edit legend Use to change the legend location and font. Click Font to modify
font attributes. Deselect the Use default font to enable font options.
Select new font attributes for the report data. To return to the
default fonts, enable Use default font.

Legend Properties (S|
(7) Do not show
() Vertical above _—
(@ Horizontal above
) Left
() Right
(7) Bottom
[ OK ] [ Cancel ]

Edit title Use to change the graph title and font. Click Font to font attributes.
Deselect the Use default font to enable font options. Select new font
attributes for the report data. To return to the default fonts, enable
Use default font.

Hide curve Hides selected curve.

Redraw Sets the axis boundaries to the original view. This option also
removes cross-hairs.

Show curve Displays a list of all curves. Select the curve to display.
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EI m icromeritics“ Graph Features and Shortcuts

Axis Cross-hair

AXxis cross-hair

0.0151

RN}

e

0.01510—

Density (glcn™
7,) BIneladwa

[

0.01508—

T I e e
10 15 20 25 3_5 40 45 50 55 60 65 7.
Cycle NMumber

The cross-hair feature displays axis coordinates.

1. Left click on the graph to view the cross-hair coordinates.

2. To remove the cross-hair, right click in the graph area and select either Autoscale all axes or
Reset axis limits to initial setting.
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[M] micromeritics®

Graph Grid Lines

Options > Graph Grid Lines

x| Graph Grid Lines

i

K-Axis
Linear Scale:

Logarithmic Scale:

¥-Axis
Linear Scale:

Logarithmic Scale:

Grid Line Styles
Major: " Solid
Minor: " Solid

v Major

v Major
v Major

+ Dotted
(+ Dotted

LCancel

[~ Minor
[~ Minor

[~ Minor
[~ Minor

Use to select how grid lines appear on reports. This menu option is not available if using Restricted
presentation option.

Graph Grid Lines Fields and Buttons Table

Field or Button

Description

Grid Line Styles

Select if the major and / or minor grid lines should appear as solid or dot-
ted lines.

X-Axis / Y-Axis

Select major and / or minor lines to display in reports for the logarithmic
and linear scales. Deselect this option to remove the grid lines.

Zoom Feature

Use the zoom feature to examine graph details.

1. Open the graph.

2. Hold down the left mouse button, then drag the mouse pointer across the graphical area to be
enlarged. A box will display in the area to be enlarged.

3. Release the mouse button. The enlarged area fills the graph area. To return to normal view, right
click in the graph area, then select either Autoscale or Redraw on the shortcut menu.
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Tabular Report Features and Shortcuts

TABULAR REPORT FEATURES AND SHORTCUTS

Display tabular report shortcuts by right clicking in the body of the tabular report.

Resize column

Rename column

Move column 3
Align celumn 3
Hide colurmn »
Show column 2

Column font

Header font

Edit title...

Copy table as text

Tabular Reports Shortcut Options and Descriptions Table

Field or Button

Description

Align column

Change the column alignment to either left, right, or centered.

Column font

Change the column font. Deselect the Use default font to enable font
options. Select new font attributes for the report data. To return to the
default fonts, enable Use default font.

Copy table as text

Copy the report contents to the clipboard as tab-delimited text. It can then
be pasted into another document.

Edit title

Change the report title in the tabular data area.

Header font

Change the column header font. Deselect the Use default font to enable
font options. Select new font attributes for the report data. To return to
the default fonts, enable Use default font.

Hide column

Hide the selected column.

Move column

Move the selected column left or right.

Rename column

Rename the selected column.

Resize column

Resize the width of the selected column.

Show column

Show a hidden column.
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GRAPH OVERLAYS

Use the graph overlay functions to compare multiple graph options. Graphical lines are differentiated by
the use of varying colored symbols outlined on a legend. Overlays may be generated in two ways:

o Multiple Graph Overlays. Overlay two different types of graphs from one sample.
o Multiple Sample Overlays. Overlay up to 8 graphs of the same type with that of the current plot.

/ This feature is available only when using Advanced presentation display.

GENERATING GRAPH OVERLAYS

Use graph overlays when graphically comparing results for multiple samples, or multiple graphs for one
sample. Graphical lines are generated in different colors and denoted in a legend on the report.

Use the Advanced format to specify graph overlays. Graph overlays can be implemented in two ways:

o Multiple Sample Overlays
Overlay results for up to eight samples on top of a previously selected sample.

o Multiple Graph Overlays
Overlay two different types of graphs from one sample.
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Generate Multiple Sample Overlays

[M] micromeritics’

GENERATE MULTIPLE SAMPLE OVERLAYS

/ Use a copy of a file rather than the original file when performing a sample overlay.

1. Go to Options > Option Presentation and ensure there is a checkmark to the left of Advanced.
2. Go to File > Open > Sample Information and open the sample file.

3. On the Report Options tab, in the Selected Reports list box, select the reports to be used by double
clicking the report name. This places a checkmark to the left of each selected report.

4. Highlight the graph to be used for multiple overlays, then click Edit.

=lalx|
<<Prev ‘( Sample Infomalion (Ana\ys\s Condiions rREDmADDAmns WEaHecAed Data H
Report Options [Default Report Options Replace.
I Show repart kitle [Gamet Analysis
Graphic
o — miclogo. emf Browse..

0250 in  Width [ 2000 in
ey

Highlight the report
e | Lot £ to overlay, then
click Edit

5. On the overlay window, click the down arrow to the right of the Overlay field and select the Over-
lay Samples Select other options as needed, then Click OK.

x|

~|| ¥ Show Average!

- I~ Show Reference [ oo010)| cm®
<[ T Show s [ 30| sigma
I~ Show Min || 0.0010) cw
Select Max ([ 0.0010] o
Overlay Samples ) T —

y-axis 0.0010) 1o [ 9999.9999 |cm*

=

6. Inthe Report Options tab, click Overlays.
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[M] micromeritics®

[=] Graph Overlay Samples x|

Sample 2 ‘C:\DATA\EAHNET.SMP

Sample 3 |C:\DATAVGLASS SMP
Sample 4 |
Sample § \
Sample § |
Sample 7 |

Sample 8 \

ju)

ju)

jw)

[v}

[v}

elelelelele

ju)

~Reminder™  You must select which graphs are to be
averlaid by selecting the Dverlay samples on each Selectad

Cancel
7. Om the Graph Overlays window, click Browse to locate and select which graphs are to be over-

10.

laid. Click OK.

Go to Reports > Start Report. Select the report destination in the Settings group box. Select the
overlay file name in the Files list box, then click OK.

In the pop-up Selected Reports list box, reports can be added or removed by double clicking the
entry. Selected reports as indicated by a checkmark to the left. Click OK.

Reports display in a tabbed format. Click each tab to view each report.

GENERATE MULTIPLE GRAPH OVERLAYS

Multiple graph overlays can be generated by:

1.
2.
3.

Go to Options > Option Presentation and ensure there is a checkmark to the left of Advanced.
Go to File > Open > Sample Information and open the sample file.

On the Report Options tab, in the Selected Reports list box, highlight the graph to be used for mul-
tiple overlays, then click Edit.

=lalx|

¢Prew ‘( Sample Information [ “Analysis Conditions ( Report Options WEﬂHetled Dats H
t Options [0 ions

ssssss

0.250 in  Width [ 2.000 in

Highlight the report

= (e ]| i | Nto overlay, then
click Edit
4. Click the down arrow to the right of the Overlay field and select a graph. This selection will over-

lay the graph selected in the Y-axis field.
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Generate Multiple Graph Overlays

x|

X-Asis: | Cycle Number - v Show Average

L]

Max

Select the
Overlay

Y-is: I~ Show Reference 0.0001 | g/cm®
emperature I Show +/- 3.0] sigma
I~ Show Min 0.0001 | g/cm?

¥ Plot curve ¥ Autoscale -axis 1 1o 999
¥ Plot points IV Autoscale y-axis 0.0001 ] to 99.9999 |g/cm?

0.0001] g/cm®

Cancel

5. Click OK then click Save.

6. Go to Reports > Start Report. Select the report destination in the Settings group box. Select the
overlay file name in the Files list box, then click OK.

7. In the pop-up Selected Reports list box, reports can be added or removed by double clicking the
entry. Selected reports as indicated by a checkmark to the left. Click OK.

8. Reports display in a tabbed format. Click each tab to view each report.
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[M] micromeritics’

REPORT EXAMPLES

COMBINED REPORT

= - - -
[Mj micromeritics
4356 Communications Drive Norcross, GA 30093
AccuPyc Il 1340 Asphalt Unit 1 Serial # 2366 Page 1
V2.00
Sample: SMN 2366 1cc Yolume Check
Operator: AL
Submitter: MAS
Bar Code: Sphere Volume = 0.717913 - 0.719141
File: CADATAV1406472C SMP
Analysis Gas: Mitrogen Analysis Start: 9722014 T7.54:30AM
Reported: 10/7/2014 1:36:5TPM Analysis End: 9212014 8:34:144M
Sample Mass: 1.0000 g Equilib. Rate: 0.005 psigfmin
Temperature: 23.22 °C Expansion Volume: 08897 cm?®
Number of Purges: 10 Cell Volume: 1.3300 cnv
Chamber Insert: None
Comments: Total number of pages: 1
Combined Report
Summary Report
Sample Volume
Average: 0.7189 cm®
Standard Deviation: 0.0000 cr®
Sample Density
Average: 1.3910 gfen®
Standard Deviation: 0.0001 gfcm®
Tabular 1
Cycle# P1 P2 “Volume Density Tatal Pore
Pressure Pressure {em?) {glem?) ‘Volume
{psig) (psig) (cmiig)
1 19.5155 11.4624 0.7190 1.3908 0.2810
2 19.5252 114675 0.7189 1.3908 0281
3 19.5222 114655 0.7189 1.3910 0281
4 19.5291 11.4696 0.7189 1.3911 0281
5 19.5164 11.4622 0.7189 1.3911 0281
B 19.5199 114644 0.7189 1.3910 0281
7 19.5279 114685 0.7188 1.3912 0.2812
g 19.5274 114685 0.7189 1.3911 0281
9 19.5154 114612 0.7188 1.3911 0.2812
10 19.5275 114657 0.7189 1.3911 0281
Summary Data Average Standard
Deviation
Wolume: 0.7189 cm? 0.0000 cm®
Density: 1.3910 gfem®  0.0001 glem?®
6202- Total solids concentration is invalid; liquid density is greater than or equal to solids density.
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Summary Report Example

SUMMARY REPORT EXAMPLE

| ]
-  w -
|EI micromeritics
4356 Communication Drive Norcross, GA 30093
AccuPye || 1240 FoamPyc Unit 3 Seral # 108
W2.00

Sample: Glass Powder
Operator: HH
Submitter: Micromeritics
Bar Code:
File: C:\DATA\GLASS.SMP

Analysis Gas: Helium Analysis Start: 1/22/2007 2:40:-48PM
Reported: 11/26/2014 10:35:20AM Analysis End: 1/22/2007 3:12:00PM
Sample Mass: 59837 g Equilib. Rate: 0.005 psig/min
Temperature: 23.79 °C Expansion Volume: 8.1028 cm?
Number of Purges: 10 Cell Volume: 11.2880 cm?

Chamber Insert: Mone

Comments: Sample 1

Summary Report
Sample Volume
Average: 2.2428 cm?
Standard Deviation: 0.0015 cm?®

Sample Density
Average: 2.6581 g/fem?

Standard Dieviation: 0.0018 g/cm?®

Page 1
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TABULAR REPORT EXAMPLE

| ]
- = »
IEI micromeritics
4356 Communication Drive Morcross, GA 30093
AccuPyc || 1240 FoamPyc Unit 3 Serial # 108 FPage 2
W2.00

Sample: Glass Powder
Operator: HH
Submitter: Micromeritics
Bar Code:
File: CADATAVGLASS.SMP

Analysis Gas: Helium Analysis Start: 1/22/2007 2:40:48PM
Reported: 11/26/2014 10:35:20AM Analysis End: 1/22/2007 3:12:00PM
Sample Mass: 59637 g Equilit. Rate: 0.005 psigi/min
Temperature: 23.79 °C Expansion Volume: 81028 cm?®
Number of Purges: 10 Cell Violume: 11.2880 cm?

Chamber Insert: None

Comments: Sample 1

Density and Volume Report

Cycleg Volume F2 Pressure Density olume Temperature Forosity”
{cm) Dieviation (gfcm?®) Dieviation (*C) (%)
(psig) (e}
1 2.2418 -0.017 2.8602 -0.0010 23.72 G241
2 2.2448 -0.008 2.8562 0.0018 2374 6235
3 2.2410 -0.028 28812 -0.0018 2375 6242
4 2.2408 -0.014 2.8614 -0.0018 23.77 G243
5 2.2423 -0.012 2.8508 -0.0005 23.78 G240
8 2.2437 0.002 2.8580 0.ooo8e 23.80 6238
7 2.2434 0.032 2.8584 0.0008 23.83 62.38
a 2.2457 0.027 2.8557 0.0028 23.83 G234
g 22417 003 2.8803 -0.0011 23.85 6241
10 2.2428 0.004 2.8500 0.0001 2387 6238
Summary Data Average Standard
Deviation
Volume: 2.2428 cm® 0.0015 em*
Density: 28591 glcm® 0.0018 glom®

*Calculated from envelope density
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Graph Report Example
Page 3

1/22/2007 2:40:48PM
1028 cm?

1/22/2007 3:12:00PM

11.2080 em?
0.0015 em?

Serial # 108

i
quilib. Rate: 0.005 psig/min

xpansion Volume: 8

Cell Volume:

Analysis Start:

- L]
itics
Analysis

Standard Deviation:

Volume vs Cycle #

2.24228 cm®

®
micromer

Unit 3

[Fij

4356 Communication Drive Norcross, GA 30093

-
File: CADATAVMGLASS SMP
Average:

1142672014 10:35:20AM

Sample Mass: 58637 g
10

Sample: Glass Powder
Chamber Insert: NMone

Operator: HH
Submitter: Micromeritics

Bar Code:
Reported:

V2.00
Temperature: 23.79 *C

Analysis Gas: Helium

micromericics

AccuPyc || 1340 FoamPyc
Mumber of Purges:

Comments: Sample 1

GRAPH REPORT EXAMPLE
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]

micromeritics

[mi

7 About Reports

OVERLAY REPORT EXAMPLE

@i micromer

4356 Communication Drive Norcross, GA 30093

Fage 4

Unit 3 Serial #: 108

AccuPye || 1240 FoamPyc
V2.00

Sample: Glass Powder

Operator: HH

Submitter: Micromeritics

Bar Code:

File: CADATAVGLASE SMP

1/22/2007 2:40:48PM

Analysis Start:

Analysis Gas: Helium

nd: 1/22/2007 3:12-:00PM

quilib. Rate: 0.005 psig/min

xpansion Yolume: 8.1028 cm?

Amnalysis

11/26/2014 10:35:20AM

Reported:
Sample Mass: 59637 g

Temperature: 23.79 °C

11.2880 cm?®

Cell Vaolume:

10

Chamber Insert: None

Mumber of Purges:

Comments: Sample 1

Density vs Time

581 glem?® Standard Deviation: 0.0018 gfem?®

Average: 2.6

ime

Density vs

—=—
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Equilibration Report Example

]

micromericics

[mi

EQUILIBRATION REPORT EXAMPLE

Itics’

Ei micromer

4356 Communication Drive Norcross, GA 30093

Page &

Serial #: 108

Unit 3

AccuPye |l 1240 FoamPyc

V2.00

Sample: Glass Powder

Operator: HH
Submitter: Micromeritics

Bar Code:

File: C:A\DATAIGLASS SMP

122/2007 2:40:48PM
1/22/2007 3:12:00PM

Analysis Start:

Analysis Gas: Helium

nd:
quilib. Rate: 0.005 psig/min

spansion Volume: 81028 cm?

Analysis

11/28/2014 10:35:20AM

5.0637 g

Reported:

Sample Mass:

11.2880 em?

Cell Volume:

Temperature: 23.79 °C
10
Chamber Insert: Mone

Mumber of Purges:

Comments: Sample 1

P2 Equilibration

—&— Cycle #5

= #4

—o— Cyc

P2 (Expansion Pressure) shown every second

Inh A e e e e
1 1 1 1 1 1
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7 About Reports

[M] micromeritics’

SAMPLE LOG EXAMPLE

[M] micromeritics’

4356 Communications Drive Norcross, GA 30003

Comments: Total number of pages: 1

AccuPye Il 1340 Asphalt Unit 1 Serial #: 2366
V200
Sample: S/N 2366 1ec Volume Check
Operator: AL
Submitter: MAS
Bar Code: Sphere Volume = 0.717913 - 0.719141
File: C:\DATAN406472C_SMP
Analysis Gas: Mitrogen Analysis Starl: 922014 7:54:30AM
Reported: 10/7/2014 1:36:57PM Analysis End: S/2/2014 8:34:14AM
Sample Mass: 1.0000 g Equilib. Rate: 0.005 psig/min
Temperature: 23.22 °C Expansion YVolume: 08697 cm?®
MNumber of Purges: 10 Cell Volume: 1.3300 cn?
Chamber Insert: None

Page 1

Sample log
Date Time Log Message
91212014 7:54:30AM  Analysis started.
Q212014 8:34148NM  Analysis done.
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8 Selected Reports

[M] micromeritics’

8 SELECTED REPORTS

COMBINED REPORT

m Combined Report Options ﬂ

Selected Reports

+ Tabular 1

+ Tabular 2
+ Yolume vz Cycle

<+ Dengity vz Time Edit.__
+ Total Pore Yolume vz Temperature =
+ Density vz Cycle #
+ Options Report
P1 Equilibration
+ P2 Equilibration
+ Sample Log

LCancel

The Combined Reports option creates a single report from all selected reports. The Combined Report
contains no breaks between reports and no headings. Highlight the report, then click Edit to edit report
details.

DENSITY AND VOLUME TABLE

D Tabular Report ﬂ
Name: Density and Yolume T able|
Column 1: Cycle Humber A

Column 2: | Volume

Column 3: | P2 Deviation

Column 4: | Density

L file e

Column 5: | Volume Deviation

Column 6: | Temperature

L« |Le

Column 7: | Percent Porosity

Summary Data

Yolume: v Average ¥ 5td. Dev. | CV.
Density: v Average ¥ 5td. Dev. | CV.
Specific Gravity: [ Average [" 5td. Dev. | CV.
Total Pore Volume: [ Average [ Std. Dev. | CV.
Total Solids Concentration: [ Average ["Std. Dev. | C¥
Percent Porosity: [~ Average ["Std. Dev. | CYV.
Temperature: [~ Average ["Std. Dev. | CYV.

LCancel
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8 Selected Reports

[M] micromeritics’

Density and Volume Fields and Buttons Table

Field or Button

Description

Columns 1 though 7

Select a variable for each column.

Name

Enter the name of the report.

Summary Data

Select the average, standard deviation, and coefficient of variation (C.V.)
for report parameters.

/

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

DENSITY VS CYCLE NUMBER TREND PLOT

x|

X-Asis: | Cycle Number -

Y-Axis: | Volum

Overtlay: | Dverlay Samples -

L!L

¥ Plot curve

¥ Plot points

¥ Show Average
[~ Show Reference

[~ Show +/-
I” Show Min
Max

IV Autoscale x-axis 1 to
IV Autoscale y-axis 0.0010] to [ 9999.9998|em?

0.0010 cm*
3.0 sigma
0.0010 | cm®

0.0010] cm*

999

Cancel

There are four types of graphical reports available. Report titles are based on the parameters selected for
the X-axis and Y -axis.

Volume vs Cycle Number Trend Plot Fields and Buttons Table

Field or Button

Description

Autoscale x-axis
Autoscale y-axis

When enabled on the report parameters windows, allows the x- and y-
axes to be scaled automatically. Autoscale means that the x- and y-
ranges will be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

Overlay

Select overlay plot options.

o A second Y-axis can be selected to overlay with the variable in the Y-
Axis field.

or

o Select Overlay Samples to overlay data of the type selected in the Y-
Axis field with the same type of data contained in other sample files.

To select other sample files, go to the Report Options tab and click the
Overlays button.
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[M] micromeritics’

Density vs Time Trend Plot

Volume vs Cycle Number Trend Plot Fields and Buttons Table (continued)

Field or Button Description

Plot curve Select to display how data are plotted.

Plot points

Show +/- Select to place two horizontal lines on the graph. The top line will be

placed at a point relative to the average and standard deviation of the
data. The bottom line will be placed at the point entered in the adjacent
field.

Show Average

Select to show the average of all cycles. A horizontal line is placed at the
average point for the cycles.

Show Min
Show Max

Select to show the average of all cycles. Horizontal lines are placed at
the entered limits.

Show Reference

Select to show a horizontal line placed at a reference point specified in
the adjacent field.

X-Axis

Variables available for the X-axis.

Y-Axis

Variables available for the Y-axis.

; For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

DENSITY vS TIME TREND PLOT

X-Axis: | Cycle Number ~|| ¥ Show Average

Y-Avis: [Volume ~|| I Show Reference

Oyerlay: |Overlay Samples <] T Show -

I~ Show

LIL

¥ Plot curve I Autoscale x-axis 1] to 993!
¥ Plot points ¥ Autoscale y-axis 0.0010] to [ 9999.9999 |cm®

sigma

The Density vs Cycle Number Trend Plot and the Volume vs Cycle Number are identical unless
otherwise noted.. See "Density vs Cycle Number Trend Plot" on the previous page.
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8 Selected Reports

[M] micromeritics’

EQUILIBRATION REPORT

f= P2 Equilibration

Report guantity

[~ Show table
¥ Show plot

¥ Plot curve

P2 [Expansion Pressure] j

From cycle: |—1
Report eyery |—1 cycle
Report total of- I—B cycles
Report every: |—1 3

+ Overlay cycles

[ Plot points " Owverlay samples
[v Autoscale x-axis: I 10| to I 99999 || ;
[ Autoscale p-asis: I 0.000 || to I 30.000 | psig

This report is available only if the Record equilibration data option was selected on the Analysis

Conditions tab.

Equilibration Report Fields and Buttons Table

Field or Button

Description

Autoscale x-axis
Autoscale y-axis

When enabled on the report parameters windows, allows the x- and y-
axes to be scaled automatically. Autoscale means that the x- and y-
ranges will be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

From cycle

Enter the beginning report cycle.

Report every

Enter which cycle to report.

Overlay cycles

Select to overlay the number of cycles entered in the Report total of field.

Overlay samples

Select to overlay the last cycle in the current file with the last cycle con-
tained in other files. Click Overlays on the Report Options tab to select
the other sample files.

Plot curve
Plot points

Select to display how data are plotted.

Report quantity

Select a variable to be reported.

Report total of

Enter the number of cycles for this report. Enter up to 8 cycles.

Report every

Enter time between cycles. Up to 60 seconds can be entered.

Show plot

Generates a plot (graph) for the Report quantity field selection.

Show table

Generates a tabular report for the Report quantity field selection.

/

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.
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[M] micromeritics’

Options Report

OPTIONS REPORT

The Options report provides information on the sample, its material properties, and analysis conditions.
This report cannot be edited.

PRESSURE AND VOLUME TABLE

m Tabular Report ﬂ

Name: Density and Yolume T able|

Column 1: Cycle Humber |=]

Column 2: | Volume hd

Column 3: | P2 Deviation Jlad|

Column 4: Density &2

Column 5: | Yolume Deviation |=]

Column 6: | Temperature hd

Column 7: | Percent Porosity =]

Summary Data
Yolume: ¥ Average [V Std. Dev. | CYV.
Density: ¥ Average [V Std. Dev. | CYV.
Specific Gravity: [~ Average ["Std. Dev. | CYV.
Total Pore Volume: [ Average [ Std. Dev. | CV.
Total Solids Concentration: | Average [ Std. Dev. | CV
Percent Porosity: [ Average [ Std. Dev. | CV.
Temperature: [ Average [ Std. Dev. | CV.

The Pressure and Volume Table and the Density and Volume Table are identical unless otherwise noted.

See "Density and Volume Table" on page 8 - 1.

SAMPLE LOG REPORT

The Sample Log report displays:

o Automatic operations

o Information entered using Add Log Entry on the Sample Information tab

o Warnings and / or errors which occurred during analysis

The Sample Log Report cannot be edited.
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8 Selected Reports

[M] micromeritics®

SUMMARY REPORT

[ summary Report x|
‘Sample Yolume
v fAverage ¥ Std. Dev. I~ Pass/Fail  Min 1.0000] cn®
I Cv. Max 1.0000 | cm*
‘Sample Density
IV Average [V Std. Dev. I~ Pass/Fail  Min 1.0000 | g/cm®
I cv. Max [ 1.0000 g/cm
Specific Gravity
I~ Average | Std. Dev. I Pass/Fail ~ Min 0.0001
Icv. Max | 99.9999
Total Pore Volume
I~ Average | Std. Dev. I~ Pass/Fail  Min 1.0000 | cm/g
I~ Pass/Fail M 0.00 %
;
Sample Yolume (60° F) O p p p | b |
oo T oo [ pavrat [ [0 e tions applicable
cv. Mox 1,939,999 | cm® h hal
Fo R to the asphalt
e ) application only
Specific Gravity (60° F)
Icv. Max 99.9999
e

The Summary Report provides a condensed listing of data results. Select the type of information to
include in the report. If Pass/Fail is selected, the Min and Max fields are enabled. Enter the minimum
and maximum values for the pass / fail.

TABULAR REPORT

mTabularReport ﬁ

Name: |Tahu|al 1

Column 1: | Cycle Humber Jhd|

Column 2: | P1 [Fill Pressure] =1

Column 3: | P2 [Expansion Pressure] -

Column 4: | Volume |

Column 5: | Density Jhd|

Column 6: | Total Pore Yolume hd

Column 7: | Total Solids Concentration  ~ |

Summary Data
Yolume: ¥ Average [V Std. Dev. | CYV.
Density: ¥ Average [V Std. Dev. | CYV.
Specific Gravity: [~ Average ["Std. Dev. | CYV.
Total Pore Volume: [~ Average [T Std. Dev. | CV.
Total Solids Concentration: | Average [ Std. Dev. | CV
Percent Porosity: [ Average [ Std. Dev. | CV.
Temperature: [ Average [ Std. Dev. | CV.
Yolume (60° F): [~ Average ["Std. Dev. | CYV.
Density [60” F): [~ Average ["Std. Dev. | CYV.
Specific Gravity [60° F): [~ Average ["Std. Dev. | CYV.
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Ei micromeri ticsm Total Pore Volume vs Temperature

Tabular Report Fields and Buttons Table

Field or Button Description

Columns 1 through 7 Select a variable to appear in each column.

Selections applicable only to the Asphalt configuration:

o Volume (60 °F)

o Density (60 °F)

o Specific Gravity (60 °F)

« Volume (60 °F) Deviation
« Density (60 °F) Deviation

« Specific Gravity (60 °F)) Deviation
Name Enter a name for the report.

Summary Data Select options for reporting the average, standard deviation, and coef-
ficient of variation (C.V.).

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

TOTAL PORE VOLUME VS TEMPERATURE

x|

X-Axis: | Cycle Number ~|| ¥ Show Average
¥ -Auis: [~ Show Reference [ 0.0010 cm*
Dyerlay: [~ Show +/- [ 30| sigma
[~ Show Min 0.0010 | co®
Max 0.0010) cm*
¥ Plot curve I Autoscale waris [ 1 1w 999
¥ Plot points ¥ Autoscale y-asis [ 0.0010 to [ 9999.9995 cne

Cancel

The Total Pore Volume vs Temperature and the Density vs Cycle Number Trend Plot are identical
unless otherwise noted. See "Density vs Cycle Number Trend Plot" on page 8 - 2.
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8 Selected Reports

[M] micromeritics’

VOLUME vs CYCLE NUMBER TREND PLOT

x|

¥ Plot curve IV Autoscale x-axis 1 to 939
i Plot points IV Autoscale y-axis 0.0010] to [ 99999998 ||cm

X-Axis: | Cycle Number ~|| ¥ Show Average
Y-Axis: [~ Show Reference 0.0010 | cm®
[~ Show Min 0.0010 | cm®
Max 0.0010] cn?

Cancel

The Volume vs Cycle Number and the Density vs Cycle Number Trend Plot are identical unless
otherwise noted. See ""Density vs Cycle Number Trend Plot" on page 8 - 2.
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9 Diagnostics using the Software

[M] micromeritics®

9 DIAGNOSTICS USING THE SOFTWARE

Unit [n] > Diagnostics

Performs a leak test for the analysis module.

Diagnostic Test Fields and Buttons Table

Field or Button Description

File Shows a status bar of steps complete once the test begins.

Next Starts the next test.

Report after test Automatically generates reports to the selected destination when the test
is complete.

Sequence Sequence number assigned to the test.

Test Select the test from the drop-down list.

; For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.
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[M] micromeritics®
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10 Calibration

[M] micromeritics’

10 CALIBRATION

The pycnometer volume should be calibrated every time it is restarted. Cell volume and expansion
volume in the set up parameters are updated automatically upon calibration. Run an analysis with an
empty cup to see how close the average volume is to 0. It should be + 0.05% of full scale. If it is not
within £ 0.05% of full scale, calibration is required.

If calibrating using the keypad, see ""Calibrate using the Keypad' on page 10 - 14.

CALIBRATE USING THE SOFTWARE

CALIBRATION REPORT
Unit [n] > Calibration > Calibration Report
| =)

Chamber Insert: (v Nope 35 cm® 10 cm®

Copies: I 1 .
Destination: [FF 2 I -

File name:| |C-ADATAV.RPT

1].4 | Cancel |

1. Select the type of chamber insert used.
2. Select the report destination.

3. Click OK to generate the report.

=10 x|
{ Zein Cel Vallme Hepoit | volume Calbration Report | Fenar
eparts
Zero Cel Volume Fepo
Volume Calibration Rer
Calibration Report (Unit 1 - SiN: 1) E
ACcuPyc Il 1340 Asphatt Unit 1- SIN:1 Pag
L om »
Zero Cell Volume Header B
| _Show | Delete
alysis Start 10/6/2014 10:16:06A1 Reported 101612014 1:13:32P Hide
alysis End 10/8/2014 10:16:0641 Temperature 23.40°C
imber of Purges: 5 Purge fill pressure 19.500 psig E Open_|[_Pint
1mber of cycles 5 Gycle fill pressure: 19.500 psig
uilib. Rate 0.0050 psig/min Expansion Volume: 50.1000 cm* Save [ Savess
Dicfaut Siyle
Closy
Zero Cell Volume Report =
Cydle# Cell Deviation
Volume (o)
(cm?)
1 501000 0.0000 -
[ m -
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10 Calibration [M] micromeritics’

CALIBRATE TEMPERATURE OFFSET
Unit [n] > Calibration > Temperature

Opens the Calibrate Temperature Offset box.

Calibrates the temperature offset. Use an external reference device to determine the sample cell
temperature. Enter the value in the field, then click Done.

A Calibration report is not generated for the temperature offset. The entry is recorded in the Instrument
Log. To view the log, go to Unit [n] > Show Instrument Log.

Enter the cumment zample cell temperature
I ‘C
Done LCancel

Enter a value between 0,00 and 52,00,

1. Enter the current sample cell temperature.

2. Click Done. Temperature reading will be adjusted to the entered temperature.

CALIBRATE ZERO CELL VOLUME
Unit [n] > Calibration > Zero Cell Volume

Use to calibrate the cell volume offset.

-[O] x|
Insert
& Hone!
35 cm?
10 e Analysis Conditions._
Expansion Yolume
50.1000 cne on 4/21/2006 2:17:44PM
Cell Yolume
Current: 1011000 cm® on 10/6/2014 1:30:38PM
New:

The sample chamber should contain a sample cup or the insert, with sample cup,
selected above. Click Start to begin.

Start Cancel
Operation: Idle Pressure: 14.500 psig
Elapsed Time: Temperature: 32.00°C
Equilibrati Cycle:
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[M] micromeritics’

Calibrate Zero Cell Volume

Field or Button

Description

Analysis Conditions

Specify conditions for the calibration.

. __ —

MHumber of purges: I m Replace
Purge fill pressure: 19.500 psig End equilibration by:
| Number of cycles: I 10 * Rate 0.0050 psig/min

| Cycle fill pressure: 19.500  psig  Time 10]is

[” Use run precision
Percent full scale: || 0.05 %

0K | LCancel |

| Enter a value between 0 and 939

|

Click Replace to replace the values with those from an existing Analysis

Conditions file. See "Analysis Conditions' on page 5 - 2.

Cell Volume

Current cell volume (without an insert) or the volume of the selected

insert.

Expansion Volume

Current expansion volume, and the date and time of calibration.

the user by clicking Unit > Unit Configuration and changing the Insert title.

/ Insert values listed in this table are default values. The insert title can be changed by

Insert « None
1 cm?3 unit o 0.1 cm3
If None is selected, place an empty sample cup in the chamber.
Insert « None
10 cm3 unit . 3.5 cm’

If None is selected, place an empty sample cup in the chamber.

Insert
1.0 cm3and 100 ¢m3 unit

o None
e 35cm3
e 10cm3

If None is selected, place an empty sample cup in the chamber.

Insert
350 cm3 and 2000 cm3
units

e None
o Large
e Small

If None is selected, place an empty sample cup in the chamber.
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10 Calibration

[M] micromeritics’

Field or Button

Description

tion of this operator manual.

/ For fields and buttons not listed in this table, see the Common Fields and Buttons sec-

CALIBRATE ZERO PRESSURE
Unit [n] > Calibration > Zero Pressure

This option zeros the pressure transducer reading.
- o] x|

This procedure will calibrate the pressure offset.

........ Cancel

Operation: Idle |Plessure: 14 500 psig

Click Start to calibrate the pressure offset.

10- 4
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Reset Pressure Calibration

[M] micromeritics’

RESET PRESSURE CALIBRATION

Unit [n] > Calibration > Reset Pressure Calibration
This procedure resets the pressure calibration to the factory default settings.

This option can be used when the pressure appears not to be reported correctly by the analyzer. For
example: a zero, negative, or unreasonably high reading is being consistently reported. Resetting to
nominal may restore normal pressure readings but a proper calibration should be performed.

A popup warning indicates that when this option is used, the previous pressure calibration is lost and the
nominal calibration is used.

e

Resetting the pressure calibration will restore the factory calibration
i l " settings. The current calibration settings will be lost.

/ Temperature and volume calibrations are not affected by a reset of the pressure calibration.

Click OK. The nominal calibrations may be sufficient. However, it is recommended to contact your
Micromeritics Service Representative and schedule a proper pressure calibration as soon as possible
since data accuracy may be compromised.
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CALIBRATE VOLUME SCALE
Unit [n] > Calibration > Calibrate Volume

Calibrates the cell volume offset and expansion volume.

Although the instrument is calibrated prior to shipment, the pycnometer should be recalibrated to
laboratory atmospheric and environmental conditions.

1. On the pressure regulator, turn the pressure control knob clockwise to set the regulator pressure at
21.500 psig (low pressure gauge).

Low pressure
gauge High pressure
gauge Gas bottle shut-off

\ valve
[ - -
Gas regulator V Lidh- P A _:.\

shut-off valve 2. i | y AN /
\ x i & T 1

/]

Copper
tubing

Brass reducer
fitting
Regulator
connector nut

Regulator
control knob

2. Remove the chamber cap and place an empty cup into the sample chamber, then replace the cap.
If an insert is being used, place the insert sample cup into the chamber.

/ Wear latex or nitrile, powder-free gloves to prevent transfer of oil from hands when hand-

ling sample cups, calibration standards, and inserts. See ""Handling System Components"

on page J - 1.

3. Go to Unit [n] > Calibration > Calibrate Volume.
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j=lF
Insert
© Nonel
" 36 cm?
10 cw Analysis Conditions. .
Volume of calibration standard:
51.099998 cm®
5 Cell Volume Expansion Volume
¢ Brevious: | 101.1000 cm on 10/6/2014 1:30:38PM 50.1000 cr® on 4/21/2006 2:17:44PM
LlEntereds 101.1000 50.1000
(+ Measured:
The sample chamber should contain a sample cup or the inset, with sample cup, selected above. Click
Start lo begin.

Stant Cancel
Dperation: Idle Pressure: 14.500 psig
Elapsed Time: Temperature:  32.00 T

il Cycle:

4. Enter the volume of the calibration standard (located on the outside of the calibration standards
case shipped with the instrument) in the Volume of Calibration Standard field.

The value recorded on the case for a 10 cm? pycnometer is the sum of the two standards, and on
a 350 cm? pycnometer, the sum of the three standards.
5. Select the Measured option.

6. Click Analysis Conditions to specify calibration parameters. Click Replace and select the
file calstd.anc. The values in the current file will be replaced with those contained in the selected
file. Click OK, then click OK again to return to the Calibrate Volume Scale window.

==

| Mumber of purges: I—[[I]
Purge fill pressure: IW psig
Humber of cycles: I—‘Il]
Cycle fill pressure: IW psig

Replace
End equilibration by: |
* Rate I 0.0050  psig/min
" Time I 10)/s

[~ Use run precision

Percent full scale:|| 0.05)%

[1] 4 LCancel ‘

|[Enter & value between 0 and 938,

7. Click Start to begin the first phase of the calibration (volume offset). Status messages display
until this phase is complete. When the phase has finished, a prompt display indicates to insert the
calibration standard.

8. Remove the sample chamber cap, then remove the sample cup from the chamber. Place the cap
back onto the chamber while placing the standard into the cup.

9. Tilt the sample cup and allow the standard to roll gently into the cup to prevent denting of the cup.
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« one standard is shipped with the 1-, 100-, and 2000 cm? pycnometers
« two are shipped with the 10 cm3 pycnometer
o three are shipped with the 350 cm® pycnometer

10. Remove the sample chamber cap, place the sample cup back into the chamber, and replace the
cap. Turn the cap clockwise to tighten.

11. Allow the standards to reach thermal equilibrium with the pycnometer.

Wait 10 minutes for 1- and 10 cm3 pycnometer

Wait 15 minutes for the 100 cm® pycnometer

Wait 20 minutes for the 350 cm® pycnometer

« 30 minutes for the 2000 cm® pycnometer

12. Click Continue to complete the second phase of the calibration (volume scale). Status messages
display until the calibration is complete.

13. Click Done to accept the new values, then click OK.

14. Do not remove the standard from the sample chamber until the operation is verified. See ""Verify
Operation' on page 10 - 10.
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Calibrate Volume Scale

Calibrate Volume Scale Fields and Buttons Table

Field or Button

Description

Analysis Conditions

Specify conditions for the calibration.

==

MNumber of purges: | [ﬂ]

‘ Replace
| Purge fill pressure: I 19.500 psig

|

|

End equilibration by: |

* Rate 0.0050 psig/min
 Time 10(/s

Humber of cycles: I 10
Cycle fill pressure: 19.500 psig

[” Use run precision

Percent full scale: || 0.05 %

Enter a value between 0 and 939

|
l
J 0K | Lancel |
|
|

L

Click Replace to replace the values with those from an existing Analysis
Conditions file.

Cell Volume Displays the current cell volume (without an insert), or the volume of the
selected insert.
Continue Place the standard into the sample cup and click Continue to complete

the volume scale calibration.

Expansion Volume

Displays the current expansion volume, and the date and time of cal-
ibration.

Insert

o 1 cm3 unit None, 0.1 cm?
None, 3.5 cm3

None, 35 cm3, 10 cm3

e 10 Crn3 unit
e 1.0 cm3100 cm3 unit
e 350 cm3 and 2000 cm3 units  None, Large, Small

If None is selected, pace an empty sample cup in the chamber.

Previously Entered /
Measured

Select the method for calibrating the cell and expansion volumes.

o Previous. Uses the current values.
« Entered. Enables the fields for the cell and expansion volumes.

o Measured. Measure the cell and expansion volumes using a reference
standard.

Start

Begins the first segment of the volume offset calibration. Status messages
are shown as the calibration proceeds. When the volume offset cal-
ibration is complete, a prompt displays indicating to insert the standard.

Volume of Calibration
Standard

The volume of the standard used for the previous calibration.
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Calibrate Volume Scale Fields and Buttons Table (continued)

Field or Button Description

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

VERIFY OPERATION

Verify operation of the pycnometer by performing an analysis on the calibration standard to ensure that
the pycnometer is operating properly.

1. Go to Unit [n] > Sample Analysis.
2. Click OK, then Yes to create a new sample file.

3. Click Replace and select the refanly.smp file. The values in the current file will be replaced
with those contained in refanly.smp. Click OK.

o] x|

View: Operation - Browse
Sample Repla
Sample mass: 1.0000 g

Analysis Conditions [ Analysis Conditions -

Report Options | Default Report Options |
Selected Reports

Report After Analysis....

Export After Analysis...

Pressure: . 14.500 psig
Idie Temperature: 32,00 °C

4. Click Report After Analysis. Select the Report after analysis option, then click OK.

'8 Report Settings @
Copies: 1
Destination: |Screen ﬂ|
File name: |

1].4 | Cancel |
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5. Click Start to begin the analysis.

6. Compare the value displayed for the average volume to the value recorded on the calibration stand-

ards case. These two values should agree plus or minus the tolerance obtained using the following
calculation:

Tolerance = (chamber volume * 0.0003) + (Value recorded on Standards case * 0.0003)

Example: calculate the tolerance for a 10 cm? pycnometer with a value of 6.372242 recorded
on the case as :

Tolerance = (10 * 0.0003) + (6.372242 * 0.0003) = 0.003 + 0.0019116726 = 0.005

If the values do not agree, a leak may be indicated. Check the system for leaks. Then repeat steps
1 through 6. If the values continue to disagree, contact your Micromeritics service representative.
See "Diagnostics using the Software' on page 9 - 1.

7. Remove the standards and place them back into the case.
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LoAD CALIBRATION FROM FILE

Unit [n] > Calibration > Load from File
Use to load a previously saved calibration file.

It is recommended that the current calibration settings be saved using Unit [n] > Calibration > Save to
File prior to loading another calibration file. When loading a previously saved calibration file, a backup
of the current file is created and saved as [SN/last.cal. The backup file is overwritten each time a new
one is created.

/ Changing the calibration may affect the analyzer’s performance.

18] Select Calibration File_ (s
File name: [F.CAL
Directories:
Files: c:\___\hardware

01-001_cal ]

0] g

[1].4 | LCancel |

1. Select the calibration file from the Files list box.
2. Click OK.

10- 12 AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



EI m icromeriticsw Save Calibration to File

SAVE CALIBRATION TO FILE
Unit [n] > Calibration > Save to File

Use to save the current calibration settings to a backup file which can later be reloaded using Unit [n] >
Calibration > Load from File menu option.

- N - - "
5| Select Calibration File . [é]
File name: [.CAL

Directories:
Files: c:\.__\hardware
01-001.cal []

(] g

1] 4 | LCancel |

The default file naming convention for calibration files can be used or the file name can be changed. The
default file name of 0217-001.CAL is interpreted as:

0217 is the analyzer serial number
001 is the sequence number
.CAL is the file name extension
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CALIBRATE USING THE KEYPAD

CALIBRATE FUNCTION

This command performs a full volume slope and offset calibration. Press ALT + . (decimal) to access

the Calibrate function.

Display Text Description
Calibration Type? Press CHOICE until the option is displayed, then press ENTER.
Volume
e Volume
o Temperature
o Pressure
« Copy to an external device
o Load from an external device
o Reset Pressure Calibration
CALIBRATION DATA
Display Text Description
Setup Type? Press CHOICE until Calibration Data is displayed, then press ENTER.
Calibration Data

Calibration Data
Chamber Insert?

Select Yes at the Request insert prompt in Report Options. Press
CHOICE until the appropriate insert is displayed, then press ENTER.
« None, 0.1 cm3 (for 1 cm3 unit)

« None, 3.5 cm3, 1.0 cm3 (for 10 cm? unit)

« None, 35 cm?, 10.0 cm3 (for 100 cm3 unit)

« None, 650 cm?, 1300 cm? (for 2000 cm3 pycnometer)

Expansion Volume:

Calibration Data Displays the cell volume determined during calibration Cell volumes can
Cell Volume: also be entered at this prompt. Press ENTER.

The range is 0.01 to 999.0000 cm?.
Calibration Data Displays the expansion volume determined during calibration. Press

ENTER.

The range is 0.5 to 999.0000 cm?.

10- 14
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Calibrate Volume

CALIBRATE VOLUME

Place an empty cup into the sample chamber for Call (volume offset). If using an insert, place the insert
and its appropriate sample cup into the sample chamber.

Display Text Description
Calibration Type? Press ENTER to accept Volume (default) and display the next prompt.
Volume

Calibrate Volume
Chamber insert?

Press CHOICE until the appropriate insert is displayed, then press
ENTER. Yes must be selected for the Request Insert prompt in Report
Options for this prompt to display.

None, 0.1 cm? (for 1 cm3 unit)

None, 3.5 cm?, 1.0 cm? (for 10 cm3 unit)

None, 35 cm3, 10.0 cm? (for 100 cm? unit)

None, 650 cm?, 1300 cm? (for 2000 cm3 pycnometer)

Calibrate Volume

Volume of Cal Std:

Enter the volume of the calibration standard to be used in the calibration
(located on the outside of the calibration standards case). Some
pycnometers require and are shipped with multiple standards. In this
instance, the value recorded on the case is the sum for all standards and
is the one that should be entered at the prompt. Press ENTER.

The range is 0.1 to 999.0000 cm?.

Calibrate Volume
[ENTER

Press ENTER to begin the calibration or Alt + CLEAR to cancel. The
volume offset is calibrated first (Call). When the first calibration is com-
plete, the pycnometer beeps three times and the next prompt is displayed.

Insert Cal Std
[ENTER] to start

Place the calibration standard in the cup in the sample cell chamber and
replace the chamber cap. Press ENTER to calibrate the temperature
offset (Cal2). Calibration continues and operational status messages are
continually displayed. After the operation is complete, the pycnometer
returns to the Reload prompt.

For best results, sample volume should be approximately equal to the
volume of the calibration standard. Therefore, if calibrating the 10 cm?
pycnometer for use with smaller sample volumes, use only one standard.
If using one standard, enter half of the value at the Volume of cal std
prompt. Press Alt + CLEAR to cancel the operation.
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RESET PRESSURE CALIBRATION

since data accuracy may be compromised.

/ Contact a Micromeritics service representative and schedule a proper pressure calibration

This option can be used when the pressure is suspected of not being reported correctly by the analyzer.
For example: a zero, negative, or unreasonably high reading is being consistently reported. Resetting to
nominal may restore normal pressure readings but a proper calibration should be performed.

Display Text

Description

Calibration Type?
Reset Pressure Cal

Press CHOICE until the desired option is displayed, then press ENTER.

Reset Pressure cal?
[Yes / Noj

Resets the pressure calibration to nominal values. Temperature and
volume calibrations are not affected. Nominal values may be sufficient.
Schedule a proper pressure calibration as soon as possible, then press
CHOICE.

Select Yes to reset the calibration to nominal values. Press ENTER.

Select No to contact your service representative to schedule a proper
pressure calibration. Press ENTER.

10- 16
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Review Calibration

REVIEW CALIBRATION

The Review function reviews the results of the last calibration operation.

The sample cell volume and the expansion cell volume are used for calculating the sample volume. The
cell volume and expansion volume are updated automatically when the pycnometer is calibrated.

The prompts that display during a review of calibration data depend on the options specified in Setup >
Analysis Parameters and Report Options.

L.

Press Alt + 5 to display the Chamber Insert prompt from which the insert can be selected (if
used).

Press ENTER to display the volume of the calibration standard. This volume can be edited from
this prompt.

Press ENTER to display the Which Chamber prompt.

Press CHOICE to select whether to view the results for the sample chamber or the expansion
chamber.

Press ENTER to display a prompt showing the starting time and date.
Press ENTER to display a prompt showing the ending time and date.

Press ENTER to display the first of the prompts containing data. The [#] in this example rep-
resents the cycle number.

Unit[n]> SN1234> 10 cm3

Cell [n] = (volume)
Dev [n] = (deviation)

X - X - X

8. Continue pressing ENTER to view all of the data. Press CHOICE to exclude data from report
calculations. An asterisk will display indicating that it will be excluded.
9. Press SAVE to return to the Reload prompt
10. Press Alt + 6 to print report results.
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Display Text

Description

Chamber insert?
(insert)

Displays the insert selected for the calibration or None if an insert was
not used. If the selection is incorrect, press CHOICE until the correct
one is shown, then press ENTER.

« None, 0.1 cm3 (for 1 cm3 unit)

« None, 3.5 cm3, 1.0 cm3 (for 10 cm? unit)

« None, 35 cm?3, 10.0 cm3 (for 100 cm3 unit)

« None, 650 cm3, 1300 cm? (for 2000 cm3 pycnometer)

Volume of Cal Std:

Displays the volume of the calibration standard that was used for the

(volume) calibration. Press ENTER.
Which Chamber? Select to view calibration data for the sample cell chamber or the
(chamber type) expansion chamber. Press CHOICE until the chamber is displayed, then
press ENTER.
The chamber type options are Cell volume and Expansion volume.
Start: Displays the time and date the calibration began. Press ENTER.

(time) (date)

Time: HH:MM:SS
Date: DD/MM/YY

End:
(time) (date)

Displays the time and date the calibration completed. Press ENTER.

Time: HH:MM:SS
Date: DD/MM/YY

Cell[n] = (volume)
Dv[n] = (deviations)

or

Exp[#] = (volume)
Dv[n] = (deviations)

Displays the Volume, depending on the chamber type selected (Cell
volume or Expansion volume).

[n] represents the cycle number.

Press CHOICE to exclude the displayed density (or volume) from the
calculated average. An asterisk next to the density indicates it has been
excluded. Press CHOICE again to remove the asterisk and have it
included.

Each time CHOICE is pressed to exclude or include the value. A new
deviation is calculated and displayed.

Press ENTER to view the values for the next cycle.

Press SAVE to return to the Reload prompt. Press SAVE to automatically
recalculate collected data and add all data reduction messages back into
the queue.

10 - 18
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Temperature

TEMPERATURE

This operation typically is performed by a Micromeritics service representative.

Press Alt + ., then press CHOICE until Temperature is displayed.

Display Text

Description

Temperature:

Calibrate Temperature

Enter the temperature obtained from a reference temperature sensor. Press
ENTER to automatically return to the Reload prompt. Press ALT +
CLEAR to cancel the operation.

ZERO THE PRESSURE TRANSDUCER & CHAMBER VOLUME

The pressure transducer zeroes automatically before each cycle in an analysis or calibration; therefore,
it is not necessary to zero the unit for these operations. Typically, this function is not required unless
manually performing analyses for an extended period of time.

Press Alt + 0 to access the Zero function.

Display Text Description
Zero Type? Allows zeroing of the pressure transducer or the volume offset. Press
Pressure CHOICE until the option is displayed, then press ENTER. If choosing

Pressure, the next prompt is not displayed. Choices are Pressure and
Volume. Ensure the sample chamber is empty if selecting Volume.

Zero Volume?
Chamber insert?
None

Does not display for
Pressure

Displays when Volume is selected. Select Yes at the Request insert
prompt in Report Options. Press CHOICE until the appropriate insert is
displayed, then press ENTER.

o None, 0.1 cm3 (for 1 cm3 unit)

« None, 3.5 cm3, 1.0 cm3 (for 10 cm? unit)

« None, 35 cm?, 10.0 cm3 (for 100 cm’ unit)

« None, 650 cm?, 1300 cm? (for 2000 cm3 pycnometer)

Zero Volume
[ENTER] to start
[ESCAPE] to cancel

or

Zero Pressure
[ENTER] to start
[ESCAPE] to cancel

Press ENTER to begin the zero operation or Alt + CLEAR to cancel the
operation.

If zeroing the Volume, the purges and cycles specified in the current
analysis parameters are used to calculate the volume offset.

After the operation is complete, the pycnometer returns to the Reload
prompt.
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LoAD CALIBRATION DATA FROM A USB STICK

Display Text

Description

Calibration Type?
Load from USB Stick

Press CHOICE until the option is displayed. Press ENTER.

Insert USB stick
and press [ENTER]

Insert the USB device into the USB connector on the rear panel of the
unit. Press ENTER.

Local cal for SN:

Key in the serial number. Press ENTER.

Calibration for
SN (nnnn) copied

Display the unit for which calibration information has been copied.

Remove USB stick

Remove the USB stick. The system automatically returns to the Reload
prompt. This prompt appears immediately after the Calibration for SN
prompt.

CoPY CALIBRATION DATA 1O A USB STICK

Display Text

Description

Calibration Type?
Copy to USB Stick

Press CHOICE until the option is displayed. Press ENTER.

Insert USB stick
and press [ENTER]

Insert the USB device into the USB connector on the rear panel of the
unit. Wait a few seconds, then press ENTER.

Calibration for
SN (nnnn) copied

Display the unit for which calibration information has been copied.

Remove USB stick

Remove the USB stick. The the Reload prompt displays.. This prompt
appears immediately after the Calibration for SN prompt.
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11 HARDWARE COMPONENTS AND ACCESSORY
INSTALLATION

ADD ANALYSIS MoODULE TO CONTROL MODULE

Additional analysis modules provide the ability to increase productivity and / or provide a means for
analyzing different size samples concurrently. Multiple analysis modules can be connected to an
integrated controller / analysis module.

If connecting to a temperature controlled unit, see ""Add Analysis Modules to a Temperature Controlled
Module" on page F - 1.

Control Analysis
module module
or
Glove <
Box Next
—7 module —
¢ B
Diagram Components
Component |Description
A Separate power cord for external power supply. Connect cable to wall outlet.
B External power supply
C Hardwired 8-pin mini-DIN power cable for external power supply.
D 8 pin mini DIN cable.
E Power adapter DIN port.
F Power adapter.
G Module Connection - 8-pin mini-DIN OUT port to connect next analysis module.
H Module Connection - 8-pin mini-DIN IN port to connect the control module or
previously connected analysis module (not shown).
1 Hardwired power mini-DIN cable for power adapter.
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the analyzer.

/ If using the Windows version of the AccuPyc II, exit the application before powering off

to allow time for temperature to stabilize at the desired temperature, while the AccuPyc is

/ If installing an external TEC module, it is suggested that the TEC system be installed first,

being installed. The TEC module has a separate power cord and external power supply.

. Power OFF the control module.

Connect one external power supply cable to the back of the new unit and another external power
supply cable to each power adapter.

3. Connect a power cable to each external power supply.

4. Attach one end of the DIN cable (provided in the module accessories kit) to the connector labeled
Module Connection on the back of the new unit.
5. Attach the other end of the DIN cable to the separate power adapter.
6. Attach the hardwired power adapter cable to the lower connector labeled Module Connection on
the back of the analysis module.
7. Plug the external power supply cables into electrical wall outlets.
8. Power ON the control module. If running the application software, start the application.
9. Verify the unit is recognized:
o If running the application software, Unit [ o D S
[n] menus are added to the menu bar for Fil ;lifﬂitl Unit 2 |Rew't's'"Options.__‘jl‘-’indows Help
each analysis module connected. | Unitl Unit 2 I
« If using the keypad for analysis, press Alt
+ CHOICE + 2 to access the additional Unit[n]> SN 1234> 10 cm3
analysis module. Unit [n] appears in the X - X - X
left f the display.
upper left corner of the display Reload
P = (current pressure)
10. Calibrate the pycnometer. See "'Calibrate using the Keypad" on page 10 - 14 or ""Calibrate using
the Software' on page 10 - 1.
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CONFIGURE AN ANALYTICAL BALANCE

Options > Configure Balance

Used to connect and set up an RS-232 balance to the analyzer. See ""Connect an Analytical Balance"
on page J - 6.

The analytical balance tested by Micromeritics is Scientec® model #ZSA120. See "Parts and
Accessories" on page 13 - 1.

(El Configure Balance ﬂ

" Enable

Serial Port: COM1
Senal Parameters: | 9600.n.7.2

Configure Balance Fields and Buttons Table

Field or Button Description
Enable / Disable Select to enable or disable the attached balance.
Serial Parameter Used to set the baud rate, parity, data bits, and stop bits. This field should

not require modification from the default values.

Serial Port Select which serial port is used to connect the balance to the analyzer.

PRINTER SETUP

Printers are connected to the AccuPyc Il via a USB port. See "Specifications' on page 1 - 10 for a list
of supported printers. Using the keypad:

1. On the display, select Setup > Report Options.
2. Press ENTER until the Printer? prompt is displayed.
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3. Press CHOICE until the appropriate printer driver is displayed.
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12 MAINTENANCE AND TROUBLESHOOTING

What happened Why What to do
Power indicator did not Power or DIN cables not fully inser-| Verify cable connections and con-
illuminate when analyzer |ted nect any loose cable ends into
was power ON. proper outlets.

No power at outlet. Test the outlet. If there is no

power, contact electrician.

Plug prongs bent so that contact not | Unplug the power cable and re-
made at outlet. plug into outlet. If indicator does
not illuminate, have electrician
adjust prongs or replace outlet or
plug.

Power cord damaged. Have electrician check cord using
test meter. Replace if defective.

Loose internal connection, broken | Contact a Micromeritics Service

wire, or failure of internal power Representative for repair or
supply. replacement information.
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What happened

Why

What to do

Specified pressure not
reached or maintained.

Chamber cap not properly closed.

Close chamber cap by turning fully
clockwise.

Chamber cap contains dust or debris
or the O-ring is not properly
greased.

Using a lint free tissue, clean the
chamber cap and the rim of the
cell chamber. Lightly grease the
chamber cap O-ring. See "Grease
the Chamber Cap O-Ring' on

page 12 - 4.

The chamber cap O-ring is not prop-
erly seated.

Check the chamber cap. Ensure
that the O-ring is properly seated
and that it contains no scratches or
cuts.

The chamber cap O-ring is cut or
scratched.

Replace the O-ring in the chamber
cap. See "Replace the Chamber
Cap O-Ring" on page 12 - 4.

Gas leaks in the cell chamber or
expansion chamber.

Check the pycnometer for leaks.
See "Check for Leaks using the
Keypad' on page 12 - 8 or "Check
for Leaks using the Software" on

page 12 - 6.

The helium tank is low on gas, or
empty.

Check tank. Minimum recom-
mended pressure is 200 psig. See
""Set Regulator Pressure' on

page 12 - 14.

The Shut-Off valve on the gas cyl-
inder is closed.

Ensure that the valve is open.

Pressure regulator defect or the pres-
sure is set too low.

Check regulator to be sure it is set
properly. See "Set Regulator Pres-
sure' on page 12 - 14. Call a
Micromeritics Service Rep-
resentative, if necessary.

The Zero offset (of pressure trans-
ducer) is too low.

Check offset by opening chamber
cap. If pressure is negative (dis-
played on instrument schematic),
run a new zero offset. See ""Zero
the Pressure Transducer & Cham-
ber Volume' on page 10 - 19.

Dust filter on 2000 ¢m?3 unit is

clogged or leaking to atmosphere.

Clean the dust filter. See "Clean
the Dust Filter' on page 12 - 9.

12-2
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12 Maintenance and Troubleshooting

What happened

Why

What to do

Helium drained from tank.

Leaks in the gas line connection.

Pressurize the system. Close, then
open the gas cylinder Shut-Off
valve. If the needle on the pressure
gauge falls abruptly, a leak in the
gas line connections may be indic-
ated. Check all gas line con-
nections.

Pycnometer was left in Manual
mode with all the valves open or the
fill valve open and chamber cap off.

Close all valves, then attach a new
tank of helium.

Unit will not equilibrate,
or results are not repro-
ducible.

Sample outgassing.

Prior to analysis, remove moisture
and contaminants from the sample.
See "Preparing and Loading
Sample' on page 6 - 1.

Dust filter on 2000 cm3 unit is
clogged or leaking to atmosphere.

Clean the dust filter. See "Clean
the Dust Filter" on page 12 - 9.

Defective cap O-ring

Check cap O-ring for defects.
Regrease or replace the O-ring, if
necessary.

Debris on valves

With manual mode enabled and
with the cap installed, open all
valves. With helium flowing
through the pycnometer, open and
close the expansion valve
repeatedly for approximately one
minute. This will remove sample
contamination, which may cause a
leak, from the valve seat. Repeat
the process for the vent valve with
the inlet and expansion valves
open.
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CHAMBER CAP O-RING

The cell chamber cap contains an O-ring that requires routine maintenance. The chamber cap O-ring
should be greased at the beginning of each period of use.

Fine fibers and particles between the O-ring and its sealing surfaces can cause leaks, as can scratches
or cuts in the O-ring or in the metal surfaces.

GREASE THE CHAMBER CAP O-RING

1. Turn the chamber cap counter-clockwise and lift it from the chamber.

2. Place the chamber cap on a clean surface with the O-ring side exposed.
3. Use a small drop of Dow Corning high vacuum grease (or equivalent).
4

. Distribute the grease evenly and completely around the O-ring groove.

-

5. Replace the chamber cap.

6. If recalibrating the pycnometer, allow the pycnometer to warm up for 30 minutes before cal-
ibrating.

REPLACE THE CHAMBER CAP O-RING

1. Use a pointed tool and carefully remove the O-ring from its groove in the cap. A small niche is
provided at the groove for placement of the tool.
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@ Do not to scratch the metal surface of the chamber cap. Scratches could result in an imper-
fect seal.

2. Clean the groove in the chamber cap using a small brush or lint-free tissue moistened with iso-
propyl alcohol.

3. Allow the chamber cap to dry thoroughly.
4. Use a small drop of Dow Corning high vacuum grease (or equivalent).

5. Grasp the O-ring with the two greased fingers. Distribute the grease evenly and completely
around the O-ring.

Apply the grease sparingly. Too much grease may alter cell volume while too little grease
results in an imperfect seal and leaks.

6. Place the O-ring back into the groove on the cap and, with the greased index finger, gently press it
back into position.

7. Ensure the O-ring groove is properly greased. See "Grease the Chamber Cap O-Ring" on the
previous page.
8. Replace the chamber cap.
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CHECK THE CELL AND EXPANSION CHAMBERS FOR LEAKS

This procedure should be performed in a temperature-stable environment after the pycnometer has been
allowed to warm for at least two hours. Before performing this procedure, check the chamber cap to
ensure that it is not the source of leaks. It should be free from particles, the O-ring should be properly
seated, and should not contain excessive grease.

CHECK FOR LEAKS USING THE SOFTWARE

of leaks. It should be free from particles, the O-ring should be properly seated, and it should

/ Before performing this procedure, check the chamber cap to ensure that it is not the source
not contain excessive grease.

1. Allow the pycnometer to equilibrate thermally in a room having a stable temperature.

2. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the menu
item. The instrument schematic should display. If not, go to Unit [n] > Show Instrument
Schematic.

3. If the system has been open, manually purge the system before proceeding:
a. On the schematic, open the Expansion valve and close the Vent valve.

b. Open the Fill valve and fill the sample chamber (1-, 10-, 100 cm?3) or expansion chamber
(1- and 2000 cm?) to the correct pressure. Pressure is displayed to the left of the chamber
on the schematic.

c. Close the Fill valve and open the Vent valve.
d. Repeat steps (a) through (¢) two or three times.
e. Close the Expansion valve.

Open the Fill valve.

Fill the first chamber to 19.5 psig (134.4 kPag).

Close the Fill valve.

O

Observe the pressure display. After an equilibration period (about 20 to 30 seconds), the pressure

should not decrease more than 0.007 psig (0.048 kPag) or increase more than 0.02 psig (0.14 kPag)

in a two minute span.

o If the pressure does not decrease more than 0.007 psig (0.048 kPag) or increase more than 0.02
psig (0.14 kPag) in a two minute span, proceed to step 8.

o If the pressure decreases more than 0.007 psig (0.048 kPag) or increases more than 0.02 psig
(0.14 kPag) in a two minute span, temperature instability or a leak may be indicated. Vent the
system, then repeat steps 4 through 7 several times to verify that a leak is indicated. If a leak is
indicated, call a Micromeritics Service Representative.

8. Close the Vent valve, then open the Expansion valve and the Fill valve.
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9. Fill the chambers to 19.5 psig (134.4 kPag).
10. Close the Fill valve.

11. Observe the pressure display. After an equilibration period (about 20 to 30 seconds), the pressure

should not decrease more than 0.007 psig (0.048 kPag) or increase more than 0.02 psig (0.14 kPag)
in a two minute span.

If the pressure decreases more than 0.007 psig (0.048 kPag) or increases more than 0.02 psig
(0.14 kPag) in a two minute span, temperature instability or a leak may be indicated. Vent the

system, then repeat steps 8 through 11 several times to verify that a leak is indicated. If a leak is
indicated, call a Micromeritics Service Representative.

AccuPyc II Operator Manual — (Rev -) 12-7
134-42800-01 — Dec 2014



12 Maintenance and Troubleshooting

[M] micromeritics®

CHECK FOR LEAKS USING THE KEYPAD

of leaks. It should be free from particles, the O-ring should be properly seated, and it should

/ Before performing this procedure, check the chamber cap to ensure that it is not the source
not contain excessive grease.

Check the cell and expansion chambers for leaks.

Unit[n]> SN1234>  10.cm3

X - X - X
Manual

p = (pressufe)

/A I \
Fill valve = | Expansion valve Vent valve

1. Allow the pycnometer to equilibrate thermally in a room with a stable temperature.

2. Press Alt + 1 to enter Manual mode.

3. If the system was previously open, manually purge the system before proceeding:
a. Press 8 to open the Expansion valve and 9 to close the Vent valve; X - O - X.

b. Press 7 to open the Fill valve. Once the sample chamber fills to the appropriate pressure,
press 7 to close the Fill valve.

c. Press 9 to open the Vent valve; X - O - O.

d. Repeat this procedure two or three times.

e. Press 8 to close the Expansion valve; X - X - O.
Press 7 to open the Fill valve; O - X - O.
Fill the sample chamber to 19.5 psig.
Press 7 to close the Fill valve; X - X - O.

N ok

Observe the pressure display. After an equilibration period (about 20 to 30 seconds), the pressure

should not decrease more than 0.007 psig (0.048 kPag) or increase more than 0.02 psig (0.14 kPag)

in a two minute span.

« If the pressure does not decrease more than 0.007 psig (0.048 kPag) or increase more than 0.02
psig (0.14 kPag) in a two minute span, proceed to step 8.

o If the pressure decreases more than 0.007 psig (0.048 kPag) or increases more than 0.02 psig
(0.14 kPag) in a two minute span, temperature instability or a leak may be indicated. Vent the
system, then repeat steps 4 through 7 several times to verify that a leak is indicated. If a leak is
indicated, call a Micromeritics Service Representative.

8. Press 9 to close the Vent valve, 8 to open the Expansion valve, and 7 to open the Fill valve;
0-0-X.
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9. Fill the chambers to 19.5 psig.
10. Press 7 to close the Fill valve; X - O - X.

11. Observe the pressure display. After an equilibration period (about 20 to 30 seconds), the pressure
should not decrease more than 0.007 psig (0.048 kPag) or increase more than 0.02 psig (0.14 kPag)
in a two minute span.

If the pressure decreases more than 0.007 psig (0.048 kPag) or increases more than 0.02 psig (0.14
kPag) in a two minute span, temperature instability or a leak may be indicated. Vent the system,

then repeat steps 8 through 11 several times to verify that a leak is indicated. If a leak is indic-
ated, call a Micromeritics Service Representative.

CLEAN THE DUST FILTER

/ Applicable to 2000 cm? units only.

Dust from the sample may be carried into the instrument plumbing. A dust filter protects the valves,
minimizing valve leaks.

Filter port

o S - Spring

O-ring
/ (size 011)
Sesmm—
O-ring %S%
(size 006) Filter
Cover Retaining
plate screws

1. Press Alt+1 to enter Manual mode.

2. Close the Fill valve. Open the Expansion and Vent valves to ensure that the system is not under
pressure.

3. At the lower rear of the instrument, remove the two screws which hold the dust filter cover and
remove the cover plate.

4. Remove the spring and the filter. Remove the small O-ring inside the filter port.

5. Clean all parts with alcohol. The filter may require sonication to dislodge dust. It should be
replaced if it becomes severely clogged.

6. Inspect the O-rings before re-assembly. A very thin coating of vacuum grease may be used.
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7. Re-assemble.

8. Check for leaks:
a. Fill the system with gas.

b. Open Expansion valve.

c. Check for leaks by applying a leak detecting liquid around the dust filter cover.

CLEAN THE PYCNOMETER

The exterior casing of the pycnometer may be cleaned using a clean cloth, dampened with isopropyl
alcohol (IPA), a mild detergent solution, or a 3% hydrogen peroxide solution.

Do not immerse the pycnometer or the power cord in any liquids. Doing so could result in
electrical shock to personnel or damage to the unit.

age to the unit.

@ Do not allow liquid to penetrate the casing of the pycnometer. Doing so could result in dam-

RECOVER FROM A POWER FAILURE

Setup parameters and collected data are recorded by the pycnometer in case of a power failure. These
settings will be available when power is restored. If an automatic operation was in progress when the
power failure occurred, it will be canceled when the pycnometer restarts.

Even though the pycnometer saves data during a power failure, any operation should be
/ restarted to ensure complete results.
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RESET THE PYCNOMETER

There are two ways to reset the Pycnometer.
« Hold the . key on the keypad during power ON. This erases data and setup parameters except for
printer and network settings.

o Hold 5 on keypad during power ON. This resets setup parameters, as well as printers and network set-
tings.

GUIDELINES FOR CONNECTING GASES

« Place gas cylinders close to the analyzer. Using gas line extenders on gas cylinders located in remote
areas may degrade gas quality and reduce pressure. Gas lines are typically five to six feet long. Place
the bottles close enough to allow for proper connection at the analyzer inlet.

o Use a retaining strap (or other appropriate tether) to secure the gas cylinder.

o Always use the gas lines provided with the analyzer. It is very important that proper gas lines are
used with the analyzer.
o Do not use polymer tubing for the gas line.

o Do not use flexible gas lines. Some flexible lines may appear to be appropriate, such as those
with a herringbone covering, but the line may be coated internally with a polymer.

o Long gas lines, such as those used with gas cylinders placed in remote areas, must be evacuated for
an extended period of time to remove ambient gases. When possible, avoid placing gas cylinders in
remote locations. It is always better to have gas cylinders located near the analyzer.

o Carefully route the gas lines from the cylinder to the analyzer avoiding overlapping or entangling gas
lines. This will help avoid confusion in the event maintenance is required.

o Label the gas line at the analyzer inlet for proper identification and maintenance.

o Replace gas cylinders before gas is depleted. It is best to replace a gas cylinder when the pressure
reads approximately 200 psi on the high-pressure gauge. Contaminants absorbed to the walls of the
cylinder will desorb as the pressure decreases.

« Ensure the gas cylinder is closed before connecting to the analyzer.
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REPLACE A GAS CYLINDER

A
A

These instructions apply to working with inert gases only. When working with hazardous
gases, follow the safety procedures established by your lab.

A power failure can result in dangerous pressures in the sample chamber. When using toxic
or flammable gases, additional venting of the cabinet may be required.

Low pressure
gauge High pressure

‘ gauge Gas bottle shut-off
\ valve
Gas regulat; M ;- -:‘.\
shut-off valve 2, " /¥ o
- ‘\ :3 ) &, N ’ | -

Copper
tubing

- e

Brass reducer
fitting

Regulator

connector nut
Regulator

control knob

Disconnect the Depleted Gas Cylinder

1. Close the gas cylinder shut-off valve by turning the valve clockwise.

2. Disconnect the gas line from the regulator and allow the regulator line to purge. The gas will
begin to vent. It is not necessary to disconnect the gas line from the analyzer inlet.

3. Open the gas regulator shut-off valve by turning the valve counter-clockwise. The gas will con-
tinue to vent.

4. Turn the regulator control knob clockwise to open and vent any remaining gas. Both gauges should
read at or near zero. If not, open the gas regulator shut-off valve to release gas. It is not necessary
to disconnect the gas line from the regulator or the analyzer.
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5. Close the regulator control knob.

6. Use an appropriate wrench to loosen the nut at the regulator / gas cylinder connection then remove
the regulator from the bottle.

7. Replace the protective cap on the depleted bottle. Disconnect the retaining strap and move the
bottle to an appropriate location.

Connect A Gas Cylinder

Move the replacement bottle close to the analyzer and tether it into place. It is not necessary to
disconnect the gas line from the regulator or the analyzer.

1. Use an appropriate cylinder wrench to remove the protective cap from the replacement gas cyl-
inder. Place the protective cap in a secure location. It will be needed to recap the gas cylinder
when it is depleted and replaced.

2. Attach the gas regulator to the gas cylinder connector. Hand-tighten the nut, then use an appro-
priate wrench to tighten an additional 3/4 turn.

@ Over-tightening the fitting may cause a leak.

3. Check for leaks at the high-pressure side of the regulator and in the connector.

a. Turn the regulator control knob fully counter-clockwise.
b. Slowly open the gas cylinder shut-off valve, then quickly close it.

c. Observe the pressure on the high-pressure gauge for approximately one minute:

o Ifthe pressure is stable, proceed with the next step.

o If the pressure decreases, tighten the regulator connector nut until it
becomes stable. If the pressure does not remain stable, remove the reg-
ulator and clean all contacts at the regulator connection, then reinstall the
regulator.

4. Purge the lines and set the regulator pressure.
a. If the gas line is not connected to the regulator and the instrument connect it now.

b. Fully open the gas bottle shut-off valve and the gas regulator shut-off valve.

°

Under manual control, open the fill, expand, and vent valves.

&~

Adjust the regulator pressure control knob until the Purge fill or Cycle fill pressure,
whichever is higher, is shown on the regulator display.

o

Allow gas to flow for 30 seconds.

=

Close the fill, expand, and vent valves.

g. Turn the regulator control knob clockwise to increase pressure by 2 psi (15 kPa).
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SET REGULATOR PRESSURE

Low pressure

gauge High pressure

gauge Gas bottle shut-off

\ valve
Gas regulator m ’ - -:\ /
2, " / 3 g

shut-off valve

Copper
tubing

Brass reducer
fitting

Regulator

connector nut
Regulator

control knob

SET REGULATOR PRESSURE WITH THE SOFTWARE

psig indicate the tank is low on gas. Analyses are terminated automatically if gas is

/ Ensure the tank pressure for the gas regulator is at least 200 psig. Pressures less than 200
depleted.

The Purge fill and Cycle fill pressures are specified in Analysis Conditions. Set the regulator pressure at
the higher of the two, plus 2.0 psig. For example; if the Purge fill pressure is set to 19.500 psig (134.445
kPag) and the Cycle fill pressure as 19.000 psig (131.000 kPag), set the regulator pressure at 21.500 psig
(148.237 kPag).

1. Verify that the tank pressure for the gas regulator is at least 200 psig (1379 kPag).

2. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the menu
item. The instrument schematic should display. If not, go to Unit [n] > Show Instrument Schem-
atic.

3. On the schematic, right click the Expansion and Vent valves and select Open for both. Then open
the Fill valve.

4. Adjust the regulator pressure control knob until the Purge fill or Cycle fill pressure, whichever is
higher, is shown on the regulator display.
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Set Regulator Pressure with the Keypad

On the schematic, close the Fill valve, then increase the regulator pressure by 2.0 psig (13.8
kPag).

Allow the pressure in the pycnometer to drop below 2.0 psig, then close the Expansion and Vent
valves.

SET REGULATOR PRESSURE WITH THE KEYPAD

psig indicate the tank is low on gas. Analyses are terminated automatically if gas is

/ Ensure the tank pressure for the gas regulator is at least 200 psig. Pressures less than 200

depleted.

The Purge fill pressure and cycle fill pressure are specified using Setup > Analysis Parameters. Set the
regulator pressure at the higher of the two (plus 2.0 psig). For example; if the purge fill pressure is
specified as 19.500 psig and the cycle fill pressure as 19.000 psig, then set the regulator pressure at

21.500 psig.
1. Press Alt + 1 to enter Manual mode.
2. Press 8 (EXPAND) and 9 (VENT) to open the expansion and vent valves; the display will show:
X-0-0
3. Press 7 (FILL) to open the fill valve; the display will show: O -0 - O
4. Adjust the regulator pressure control knob until the Purge fill or Cycle fill pressure, whichever is
higher, is shown on the regulator display.
5. Press 7 to close the Fill valve, then increase the regulator valve by 2.0 psig. The display will
show: X - O - O.
6. Allow the pressure in the pycnometer to drop below 2.0 psig, then press 8 and 9 to close the
Expansion and Vent valves. The display will show: X - X - X
7. Press SAVE to return to the Reload prompt.
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13 Parts and Accessories

13 PARTS AND ACCESSORIES

Order system components and accessories using one of the following methods:

« Call our Customer Service Department at 1-770-662-3636

o Email orders to Orders@Micromeritics.com

« Contact your local sales representative

Part Number

Item and Description

Analyzer Equipment

134-00000-00

AccuPyc II, 10 cm3 capacity

134-00001-00

AccuPyc 11, 1 cm? capacity

134-00002-00

AccuPyc 11, 100 cm? capacity

134-00005-00

Control Module, no sample compartment

134-00010-00

AccuPyc II, flowing temperature control, 10 cm3 capacity

134-00020-00

AccuPyc I, flowing temperature control, 100 cm? capacity

134-00030-00

AccuPyc II Glove Box, 10 cm3 capacity

134-00031-00

AccuPyc II Glove Box, 1 cm? capacity

134-00032-00

AccuPyc II Glove Box, 100 cm? capacity

134-00033-00

AccuPyc II Glove Box, 350 cm? capacity

134-00034-00

AccuPyc II Glove Box, 2000 cm? capacity

134-00035-00

AccuPyc II TEC, 10 cm3, Glove Box

134-00036-00

AccuPyc II TEC, 100 cm3, Glove Box

134-00040-00

Analysis module, 10 cm3 capacity

134-00041-00

Analysis module, 1 cm? capacity

134-00042-00

Analysis module, 100 cm? capacity

134-00043-00

Analysis module, 350 cm3 capacity

134-00044-00

Analysis module, flowing temperature control, 10 cm3 capacity

134-00045-00

Analysis module, flowing temperature control, 100 cm? capacity

134-00046-00

Analysis module, 2000 cm? capacity

134-00047-00

Analysis module 1340 TEC, 10 cm?

134-00048-00

Analysis module 1340 TEC, 100 cm?3

134-00050-00

AccuPyc II TEC, 10 cm3

134-00051-00

AccuPyc I TEC, 100 cm?

Cables

003-60623-00

Cable, 2 ft; for connecting analysis modules

003-60623-01

Cable, 25 ft; for connecting Control module to Glove box unit
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Part Number

Item and Description

003-63801-00

Ethernet cable, cross-over

003-63821-00

Null Modem Cable, for connecting Analytical Balance to Con-
troller/Data Management Module

Calibration Kit

133-34900-00

Calibration Standard Kit, 10 cm3; contains two calibration standard
and one sample cup

134-34901-00

Calibration Standard Kit, 2000 cm3; contains one calibration standard
and one 2000 cm3 sample cup

133-34902-00

Calibration Standard Kit, 100 cm?; contains one calibration standard
and one 100 cm? sample cup

133-34903-00

Calibration Standard Kit, 350 cm3; contains 3 calibration standard
and one sample cup

Chamber Cap O-rings

004-25032-00

Chamber cap O-ring, 2000 cm?3

004-25575-00

Chamber cap O-ring, 10 cm3

004-25577-00

Chamber cap O-ring, 100 cm?3

004-25637-00

Chamber cap O-ring, 1 cm?

004-25689-00

Chamber cap O-ring, 350 cm?

Dust Filter Components (for 2000 cm3 units only)

O-ring
/ (size 011)
Lol
O-ring RS )
(size 006) Filter / \
Cover Retaining
plate screws

Filter port

@‘W S .
pring
/

004-25006-00

O-ring, -006 70 DURO BUNA-N

004-25011-00

O-ring, -011 70 DURO BUNA-N

004-25312-00

Compression spring

004-27082-00

Filter, Line, 10 Micron

Equipment (Optional)

011-00000-00

Scientec Analytical Balance, model ZSA 120

133-33604-00

MultiVolume Kit for 100 cm? pycnometer; includes 10 cm? and 35
cm? inserts and appropriate sample cups

13-2
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13 Parts and Accessories

Part Number

Item and Description

133-33605-00

MultiVolume Kit for 10 cm3 pycnometer; includes 1 cm?® and 3.5 cm?
inserts and appropriate sample cups

134-33605-00

MultiVolume Kit for 2000 cm3 pycnometer; includes 650 cm?® and
1300 cm3, cups, inserts, and reference standards

134-33006-00

MultiVolume Kit for 1 cm3 pycnometer; includes 0.1 cm?3 insert /
sample cup combination

Filtered Cup Assemblies (Optional)

133-25862-00

Filtered cup assembly, 10 cm3; used to constrain powdered samples

133-25863-00

Filtered cup assembly, 100 cm?; used to constrain powdered samples

Filtered Cup Assembly Components (for 100 cm3 units only)

Filter ca
=
CD/ O-ring (size 024)
CP‘—-— Paper filter
% — ™ Spring dlip
—
e~ Modified 100 cc

—
- sample cup
—

004-25299-00

O-ring, size -024 70 DURO BUNA-N

004-27055-00

Paper filter (100 pack)

133-25845-01

Modified 100 cc sample cup

133-25901-00

100 cc sample cup filter cap

133-25902-00

Spring clip for 100 cc sample cup cap

Gas Accessories

004-25549-00

Reducer, 1/8 in. tube X 1/4 in. tube

004-62230-58

Gas regulator, 30 psig, CGA 580

134-33020-00

Multigas Manifold; to connect multiple gases to the analysis unit

290-25846-00

Gas inlet line assembly

Keypad Template

134-42701-01

French template

134-42701-02

German template

134-42701-03

Spanish template

134-42701-04

Italian template
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Part Number

Item and Description

Operating Supplies

0089-16045-00

High Vacuum grease, Dow Corning

Power Accessories

003-40054-00

AC/DC power supply, external

003-40058-00

AC/DC external power supply, for TEC module on TEC instruments

003-60101-00

Power cord, US, Canada, Japan

003-60101-05

Power cord, Schuko, for European countries

134-34007-00

Power Adapter

Sample Cups

134-25600-00

Sample cup, disposable, 2.5 cm3 capacity (qty. 50)

133-25805-00

Sample cup, 10 cm?3 capacity

133-25805-02

Sample cup, 10 cm?3 capacity, stainless steel

133-25845-00

Sample cup, 100 cm? capacity

133-25845-02

Sample cup, 350 cm3 capacity

133-25855-02

Sample cup, 1 cm3 capacity

134-25874-00

Sample cup, 2000 cm? capacity (used with CorePyc)

134-25875-00

Sample cup, 1300 cm3 capacity (used with CorePyc MultiVolume kit)

134-25876-00

Sample cup, 650 cm3 capacity (used with CorePyc MultiVolume kit)

134-33007-00

Disposable Sample Cup Kit, for AccuPyc II (10 cm?) includes cham-
ber insert for 2.5 cm3 (nominal) disposable aluminum cups, cal-
ibration sphere, plus 50 disposable cups.

135-25804-00

Sample cup, 35 cc capacity (used with 100 cc MultiVolume kit)

135-25805-00

Sample cup, 3.5 cc capacity (used with 10 cc MultiVolume kit)

Software and Manuals

134-20802-00

AccuPyc II Software for Windows

134-20804-00

AccuPyc II Software for Windows (with FoamPyc)

134-20808-00

AccuPyc II Software for Windows (Asphalt)

134-33005-00

Windows Upgrade for FoamPyc; includes software and operator
manual

134-42800-00

AccuPyc II Operator Manual (includes keypad and software ver-
sions, binder and dividers)
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A ERROR MESSAGES

2201 | Cannot execute report subsystem.

Cause: Start Report failed to execute the report subsystem (which is a separate process).

Action: Restart the computer. If the problem persists, reinstall the application (this will not
affect any of your sample files). Contact a Micromeritics service representative if
this error message continues.

2204 | Communication attempt with [#] failed [#]. Please check application directory for
file.

Cause: A file necessary for reporting is missing.
Action: Re-install the software.

2401 | FATAL ERROR.

Cause: An internal processing and / or hardware error has occurred during communication
with the analyzer.
Action: Contact your Micromeritics service representative.

2430 | Error accessing file [1], error code = [n].

Cause A: Media may be damaged.

Action A:  Clean the media drive. If this does not eliminate the problem, attempt operation
using a backup copy of the file.

Cause B: Hard disk may be damaged.

Cause B: Contact your Micromeritics service representative.

Cause C: A software error occurred when the file was accessed.

Cause C: Contact your Micromeritics service representative.

Cause D: The file name specified contains one or more invalid characters.

Cause D: Enter a valid file name. Do not use characters such as * or ?. Refer to the oper-
ating system manual.

2431 | Error writing file [#], error code = [x].

Cause : Insufficient hard disk to perform the operation.
Action :  Copy files not used regularly from the hard disk external media. Delete them from
the hard disk, and then try the operation again.

2432 | Invalid response from MMI ‘FILE_READ’ request.

Cause: An internal processing and/or hardware error has occurred.
Action: Contact a Micromeritics service representative if this error message continues.

2433 | New entries have been found in this directory. Refresh the directory information?
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Cause:

Action:

Several analyzer files (sample information, analysis conditions, adsorptive prop-
erties, or report options) have been added to this directory by some function other
than the analyzer program.

Click Yes to update the directory information with data from each new file. This
operation may take a minute.

Click No to locate the file manually. This option may be feasible if a large number
of files have been copied into the directory and the file name is known.

2434 | File [n] — Subset [1] wrote wrong [#] of data, expected [#] bytes.

2436 |

Cause:
Action:

Cause:
Action:

An internal processing and/or hardware error has occurred.
Contact your Micromeritics service representative.

Path specification [#] is invalid.

An invalid path name and / or extension was entered.
Type a valid path name (including the proper extension), then press Enter.

2437 | File name [r] does not exist.

Cause:
Action:

The entered file specification does not exist.
Enter an existing file specification, or select a file name from the list box.

2439 | Could not register file.

Cause:
Action:

An unexpected error occurred when trying to access a data file.
Contact your Micromeritics service representative.

2440 | Subset not found.

Cause:
Action:

An unexpected error occurred when trying to access a data file.
Contact your Micromeritics service representative.

2441 | Seek within file failed.

Cause:
Action:

An unexpected error occurred when trying to access a data file.
Contact your Micromeritics service representative.

2442 | Bad header in subset file.

Cause:
Action:

An unexpected error occurred when trying to access a data file.
Contact your Micromeritics service representative.

2443 | Subset owner denied access.

Cause:
Action:

An unexpected error occurred when trying to access a data file.
Contact your Micromeritics service representative.
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2444 | Not a valid file format.

Cause: Anunexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2445 | Subset wrote the wrong amount of data.

Cause: Anunexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2446 | Error reading data.

Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2447 | Error writing data.

Cause: Anunexpected error occurred when you tried to access a data file.
Action: Contact your Micromeritics service representative.

2448 | Basic Mode default parameter file directory [#] is invalid. Resetting to the install-
ation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | Default Adsorptive Properties directory [#] is invalid. Resetting to the installation
directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | Default parameter file directory [#] is invalid. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | Default report options directory [#] is invalid. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.
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2448 | Default sample file directory [#] is invalid. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | Default script test file directory [#] is invalid. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | The reference file directory [#] cannot be used. Resetting to the installation dir-
ectory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | The z-table file directory [1] cannot be used. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2449 | This field does not contain a valid file specification.

Cause: An invalid file name was entered.
Action:  See the description of file naming conventions in a Windows manual, then re-enter
the name.

2450 | Sample Defaults may not be edited while this operation is in progress. Do you wish
to save and close the Sample Defaults edit session?

Cause: An automatic analysis (an analysis in which sample files are created using the
defaults) was processing while editing the defaults.

Action: Finish the edit session of the defaults, close the window, then restart the automatic
analysis.

2452 | Attempt to write MICATTR.DIR in read only mode. [~]

Cause: The Read-Only attribute is turned on in the application’s MICATTR.DIR file (this
file exists in each folder containing sample or parameter files).
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Action: Use Windows Explorer to access the folder containing the MICATTR.DIR file,
then disable the Read-Only option.

2453 | Attempt to append MICATTR.DIR in read only mode. [file name]

Cause: The Read-Only attribute is turned on in the application’s MICATTR.DIR file (this
file exists in each folder containing sample or parameter files).

Action: Use Windows Explorer to access the folder containing the MICATTR.DIR file,
then disable the Read-Only option.

2454 | Too many selections for a print-to-file operation. Only the first (number) selections
will be processed. Please reselect the remainder.

Cause: Too many files were selected for this operation.
Action: Select only the number of files specified in the message.

2455 | Too many selections for an export-to-file operation. Only the first (number) selec-
tions will be processed. Please reselect the remainder.

Cause: Too many files were selected for this operation.
Action: Select only the number of files specified in the message.

2456 | Insufficient file handles available. Application cannot continue.

Cause: More than 50 files are open at the same time.
Action: Refer to an operating system manual then set the limit for open files to 50 or
greater.

2457 | Results cannot be displayed. More than [1#] windows are currently displaying or
printing results.

Cause: Too many windows are open in the application.
Action: Close some of the open windows.

2458 | An instrument is performing a critical operation. Wait a few moments before exiting
the application.

Cause: An attempt was made to exit the application while the instrument was performing a
critical operation. This operation must be completed before the application can be
exited.

Action: Wait a short time and attempt to exit the application again.

2459 | An instrument is busy. A delay in restarting this application could result in loss of
new data. Continue with program Exit?

Cause: An attempt was made to exit the application while an analysis was in progress.
While this is possible, the data collected when the application is inactive will not

AccuPyc II Operator Manual — (Rev -) A-5
134-42800-01 — Dec 2014



A Error Messages

[M] micromeritics®

be permanently recorded until the application is re-started. A power failure to the
instrument could cause some data to be lost.

Action: 1f not concerned with the potential for loss of data should a power failure occur,
click Yes to continue; otherwise, click No.

2460 | Fatal Communications error on [#].

Cause: There was a fatal error in communication between the application and the software
in the instrument. All displays for that instrument will be closed.

Action: Ensure that the analyzer is connected to the computer on the communications port
configured in the Setup program. Stop and restart the analyzer software. Contact
your Micromeritics service representative.

2461 | No instruments are in operation. This application will unconditionally terminate.

Cause: At least one instrument must be active for the application to operate. The

initialization of all of the instruments configured with the Setup program has failed.
The application stops.

Action A: Usually this message is preceded by another message giving the reason for the
instrument’s failure to initialize. Refer to the instructions for that message.

Action B:  Ensure that the instrument is attached to the computer on the communications port
configured with the Setup program. Verify that the instrument's power switch is in the
ON position and that the light on the front panel is illuminated. If the application
continues to fail in its attempts to initialize the instrument, contact your
Micromeritics service representative.

2477 | [n] did not properly initialize.

Cause: The software was unable to initialize this instrument. This is usually caused by one
of the conditions listed in the previous error messages.
Action A:  Run the Setup program and ensure that a valid port is specified; if not, specify a
valid one when prompted.
Action B: Reinstall the software, then restart application.
Action C: Contact a Micromeritics service representative if this error message continues.

2478 | Error copying sequential data segment.

Cause: An internal processing and / or hardware error occurred while accessing a portion
of a sample file.

Action: Confirm that the media being accessed does not contain errors.. Contact your
Micromeritics service representative.

2479 | The instrument is busy performing an operation of which this application is
unaware. Do you want to cancel? [Yes, No]

Cause: During initialization of the application, the status of the analyzer was found to be in
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a different state than expected.
Action: Click Yes to cancel the operation in process and allow the analyzer to reset, then
continue with initialization. Click Noto cancel the initialization process.

If this error message continues, verify that files in the application directory
structure are not being changed or removed.

2480 | File [#] cannot be analyzed. It is currently being edited.

Cause: An attempt was made to start an analysis using a file that is open for editing.
Action: Finish editing the file, save and close it, then start the analysis.

2481 | Error accessing the sample information file [#].

Cause: An unexplained error prevented access to this file.
Action: The hard disk drive may be corrupt. Run diagnostics.

2482 | File cannot be opened for writing.

Cause: An attempt was made to open a file currently being used.

Action: Locate the application using the file (in the Micromeritics application, use the
Windows menu item to get a list of all open windows, one of which may contain
this file).

2483 | An analysis cannot be performed on [#]. It is open for editing and contains errors.

Cause: An attempt was made to use a sample file containing errors that is currently open.
Action:  Go to the window containing the file, correct the errors, then save it.

2484 | The edit session for [#] must be saved before the analysis. Save changes and con-
tinue with the analysis?

Cause: An attempt was made to start an analysis using a file that contains unsaved
changes and is open for editing.

Action: Click Yes to save the changes, then proceed with the analysis. Click No to cancel
the analysis, then continue editing the Sample Information file.

2485 | The service test file has an invalid status and cannot be used for this analysis.

Cause: The selected file has a status other than No Analysis.

Action: Select a different service test file, or create a new one and use Replace All to
copy parameters from the file originally selected.

2486 | Could not construct [#] report type. Program will terminate.

Cause A: Full rights to the application’s folders and files is required.
Action A: Contact a system administrator to have full rights granted.
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Cause B: An internal processing and / or hardware error has occurred.
Action B:  Contact your Micromeritics service representative.

2487 | Could not start report generator. Error code [#]. Program will terminate.

Cause A: Full rights to the application’s folders and files is required.
Action A: Contact a system administrator to have full rights granted.
Cause B:  An internal processing and / or hardware error has occurred.
Action B:  Contact your Micromeritics service representative.

2488 | File [#] cannot be opened for editing.

Cause: The specified file is being used in another edit operation.
Action: Check the Windows list to locate the other edit session.

2489 | File [#] cannot be opened for writing.

Cause: The specified file in a Save As operation is already open for edit.
Action: Select a different file for the Save 4s operation.

2490 | No “.INT’ file present. Application will terminate.

Cause: The ASCII .INI file containing initialization information and system options inform-
ation used during program startup does not exist.

Action: Run the analyzer Setup program (located on the applications CD), select Change
analyzer setup and enter the pertinent information.

2491 | Highlighted fields contain errors. Please correct the errors before dialog box.

Cause: The highlighted fields contain invalid entries. The window cannot be closed until
all errors are corrected.
Action: Check the entries, correct the errors, then close the window.

2492 | This field’s entry is invalid.

Cause: The highlighted field contains an invalid entry.
Action: Check the entry and correct the error.

2493 | An entry is required for this field.

Cause: This field requires a valid entry to proceed.
Action:  Enter or select an appropriate value.

2494 | Value is out of the valid range.

Cause: The entered value in the highlighted field is outside the valid range of values.
Action: Check the entry, then either enter or select an appropriate value.
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2495 | Value is out of the valid range. Enter a value between [#] and [x].

Cause: The entered value in the highlighted field is outside the valid range of values.
Action: Check the entry, then either enter or select an appropriate value.

2496 | Invalid number.

Cause: An invalid number was entered in the highlighted field.
Action: Check the entry, then either enter or select a valid number.

2497 | This field contains an invalid character.

Cause: An invalid character was entered in the highlighted field.
Action: Check the entry, then enter valid characters.

2498 | The requested change to the Sample’s status is invalid at this time.

Cause: A request to change the file’s status, for example, from automatically collected to
manually entered could not be done.

Action: Contact your Micromeritics service representative. Record the name of the sample
file in which the problem occurred.

2499 | Sequence number must contain at least 3 digits.
Cause: An attempt was made to enter a sequence number that did not contain at least three
digits.
Action: Enter a sequence number that contains at least three digits.

2500 | All sample file names that can be created using the sequence number pattern
already exist. You may want to modify the next sequence number.

Cause: No more sample information files can be created using the currently entered file
name sequence number.
Action:  Go to Options > Default Method, then enter another sequence number.

2501 | System resources have reached a dangerously low level. Please close some win-
dows to avoid the loss of data.

Cause: A large number of windows are open and consuming the system resources
available to all applications.
Action: Close one or more windows. Contact your Micromeritics service representative.

2502 | Error writing to file [#] during print. Error code [~].

Cause: An error occurred in the file being written to during a print operation.
Action: Ensure there is sufficient space on the drive containing the file.

2503 | Error converting file [#]. Cannot create DIO intermediate file.
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Cause: An error occurred while printing a report to file.
Action: An attempt was made to replace a file that is read only or the computer login does
not have permission to do so. Contact your IT Department.

2504 | Cannot create output file for sample [#].

Cause: There may be insufficient disk space.
Action: Ensure that sufficient space is available. Contact a Micromeritics service
representative if this error message continues.

2505 | Error logger cannot be initialized. Error code [#]. Program will exit.

Cause: An internal processing error has occurred.
Action: Contact your Micromeritics service representative.

2506 | Output device [#] is not installed. Printing cannot be accomplished.

Cause: An internal processing error has occurred.
Action: Contact your Micromeritics service representative.

2508 | Overlay [#] was not found. It will not be included in the reports.

Cause: The specified overlay file could not be found.
Action: Ensure the file specified as an overlay exists.

2509 | Error opening file [z]. Reports cannot be produced.

Cause: An error occurred while the program was opening a file necessary to the report
operation.

Action: Use the name given in the error message to investigate. Contact your Micro-
meritics service representative.

2510 | Error parsing reports from file [1]. Reports cannot be produced.

Cause A: One or more data entry fields in the sample file may contain an invalid character
(such as a single quote or double quotes).

Action A: Review the data entry fields (for example, the Sample field), then remove the
invalid character.

Cause B: The system was unable to create the usual temporary files during the report, pos-
sibly due to insufficient disk space.

Action B:  Check the space available on the hard disk.

Cause C: An internal processing error occurred.

Action C: Contact your Micromeritics service representative.

2511 | Print job [#] has been canceled due to insufficient disk space. Delete unnecessary
files and restart the report.
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Cause: The disk drive does not have required space for the temporary file.
Action: Delete unnecessary files from the disk. At least five megabytes of free space is
required for normal operation.

2512 | Print job [#] canceled.

Cause: The print job was canceled by the operator.
Action: None required.

2513 | Unable to read the calibration file [#].

Cause: An invalid calibration file was selected or cannot be read.
Action: Ensure the media containing the calibration file has no problems.

2514 | Unable to write the calibration file [#].

Cause: An attempt to save calibration data has failed due to possible media problems.
Action A: Ensure the destination location has no problems.
Action B:  Choose an alternate media to save the calibration data.

2515 | Warning: Changing the calibration information will affect the performance of the
instrument. Only qualified service personnel should do this. Do you wish to proceed?

Cause: The process of performing a calibration operation was started.
Action: Calibration operations should only be done by or under the direction of qualified
service personnel.

2516 | Warning: Keeping a backup copy of the calibration data is recommended by Micro-
meritics. Would you like to do so now?

Cause: A calibration operation was performed and a backup copy is recommended.
Action:  Go to Unit [n] > Calibration > Save to File to perform a calibration save operation.

2517 | Canceling this dialog will reset the calibration state to what it was when this dialog
was first opened. Are you sure you want to cancel?

Cause: The calibration has not been accepted.
Action: 1f the calibration operation was successful, click Accept.

2520 | No data points available for reporting.

Cause: The selected sample file does not have collected data and cannot be used for
reporting.
Action: Select a different sample file.

2521 | Unable to program controller.
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Cause: A hardware malfunction has occurred.
Action: Contact your Micromeritics service representative.

2522 | Invalid controller application file.

Cause: The application’s control file has been corrupted or deleted.
Action: Reinstall the analysis program.

2523 | Programming controller failed.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2524 | CRC check failed on programming controller.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2525 | Unknown error programming controller.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2526 | Controller download was not successful.

Cause: An internal processing and / or hardware error has occurred.
Action A:  Contact your Micromeritics service representative.

2527 | Controller CRC error on boot block.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2528 | Controller DRAM error.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2529 | Controller Com 1: error.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2530 | Controller Com 2: error.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2531 | Controller debug port error.
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Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2532 | The instrument contains a different software version. Do you want to reset it?

Cause: The application has discovered a different version of software operating in the
analyzer.

Action: 1f there are no analyzers other than the one connected to the computer, click Yes,
then allow the updated software to load.

2533 | Analyzer initialization failed.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2534 | Error opening file[#] for printing. Error Code [#].

Cause: An error occurred in the selected file for print output.
Action: Ensure that sufficient disk space is available.

2548 | System status 1 [#].

Cause: There was a problem establishing communication with the analyzer.

Action: Ensure that the communications cable is seated firmly in the Ethernet slot at the
analyzer connection and the computer connection. Contact your Micromeritics
service representative.

2548 | System status 2 [n].

Cause: There was a problem establishing communication with the analyzer.

Action: Ensure that the communications cable is seated firmly in the Ethernet slot at the
analyzer connection and the computer connection. Contact your Micromeritics
service representative.

2549 | Error accessing online manual file [#].

Cause: The operator’s manual file could not be located.
Action A: Reinstall the application.
Action B:  Copy the contents of the manual folder from the setup CD to the application
directory.

2550 | Attempts to acquire the instrument’s status timed out.

Cause: There was a problem establishing communication with the analyzer.

Action: Ensure that the communications cable is seated firmly in the Ethernet slot at the
analyzer connection and the computer connection. Contact your Micromeritics
service representative.
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2551 | Cannot access web page [#].

Cause: The Micromeritics web page for DFT models cannot be accessed. This could be
caused by an ISP problem of high internet traffic.
Action: Try the operation later.

6000 | An error occurred while loading the application control information. Data entry can-
not be performed. (Code [#]).

Cause: An error occurred accessing the control information disk file required by this applic-
ation.
Action: The disk drive may have failed or be corrupt. Run diagnostics on the disk drive.

6001 | Unable to establish the TCP connection with the instrument.

Cause: A communications problem between the computer and the analyzer has occurred.
Action A:  Check the cable connection between the computer and the analyzer
Action B:  Go to Unit [n] > Unit Configuration and verify that the TCP/IP configuration for
the computer and the analyzer are correct.
Action C: Exit the application, and turn off the analyzer. Then turn on the analyzer and restart
the application. Contact a Micromeritics service representative if this error mes-
sage continues.

6002 | Configured serial number does not match instrument.

Cause: An incorrect serial number was entered when installing the software.

Action  Exit the application. Access the Setup program and remove the incorrect analyzer.
Then use the Add an Analyzer option in the Setup program to add the correct serial
number for the controlling unit. Contact a Micromeritics service representative if
this error message continues.

6003 | The instrument [#] is not calibrated.

Cause: Calibration data for the selected unit was not found
Action: Go to Unit > Calibration. Select the appropriate Calibration menu item or load a
saved calibration.

6110 | Error accessing the sample information file [«].

Cause: There was an error opening a file.

Action: Code 5: There is a problem with the computer login permissions. Consult your IT
department.
Code 2: File not found. Select a different file name.

6111 | File [#] cannot be analyzed. It is currently being edited.

Cause: An open file was selected. This message is informational-only.
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Action: Click OK to close the error message window. Then continue editing the file, save
and close it; or click Browse and choose a different file.

6112 | File [#] cannot be opened. It is currently being setup for analysis.

Cause: An open file was selected that is currently being used for analysis.
Action: Select a different file.

6113 | An analysis cannot be performed on [#]. It is open for editing and contains errors

Cause: The selected analysis file contains errors and is open for editing.
Action: Finish editing the file, save, and close it, or choose a different file. Then restart the
analysis.

6114 | The edit session for [#] must be saved before the analysis. Save changes and pro-
ceed with the analysis?

Cause: An attempt was made to start an analysis using a file that contains unsaved
changes and is still open.

Action: Click Yes to save the changes and proceed with the analysis. Click No to cancel
the analysis and continue editing the file, save and close it; or click Browse and
choose a different file.

6120 | Unable to read the calibration file [#].

Cause: The selected calibration file is not valid or cannot be read.
Action: Ensure the media containing the calibration file has no problems.

6121| Unable to write the calibration file [#].

Cause: An attempt to save calibration data has failed due to possible media problems.
Action A:  Confirm the media containing the calibration file has no problems.
Action B:  Choose an alternate media to save the calibration data.

6122 | File contains calibration data for a different unit [#].

Cause: A calibration file from a different unit was loaded.
Action: Load a file for the current unit or go to Unit > Calibration and select the appro-
priate menu item.

6123 | The device has no calibration data for the selected insert.

Cause: A calibration report was produced for an insert that has not been calibrated.
Action: Perform a volume calibration for the insert or produce a report for a different
insert.

6126 | The cell and expansion volumes must be positive. Enter positive values and recal-
ibrate.
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Cause: According to the calibration data, the cell volume or expansion volume for the
selected insert is zero or a negative value
Action: Perform these steps:
1. Select Setup > Calibration Data.
2. Inthe Cell volume field, enter the volume of the sample cell (or insert).
3. Inthe Expansion volume field, enter half of the sample cell volume.
4

. Perform a volume calibration.

6127 | The entered calibration volume is < 10% of the cell volume. The resulting calibration
may be inaccurate.

Cause A: An incorrect volume was entered for the calibration standard.
Action A: Correct the volume entry.

Cause B: The calibration standard is too small for the cell.

Action B: Use a larger calibration standard.

6160 | Device in recognizable state. Analysis canceled.

Cause: The application was closed during an analysis. When the application was restarted,
the analysis had been canceled.

Action: None required. The data collected up to the point of cancellation is saved in the
sample file.

6161 | The sample file [#] is already present in the sequence.

Cause: An attempt was made to insert an existing file into the Sample File list.
Action: None required. The same file cannot be inserted into the list multiple times.

6162 | The sequence list is full.

Cause: An attempt was made to add another file to the Sample File list for sequenced ana-
lyses when the list already contains eight entries.
Action A:  Run the sequence analysis with the current list and include the preferred file in the
next sequence analysis.
Action B:  Remove one of the files from the list, then add the preferred file.

6163 | The sample file has an invalid status and cannot be used for analysis.

Cause: A sample file with a status other than No Analysis was selected.
Action: Select a sample file that has not been used in an analysis.

6164 | FoamPyc analyses cannot be done on a 1 cm3 unit.

Cause: An attempt was made to perform a FoamPyc analysis on a unit that does not sup-
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port it. FoamPyc analyses cannot be performed on a unit with a 1 cm3 or 2L sample
cell.

Action A: Start the analysis on a different unit.

Action B:  Close the analysis window, open the sample file, and select Standard Method.
Then restart the analysis.

6165 | Failure to fill sample cup.

Cause: There was insufficient pressure to allow filling within five minutes during an ana-
lysis

Action: Increase the regulator pressure or, if there is insufficient helium in the tank, obtain
a new tank of helium.

6166 | Pressure overrange

Cause A: A pressure overrange occurred during an analysis because the regulator pressure is
set too high.

Action A:  Adjust the pressure so that it is equal to the higher of the two fill pressures spe-
cified in the analysis parameters plus 2.0 psig.

Cause B: A pressure overrange occurred during an analysis because an error occurred in the
pressure measurement electronics.
Action B:  Contact your Micromeritics service representative.

6167 | Pressure underrange

Cause: A pressure underrange occurred during an analysis because an error occurred in
the pressure measurement electronics.
Action: Contact your Micromeritics service representative.

6168 | Pressure failed to equilibrate.

Cause A: The sample being analyzed failed to equilibrate in 1000 seconds.

Action A: Check the system carefully for leaks following the instructions in the instrument
operator manual. Ensure the sample is properly prepared before performing an ana-
lysis.

Cause B: Sample (foams, organics, etc.) absorbs helium slowly.

Action B:  Set the equilibration rate to progressively higher values until reasonable equi-
libration times (15 sec to 120 sec) are achieved.

6169 | The instrument lost power during analysis.

Cause: A power failure occurred and when power resumed, the automatic operation was
canceled.

Action: Restart the automatic operation.

6170 | The measured volume is < 10% of the cell volume. Results may be inaccurate.
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Cause: Not enough sample was placed in the sample cup to give an accurate reading.
Action: Rerun the sample using enough material to occupy the maximum amount of the
nominal cell chamber volume

6171 | Valve failed to respond.

Cause: The instrument valves failed to operate.
Action: Contact your Micromeritics service representative.

6200 | At least one report item must be selected. Press Cancel if you do not want a report.

Cause: No reports were selected in the Selected Reports list. No output could be produced.
Action: Ensure that at least one report is selected for the sample and re-submit the sample
for reporting, or click Cancel.

6201 | No data available in [«] for reporting.

Cause: The requested report file does not contain collected data.
Action: Use the file in an analysis before requesting reports.

6202 | Total solids concentration is invalid; liquid density is greater than or equal to solids
density.

Cause: A report was requested on a file containing invalid densities for Total Solids Con-
centration.
Action A:  Specify appropriate densities for liquid and solids.
Action B: Do not request that total solids concentration be reported.
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ERROR MESSAGES FOR 1340 AccUPyc KEYPAD ONLY

Press CHOICE to cycle through the messages and data. To delete the message, press CLEAR.
Messages that are not cleared will remain in the queue until the next analysis or calibration is performed,;
at that time, any remaining messages will be cleared automatically.

o NN = Number of cycles completed
e 77 =Number of cycles requested
Add Unit

Cause A: A new analysis module has been attached to the instrument where previously a dif-
ferent module had been attached.

Action A: Press Choice and select Yes to add the new analysis module.

Cause B:  An incorrect serial number was read by the analysis module.

Action B:  Press Choice and select No to use the serial number and calibration information
stored in the command module. Contact a Micromeritics service representative if
this error message continues.

ANLSERR: Eq failure — NN/ZZ cycles completed

Cause A: The sample being analyzed failed to equilibrate in 1000 seconds.

Action A:  Check the system carefully for leaks following the instructions in the instrument
operator manual. Ensure the sample is properly prepared before performing an ana-
lysis.

Cause B: Sample (foams, organics, etc.) absorbs helium slowly.

Action B:  Set the equilibration rate to progressively higher values until reasonable equi-
libration times (15 sec to 120 sec) are achieved.

ANLSERR: Fill failure — NN/ZZ cycles complete

Cause: There was insufficient pressure to allow filling within five minutes during an ana-
lysis

Action: Increase the regulator pressure or, if there is insufficient helium in the tank, obtain
a new tank of helium.

ANLSERR: Overrange — NN/ZZ cycles completed

Cause A: A pressure overrange occurred during an analysis because the regulator pressure is
set too high.

Action A:  Adjust the pressure so that it is equal to the higher of the two fill pressures spe-
cified in the analysis parameters plus 2.0 psig.

Cause B: A pressure overrange occurred during an analysis because an error occurred in the
pressure measurement electronics.

Action B: Contact your Micromeritics service representative.
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ANLSERR: Underrange — NN/ZZ cycles completed

Cause: A pressure underrange occurred during an analysis because an error occurred in
the pressure measurement electronics.
Action: Contact your Micromeritics service representative.

Automatic operation has been canceled

Cause: The automatic operation has been canceled.
Action: Wait for the termination process to complete or end the termination process by
pressing Alt + CLEAR two more times.

CAL_ERR: Reset Pressure Cal. ?

Cause: The calibration information could not be read from the command or analysis mod-
ule.

Action A:  Select Yes and press Enter to reset the pressure and temperature calibration to
nominal values. Resetting to nominal may restore normal readings but a proper cal-
ibration should be performed by a service technician.

Action B:  Select No to avoid resetting the calibration. The instrument will be unresponsive.

CAL_ERR: Temperature Calibration Failed

Cause: The temperature calibration was unsuccessful.
Action: Contact your Micromeritics service representative.

CALI1ERR: Eq failure — NN/ZZ cycles complete

Cause: The empty cell chamber failed to equilibrate in 1000 seconds during the first pass
of calibration.
Action: Check the system for leaks.

CALI1ERR: Fill failure NN/ZZ cycles completed

Cause: There was insufficient pressure to allow filling within five minutes during the first
pass of calibration.

Action: Open the tank valves if shut, increase the regulator pressure or, if there is insuf-
ficient helium in the tank, obtain a new tank of helium. (Minimum recommended
tank pressure is 200 psig.)

CALI1ERR: Overrange — NN/ZZ cycles completed

Cause A: A pressure overrange occurred during the first pass of calibration because the reg-
ulator pressure is set too high.

Action A:  Adjust the pressure so that it is equal to the higher of the two fill pressures
specified in the analysis parameters plus 2.0 psig.

Cause B: A pressure overrange occurred during the first pass of calibration because an error

A-20 AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



Error Messages for 1340 AccuPyc Keypad Only

[M] micromeritics’

occurred in the pressure measurement electronics.
Action B:  Contact your Micromeritics service representative.

CALI1ERR: Underrange — NN/ZZ cycles complete

Cause: A pressure underrange occurred during the first pass of calibration because an
error occurred in the pressure measurement electronics.
Action: Contact your Micromeritics service representative.

CAL2ERR: Eq failure — NN/ZZ cycles completed

Cause: The calibration standard failed to equilibrate in 1000 seconds during the second
pass of calibration.
Action:  Check the system for leaks.

CAL2ERR: Fill failure — NN/ZZ cycles completed

Cause: There was insufficient pressure to allow filling within five minutes during the
second pass of calibration.

Action: Open the tank valves if shut, increase the regulator pressure or, if there is insuf-
ficient helium in the tank, obtain a new tank of helium. (Minimum recommended
tank pressure is 200 psig.)

CAL2ERR: Overrange — NN/ZZ. cycles completed

Cause A: A pressure overrange occurred during the second pass of calibration because the
regulator pressure is set too high.

Action A:  Adjust the pressure so that it is equal to the higher of the two fill pressures spe-
cified in the analysis parameters plus 2.0 psig.

Cause B: Adjust the pressure so that it is equal to the higher of the two fill pressures spe-
cified in the analysis parameters plus 2.0 psig.

Action B: Contact your Micromeritics service representative.

CAL2ERR: Underrange — NN/ZZ cycles completed

Cause: A pressure underrange occurred during the second pass of calibration because an
error occurred in the pressure measurement electronics.
Action: Contact your Micromeritics service representative.

DATA_ERR: Chamber volumes must be > 0

Cause: According to the calibration data, the cell volume or expansion volume for the
selected insert is zero or a negative value
Action: Perform these steps:

1. Select Setup > Calibration Data.
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2. Inthe Cell volume field, enter the volume of the sample cell (or insert).
3. Inthe Expansion volume field, enter half of the sample cell volume.

4. Perform a volume calibration.

DATA_ERR: No data to compute

Cause A:
Action A:
Cause B:
Action B:

An automatic operation was canceled before a complete cycle could be completed.
Restart the automatic operation.

All the cycles have been excluded in review mode.

Return to review mode and include some cycles.

DTA_WRN: Cal std — 10% of full-scale

Cause A:

Action A:
Cause B:
Action B:

You entered a value for the calibration standard that was less than 10% of the nom-
inal cell chamber volume. Resulting data may be inaccurate.

Be sure you enter the value recorded on the Calibration Standard case.

You used an inappropriate calibration standard for the nominal cell chamber.

Use a calibration standard of sufficient size (calibration standards are available
from Micromeritics). The calibration standard should occupy at least 10% of the
nominal cell chamber volume and the more nearly filled the cell is, the better the
calibration.

DTA_WRN: Volume — 10% of full-scale

Cause:

Action:

There was not enough sample placed in the sample cup to give an accurate read-
ing.

Rerun the sample using enough material to occupy the maximum amount of the
nominal cell chamber volume.

HW_ERR: Calibration could not be read

Cause:

Action:

The calibration information could not be read from the command or analysis mod-
ule.

Close the application and cycle power on the instrument. Contact a Micromeritics
service representative if this error message continues.

MAN_ERR: Pressure overrange

Cause:
Action:

No A.C. Found

Cause:
Action:

The fill valve was left open until the maximum system pressure was exceeded.
Close the fill valve and open the vent and expansion valves. Allow the pressure to
stabilize.

The control module cannot detect an analysis module.
Contact your Micromeritics service representative.
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No collected data to report, or all cycles excluded

Cause: Yourequested a report in which there is either no data available or data have been
excluded via review mode.

Action: Initiate an automatic operation or return to review mode and include at least one
cycle.

Printer port not responding

Cause: Printer port not responding
Action: Check to make sure the printer is properly connected to the pycnometer, is turned
on, and is online.

Queuing print job [ESCAPE] to cancel

Cause: Status message displayed when a report is being printed.
Action: None; this is a status message only.

Reset to factory defaults

Cause: The . (period) key was pressed at startup and the instrument was reset. Data files
and HTML reports have been erased. Setup options have been returned to default
values.

Action: Review setup options.

Sending line (line number) [ESCAPE] to cancel

Cause: Status message displayed when data are being transmitted.
Action: None; this is a status message only.

SYS ERR: Power Fail — NN/ZZ Cycles Completed

Cause: A power failure occurred and when power resumed, the automatic operation was
canceled.
Action: Restart the automatic operation if desired.

TRN_ERR: Timeout failed to respond

Cause: The receiving device took longer than 10 seconds to acknowledge receipt of data
from the pycnometer.

Action: Make sure the receiving device is properly connected to the pycnometer RS-232
port and is turned on. Verify that the serial I/O parameters controlling the receiving
device correspond with the data transmission parameters in the set up mode.

Updating Unit [n] failed: Press [CLEAR]

Cause: One of the analysis modules has malfunctioned.
Action: Press CLEAR and follow the instructions displayed in the keypad window. After
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disconnecting the faulty unit (as instructed), you may reconnect the control module
with the remaining analysis module(s) and continue using your system.

USR_ERR: Cal std 10% of full-scale

Cause: You tried to enter a calibration standard volume that is less than 10% of the nom-
inal full-scale volume.
Action: Enter a volume that represents at least 10% of the nominal cell chamber volume.

USR_ERR: No data to review

Cause: Youtried to review data for an automatic operation when there were no data to
review.
Action:  Abandon request.

USR_ERR: Number of cycles must be > 5

Cause: You tried to enable run precision without increasing the number of runs to at least
five.
Action: Increase the number of runs to five or abandon request.

USR_ERR: Out of range

Cause: You tried to enter a value that is out of the valid range.
Action: Enter a value in the specified range.

USR_ERR: Pressure overrange

Cause: A pressure overrange occurred but was left uncorrected.
Action: Return to manual mode and vent the system.

Transmission port not responding

Cause: The receiving device took longer than five seconds to acknowledge receipt of data
from the pycnometer.

Action: Make sure the receiving device is properly connected to the pycnometer RS-232
port and is turned on. Verify that the serial I/O parameters controlling the receiving
device correspond with the data transmission parameters in the set up mode.

Transmission port waiting for Xon

Cause: The receiving device stopped transmission by sending an Xoff, and hasn’t resumed
the transmission by sending an Xon.

Action: None; when the receiving device is ready for more data, it should send the pycno-
meter an Xon.

SYS _ERR: Power Fail — NN/ZZ Cycles Completed
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Cause: A power failure occurred and when power resumed, the automatic operation was
canceled.
Action: Restart the automatic operation if desired.

TRN_ERR: Timeout failed to respond

Cause: The receiving device took longer than 10 seconds to acknowledge receipt of data
from the pycnometer.

Action: Make sure the receiving device is properly connected to the pycnometer RS-232
port and is turned on. Verify that the serial /O parameters controlling the receiving
device correspond with the data transmission parameters in the set up mode.

Updating Unit [n] failed: Press [CLEAR

Cause: One of the analysis modules has malfunctioned.

Action: Press CLEAR and follow the instructions displayed in the keypad window. After
disconnecting the faulty unit (as instructed), you may reconnect the control module
with the remaining analysis module(s) and continue using your system.

USR_ERR: Cal std 10% of full-scale

Cause: You tried to enter a calibration standard volume that is less than 10% of the nom-
inal full-scale volume.
Action: Enter a volume that represents at least 10% of the nominal cell chamber volume.

USR_ERR: No data to review

Cause: You tried to review data for an automatic operation when there were no data to
review.
Action:  Abandon request.

USR_ERR: Number of cycles must be > 5

Cause: You tried to enable run precision without increasing the number of runs to at least
five.
Action: Increase the number of runs to five or abandon request.

USR_ERR: Out of range

Cause: You tried to enter a value that is out of the valid range.
Action: Enter a value in the specified range.

USR_ERR: Pressure overrange

Cause: A pressure overrange occurred but was left uncorrected.
Action: Return to manual mode and vent the system.
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B CALCULATIONS

ANALYSIS

For derivation, see "Sample Volume Equation Derivation” on page C - 1.

10, 100, AND 350 cm3 UNITS

— Vx
Vs - Vc o Py
7
m
p = _s
s v,
where
v, = sample chamber volume
V. = expansion chamber volume
V. = sample volume
m = sample mass
Py = sample density
P / = gauge pressure after fill
P, = gauge pressure after expansion

1 cm3 AND 2000 cm3 UNITS

P
Ve=V, - Vx(—l - 1)
P
— mS
=y
where
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VC = sample chamber volume

Vx = expansion chamber volume

Vs = sample volume

m = sample mass

Py = sample density

P J = gauge pressure after fill

P = gauge pressure after expansion

CALCULATIONS FOR FoAMPYC METHODS

METHOD A: COMPUTED OPEN CELL FRACTION

GeomVol— ¥V, — VolCellsCutOpen
GeomVol

X100

OpenCellPct =

ResinPlusClosedCellPct = 100 — OpenCellPct

If cell measure is Chord Length,

ChordLength

VolCellsCutOpen = ActiveArea X 114

If cell measure is Diameter,

CellDiam

VolCellsCutOpen = ActiveArea X
1.4515

METHOD B: MEASURED OPEN CELL FRACTION
VolCellsCutOpen = V' [1] = V[2]
ResinPlusClosedCellVol = Vs[l] + VolCellsCutOpen

OpenCellVol = GeomVol — ResinPlusClosedCellVol

ResinPlusClosedCellVol % 100

ResinPlusClosedCellPct =
GeomVol
Vol
OpenCellPct = OpenCellVol 100
GeomVol
where
B-2
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Vs[l] = Vs from the first analysis (before recutting)

V2]

Vs from the second analysis (after recutting)
METHOD C: UNCORRECTED OPEN CELL FRACTION

OpenCellVol=GeomVol — VS

OpenCellVol y
GeomVol

OpenCellPct = 100

METHOD D: COMPRESSIBILITY TEST

Quantities appended with [i] are for cycle i, where i goes from 1 up to the number of cycles.

vi-1]-w{il

AVPl[i] - Pili—1]=Pi]

vi-1]-w{i
Poli—1]=Py[i]

A sz[l] =
AvgVolChangeP1 = avg(AV py[i]) for all included i
AvgVolChangeP2 = avg(AV p,[i]) for all included i

AvgVolChangeP1 %
GeomVol

PctAvgVolChangeP1 = 100

AvgVolChangeP?2 y
GeomVol

PctAvgVolChangeP2 = 100

METHOD E: FRACTURE TEST
AVol = V,[3] - V[1]

PctFracturedCells = LOI x 100
GeomVol

where

=

L §

—

e
Il

VS for the first (prefracture) cycle
VS for the third (postfracture) cycle

<
M
(O8]
| S—
I
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CALIBRATION

Volume calibration uses the ultra-precise method of separate adjustments for the offset and scale factor.

VOLUME OFFSET

Vc - Vcelprev B Vsampemply
_Vsampempty ~ : o
is reported as the offset in volume calibration reports.
VOLUME SCALE
V..
V.=V / calib
¢ ceprev Vsampball
V..
V.=V calib
o expprev Vsampball

( Vcalib j
is reported as the scale factor in volume calibration reports.

Vsampball
where
v, = sample chamber volume
14 = previously stored cell volume
celprev
14 = average V from volume offset calibration analysis (no calibration ball)
sampempty samp
V. = calibration ball volume
calib
|14 = average V. from volume scale calibration analysis (with calibration ball)
sampball samp
V)C = expansion chamber volume
V = previously stored expansion volume
expprev
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GEOMETRIC VOLUME AND ACTIVE AREA

Geometric volume of the sample is calculated based on the sample shape; for Method A, Active area is
also calculated.

CUBE

GeomVol = EdgeLengtl% X NumPieces
ActiveArea = EdgeLengﬂ% X (6 — NumSkins) X NumPieces

CYLINDER

)
GeomVol = 7 x 214m” Height x NumPieces

ActiveArea = [n x Diam x Height + % X Diam2 x(2- NumSkins)J x NumPieces
RECTANGLE
GeomVol = LongEdge x ShortEdge x RemainEdge x NumPieces

ActiveArea = [(LongEdge x RemainEdge x (2 — NumLargeSkins) + ShortEdge x RemainEdge x
(2 — NumSmallSkins) + LongEdge x ShortEdge * (2 — NumRemainSkins)] * NumPieces
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RUN PRECISION

Run precision requires at least five runs. Run precision criterion is met when the sample volumes
calculated for the four most recent previous runs fall within the specified error band for the current run’s
sample volume. The error band is a specified percentage of the nominal volume of the sample chamber
(1, 10, 100, 350 and / or 2000 cm?).

VS[O] to VS[4] are the five most recent sample volumes, VS[4] being the most recent.

V. .
ErrBand = PctFullScale X %(1)%1

where
= nominal sample cell volume

nominal

If (l Vs[i] o VS[4] |S ErrBand) for i =

0 to 3, run precision is achieved.

ToTAL PORE VOLUME

Total pore volume is per gram of sample.

Ps " Pouik
P X Ppuik

TotalPoreVol =

where

Pouik - entered bulk density
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Total Solids Concentration

ToTAL SoLIDS CONCENTRATION

Pii A
WeightPctSolids = 1 — — X —=32L__ x 100
P Psol _pliq

where

pliq = entered liquid density

Py

ol =entered solid density

Ps

= sample density
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SPC REPORT VARIABLES

REGRESSION CHART

The line of best fit for the Regression Chart is calculated by the usual least squares method. If there is
only a single point, or all N points have the same x-value, there can be no line of best fit in the standard

form.
X = 2N
N
7=
N
Slope = Z(xi_f)(yi_y)

Intercept =y — Slope - x

The coefficient of correlation for this line also is calculated in the usual way1 )

o, = .
— Z(yl. _)_7)2
g, = .
s(x.—¥)v. -7
COV(X,y) = (xl );3(yl y)
CorrelationCoef = £2/0:Y)
O'XO'y

1) Mathematical Handbook for Scientists and Engineers, G.A., Korn and T.M. Korn, McGraw

Hill, Sec. 18.4 (1968)
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Control Chart

CONTROL CHART

2.
Mean = —
N

Z(yl. —Mean)2
N-1

StdDev =

StdDev
Mean

CoefVar =
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RESIN VOLUME

g

ResinVol = e EEE—
ResinDensity

ResinVolPct = ResinVol 100

GeomVol
where
m = sample mass
PERCENT POROSITY

percent porosity = (p, —p) +p,

SPECIFIC GRAVITY

SG=pyTpy,

p = water density at analysis temperature

B-10

AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



Asphalt Density Calculations

[M] micromeritics’

ASPHALT DENSITY CALCULATIONS

Sample volume at 60 °F is found by multiplying the measured volume by the asphalt volume correction
factor.
V(60) = a(T)V

easured

where
(T )= 1.0211326242 — 3.548988118 x 10*T + 4.498813 x 10 T2

and T is the analysis temperature in degrees Fahrenheit.
Sample density at 60 °F is
p(60) = m / V (60)

Specific gravity at 60 °F is calculated by dividing the adjusted sample density by the density of water at
60 °F.

SG(60) = p(60) = py10 (60)
where

3
Proo = 0.990170g/ cm

Note that the density of water at the analysis temperature is not required for this calculation.
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C SAMPLE VOLUME EQUATION DERIVATION

10, 100, AND 350 cm3 UNITS

The AccuPyc Il is a gas displacement pycnometer which measures the volume of solid objects of
irregular or regular shape whether powdered or in one piece. A greatly simplified diagram of the
instrument is shown below.

Calibrated Sample Valve Calibrated Expansion
Cell Volume Volume
VC V.

X

CeD

Sample volume is determined from the known cell and expansion volumes and from measured pressures.

The cell and expansion chamber are initially at ambient pressure and the valve is closed. The cell is then
charged to an elevated pressure.

The ideal gas law gives:

Py(V.—V,)=n.RT (1)

where
n, = moles of gas in the sample cell
R = the gas constant
T = temperature
V.= cell volume
VS = sample volume
Vx = expansion volume
P =initial cell pressure

1

Expansion volume:

PV.=nRT 2)
where
AccuPyc II Operator Manual — (Rev -) C-1

134-42800-01 — Dec 2014



C Sample Volume Equation Derivation

[M] micromeritics®

Pa = ambient pressure
n = moles of gas in the expansion volume

When the valve is opened, the pressure falls to an intermediate value, P2, and mass balance yields:

Py V.=V +V,)=n.RT+nRT (3)

Substituting from equations (1) and (2) into (3):

Py(Ve= Vit V) = Py(Ve= V) + BV )
or
(Pr= PV = Vo) = (B, = PV, 5)
then
v,—v,=alay ©)

Adding and subtracting Pa in the denominator and rearranging gives

—V ==V + Pa_P2 v (7
s ¢ Py-P-P+P,

Dividing by (Pa -P,) in both the numerator and denominator

V., 8
Vo= Ve —7 = ®)
h [Pa‘ sz
or

V.=V — Vx (9)

§ ¢ P1— Py 1
Py P,
Using gauge pressure defined as:
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1 cm3 and 2000 cm3 Units
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equation (9) is rewritten as:

Vs: Vc_ Vx (11)

1 cm3 AND 2000 cm3 UNITS

The 1 cm3 and 2000 cm3 pycnometers operate by filling the expansion chamber while the sample cell
remains at ambient pressure. After P, is equilibrated, the expansion valve opens to allow gas to expand
into the sample chamber and P2 is equilibrated.

For the 1 cm? and 2000 cm?3 pycnometers, equation (1) becomes

PV,.=n.RT

and equation (2) becomes

PWV.=V)=n.RT

A derivation similar to that above yields the working equation for the 1 cm? and 2000 cm? pycnometers

P
Ve=V.~ VX(P—Ig— 1)

2g
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D Transmitted Data

D TRANSMITTED DATA

Analysis and calibration data can be transmitted in a single column or spreadsheet with data in ASCII
delimited format. Units are displayed as:

Data Units
Type Measurement
Date DD/MM/YY
Time HH:MM:SS
Pressure psig
Temperature °C
Elapsed Time seconds

ANALYSIS REPORT

Analysis Report - Spreadsheet

Record Description Form
Number
1 Version Number 20 characters
2 Serial Number 1 integer
3 Report type = analysis 8 characters
4 Start (reported on one line as ASCII comma delimited data) |8 characters (each)
e 4a. Date
e 4b. Time
5 Stop (reported on one line as ASCII comma delimited data) |8 characters (each)
¢ Sa. Date
e 5b. Time
6 Temperature 1 floating point
7 Description line 1 20 characters
8 Description line 2 20 characters
9 Sample [Ds 20 characters
10 Sample mass 1 floating point
11 Number of purges 1 integer
12 Equilibration rate 1 floating point
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Analysis Report - Spreadsheet (continued)

Record Description Form
Number
13 Chamber Insert: 1 integer
e 0=None
e 1=10cm? (100 cm?3 unit)
1 cm?3 (10 cm? unit)
0.1 cm3 (1 cm3 unit)
o 2=35cm? (100 cm? unit)
3.5 cm? (10 cm? unit)
14 Cell volume 1 floating point
15 Expansion volume 1 floating point
16 Average volume 1 floating point
17 Volume standard deviation 1 floating point
18 Average density 1 floating point
19 Density standard deviation 1 floating point
20 Number of runs 1 integer
21 Run precision 1 floating point
o 0= Disabled
o 1 - Enabled
22 Percent full scale 1 floating point
23 Carriage return / Line feed
24 Carriage return / Line feed
25 Carriage return / Line feed
26 Run number and pressure (reported on one line as ASCII
comma delimited data)
26a Run number 1 integer
26b P1 1 floating point
26¢ P2 1 floating point
26d Include in average calculation 1 integer
o 0=Excluded
e 1 =1Included
26e Elapsed time 1 unsigned integer
D-2 AccuPyc II Operator Manual — (Rev -)
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Analysis Report - Spreadsheet (continued)
Record Description Form
Number
26f Volume 1 floating point
26g Volume deviation 1 floating point
26h Density 1 floating point
26i Density deviation 1 floating point
27 Temperature (all temperature data) 1 floating point
CALIBRATION REPORT

Calibration Report - Single Column

Record Description Form
Number
1 Version Number 20 characters
2 Serial Number 1 integer
3 Report type = calibration 11 characters
4 Start (reported on one line as ASCII comma delimited data) |8 characters (each)
e 4a. Date
o 4b. Time
5 Stop (reported on one line as ASCII comma delimited data) |8 characters (each)
e 5a. Date
e 5b. Time
6 Temperature 1 floating point
7 Calibration standard size 1 floating point
8 Number of purges 1 integer
9 Equilibration rates 1 floating point
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Calibration Report - Single Column (continued)

Record Description Form
Number
10 Chamber Insert: 1 integer
e 0=None
« 1=10cm? (100 cm? unit)
1 cm? (10 cm? unit)
0.1 cm3 (1 cm3 unit)
o 2=35cm? (100 cm? unit)
3.5 cm? (10 cm? unit)
11 Average cell volume 1 floating point
12 Cell volume standard deviation 1 floating point
13 Average expansion volume 1 floating point
14 Expansion volume standard deviation 1 floating point
15 Number of runs 1 integer
16 P1 (all P1 data) 1 floating point
17 P2 (all P2 data) 1 floating point
18 P1* (all P1* data) 1 floating point
19 P2* (all P2* data) 1 floating point
20 Include in average calculation 1 integer
e 0= Excluded
e 1 =Included
Calibration Report - Spreadsheet
Record Description Form
Number
1 Version Number 20 characters
2 Serial Number 1 integer
3 Report type = calibration 11 characters
4 Start (reported on one line as ASCII comma delimited data) |8 characters (each)
e 4a. Date
o 4b. Time
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Calibration Report - Spreadsheet (continued)
Record Description Form
Number
5 Stop (reported on one line as ASCII comma delimited data) |8 characters (each)
e 5a. Date
o 5b. Time
6 Temperature 1 floating point
7 Calibration standard size 1 floating point
8 Number of purges 1 integer
9 Equilibration rates 1 floating point
10 Chamber Insert: 1 integer
e 0=None
e 1=10cm? (100 cm?3 unit)
1 cm?3 (10 cm? unit)
0.1 cm3 (1 cm3 unit)
o 2=35cm? (100 cm? unit)
3.5 cm? (10 cm? unit)
11 Average cell volume 1 floating point
12 Cell volume standard deviation 1 floating point
13 Average expansion volume 1 floating point
14 Expansion volume standard deviation 1 floating point
15 Number of runs 1 integer
16 Carriage return / Line feed
17 Carriage return / Line feed
18 Carriage return / Line feed
19 Run number and pressure (reported on one line as ASCII
comma delimited data)
19a Run number 1 integer
19b P1 1 floating point
19c P2 1 floating point
19d P1* 1 floating point
19e p2* 1 floating point

AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



D Transmitted Data

[M] micromeritics®

Calibration Report - Spreadsheet (continued)

Record Description Form
Number
19f Include in average calculation 1 integer

e 0=Excluded
e 1 =Included

19¢g Cell volume 1 floating point
1%h Cell volume deviation 1 floating point
19i Expansion volume 1 floating point
19j Expansion volume deviation 1 floating point
D-6 AccuPyc II Operator Manual — (Rev -)

134-42800-01 — Dec 2014



E RS-232 Pin Assignment

[M] micromeritics’

E RS-232 PIN ASSIGNMENT

The AccuPyc is a standard DTE device. The RS-232 port can be used to connect an analytical balance
for transfer of sample weight, or for transmitting data to a computer. The receiving device must be
configured to interface with the RS-232 pin assignments. Any signals that are not listed in the RS-232 Pin
Assignment table are ignored.

RS-232 Pin Assignments
Pins Signal Description Data Direction
2 RXD Receive Data Into AccuPyc
3 TXD Transmit Data From AccuPyc
4 DTR Data Terminal Ready From AccuPyc
5 GND Ground N/A
6 DSR Data Set Ready Into AccuPyc

The AccuPyc uses the DTR and DSR signals for hardware flow control. Ensure that the serial device
provides these signals. For example, if attaching to a computer (also a DTE device), use a null modem
cable which includes the designated signals. If transmission problems occur, ensure that the signals are
set up properly. If the signals are correctly configured, contact the receiving device manufacturer for
assistance.
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F Temperature Controlled AccuPyc
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F TEMPERATURE CONTROLLED AccUPYC

A temperature controlled AccuPyc must be connected to a circulating bath (not provided by
Micromeritics). Refer to the manufacturer operator manual for circulating bath operating instructions.

ATTACH A CIRCULATING BATH

The rear panel of the temperature controlled AccuPyc contains connections for a circulating bath.
Provided in the accessory kit are two (2) hose fittings and a four (4) foot length of tubing.

1. Power off the controlling unit.

2. Remove the plugs from the In port and the Out port.

Circulating bath
IN port

Circulating bath
OUT port

Insert the provided hose fittings into each connector.

Cut the piece of 4 ft. tubing into two equal pieces of 2 feet each.

Install the tubing on the In and Out connectors.

Install the other end of the Out tubing to the Inlet connection of the bath circulator.
Install the other end of the In tubing to the Outlet connection of the bath circulator.

® N AW

Set the temperature using the appropriate controls on the bath circulator.

ADD ANALYSIS MODULES TO A TEMPERATURE CONTROLLED MODULE

If using the Windows version of the AccuPyc II, exit the application before powering off
/ the analyzer.

1. Power OFF the controlling unit.
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2. Connect the circulating bath. See "Attach a Circulating Bath" on page J - 5.

3. Connect one end of the module connector cable (provided in the analysis module accessories kit)
to the connector labeled Module Connection on the rear panel of the control module.

4. Connect the other end of the module connector cable to the lower connector labeled Module Con-
nector on the rear panel of the analysis module.

Circulating bath Circulating bath
IN port OUT port

Control module Analysis module

5. Power ON the analyzer. If using the Windows version of the AccuPyc I, start the application .

6. Calibrate the analysis module using the calibration kit shipped with the system. See "'Calibration"’
on page 10 - 1.

F-2 AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



G MultiVolume Insert Option

[M] micromeritics’

G MuLTIVOLUME INSERT OPTION

The MultiVolume Insert option provides analysis of samples using smaller-sized sample chambers.

Equipment Description
AccuPyc 1 cm3 Includes a 0.1 cm? insert/sample cup combination.
AccuPyc 10 cm? Includes 1 and 3.5 cm3 inserts with corresponding sample cups and appro-

priate calibration standards. Fritted filter lids are included for both inserts.

AccuPyc 100 cm3 Includes 10 and 35 cm? inserts with corresponding sample cups and appro-
priate calibration standards. A fritted filter lid, which prevents the escape
of sample particles under rapid gas flow, is included for the 10 cm3

insert.

AccuPyc 2000 cm3 Includes 650 and 1300 cm? cups, supporting inserts and calibration stand-
ards. A tool is also included to allow removal of the supporting inserts

See ""Parts and Accessories' on page 13 - 1.

OPERATING PARAMETERS

To operate using inserts, access the Chamber Insert prompt to select the appropriate MultiVolume
insert.

1. Press Alt + 2 to access the Setup function.

2. Press CHOICE until Report Options is displayed, then press ENTER.

3. Continue pressing ENTER until the Request Insert prompt is displayed.

4. Press CHOICE until Yes is displayed, then press ENTER.

Unit[n]> SN1234> 10 cm3
Report Options

Request insert?

Yes

5. Press SAVE to save the changes and return to the Reload prompt.

A Chamber Insert prompt will display during all normal operating procedures. For example, a Chamber
Insert prompt will display when starting a calibration or analysis.
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ABOUT INSERTS AND SAMPLE CUPS

Wear latex gloves when handling inserts and sample cups. Oils from skin may contaminate
/ the surface and affect analysis results. See "Handling System Components' on page J - 1.

An insert changes the size of the sample chamber and requires its own sample cup. All inserts are
shipped with appropriate cups, with the exception of the 0.1 cm?3 insert for the 1 cm3 unit. Because of its
size, the sample cup for the 0.1 cm3 insert is built-in. The appearance of the inserts and cups varies.

/ o The fritted filter caps for the 1 cm® and 3.5 cm? inserts fit on top of the insert.

o The cap for the 10 cm? insert (shown in image) fits on the sample cup.

This example shows a 10 cm? cup and insert.

<« Fritted Filter Cap

Sample Cup

The inserts for the 2000 cm? systems are installed and removed with a special tool.
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Tool

0 Insert
~

INSTALL AND REMOVE INSERTS AND SAMPLE CUPS

0.1 cm?3 Insert

The MultiVolume kit contains a special tool required to install the 0.1 cm3 inserts. The sample cup is
built into the 0.1 cm3 insert.

1 cm3 Insert

The MultiVolume kit contains a special tool required to install the 1 cm? inserts.

Install the Insert

1. Remove the sample chamber cap and place on a clean work surface with the greased side facing
upward.

Contamination from airborne particles can occur rapidly. The chamber cap should be left
off the sample chamber for as little time as possible.

2. Place the insert into the sample chamber.

3. Use the handling tool to grasp the cup for placement in the insert. After placing the sample into
the sample cup, insert the tip of the tool into the cup and press down firmly. The handling tool fea-
tures an O-ring to grip the inside surface of the sample cup.
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4. Place the cup into the insert, then tilt the tool to one side and remove it from the sample cup.

[M] micromeritics®

5. If using a fritted filter cap, place it onto the top of the insert.

6. Replace the sample chamber cap.

Remove the Insert

1. Remove the sample chamber cap and place on a clean work surface with the greased side facing
upward.

Remove the fritted filter cap (if used).
Insert the handling tool into the sample cup until the sample cup is gripped by the O-ring.
Lift the sample cup out of the insert.

Pull the insert from the sample chamber.

AN O

Replace the sample chamber cap.

10, 3.5, and 35 cm?3 Inserts

Remove the chamber cap and place the insert into the sample chamber. The insert should fit snugly in
the chamber. Place the appropriate sample cup into the well of the insert.
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Do not force the insert or cup into the openings. This may damage the instrument, insert, or
sample cup.

Install the fritted filter cap (if used) before closing the sample chamber. A fritted filter cap is used to
constrict gas flow and is included with some inserts. The fritted filter cap for the 10 cm? insert fits on the
top of the sample cup. The fritted filter caps for the 1 and 3.5 cm? inserts fit on the top of the insert.
Fritted filter caps are not available for the 0.1 and 35 cm? inserts.

CALIBRATE INSERT

An insert must be calibrated and its operation verified. Appropriate calibration standards are included in
the MultiVolume kits. For example, a 100 cm? capacity AccuPyc with a 10 cm3 insert must be calibrated
with the 10 cm3 insert, cup, and calibration standards.

0.1 cm3 INSERT

Because of the size of the 0.1 cm? insert, its calibration is performed in a different manner from that of
other inserts.

If the 1 cm> pycnometer has not been calibrated recently, perform a calibration before cal-
ibrating the 0.1 cm? insert.

1. Remove the sample chamber cap and place on a clean work surface with the greased side facing
upward.

2. Place the insert into the sample chamber (the sample cup is built into the insert). Replace the
chamber cap.

3. Press Alt + 4 to access the Analyze function. Press ENTER until the Chamber Insert prompt is
displayed. Ensure that None is displayed.

Press ENTER to display the Analyze prompt. Press ENTER to begin the calibration.
After the calibration is complete, the Reload prompt is displayed.

Press CHOICE until the average measured volume is displayed. Record this value.
Press Alt + 2 to access Sefup.

Press CHOICE until Calibration Data is displayed.

Press ENTER to display the Chamber Insert prompt.

L ©® =N ok

10. Ensure that None is selected, then press ENTER to display the Cell Volume prompt.

11. Subtract the average volume of the 0.1 cm? insert/cup (recorded in Step 6) from the cell volume
displayed in the prompt. Record this value.

12. Press ENTER to display the Expansion Volume prompt.
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13. Record the value displayed for the expansion volume, then press ENTER to return to the Cal-
ibration Data prompt.

14. Press ENTER. The Chamber Insert prompt is displayed.

15. Press CHOICE until 0.1 cm? is displayed, then press ENTER to display the Cell Volume prompt.
Enter the value recorded in Step 11.

16. Press ENTER to display the Expansion Volume prompt. Enter the value recorded in Step 12.
17. Press SAVE to save the information and return to the Reload prompt.

The pycnometer is now ready for analyses using the 0.1 cm3 insert/cup.

1, 10, 3.5, 35, 650, AND 1300 cm3 INSERTS

1. Remove the sample chamber cap and place on a clean work surface with the greased side facing
upward.

2. Place the insert and sample cup into the sample chamber. Replace the chamber cap.

3. Calibrate the insert. See ""Calibration" on page 10 - 1.

4. See ""Verify Operation' on page 10 - 10.
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H TEC MobDULE

This AccuPyc system has been modified to provide temperature control from 15 to 36 °C. The system
uses a thermoelectric control (TEC) system to heat or cool the AccuPyc. The temperature is controlled
using a digital temperature controller and a separate power system from the AccuPyc.

It is suggested that the TEC system be installed first, to allow time for temperature to stabilize at the
desired temperature, while the AccuPyc is being installed. See ."'Add Analysis Module to Control
Module'" on page 11 - 1and ""Set the TEC Temperature' on page J - 4.

SET THE TEC TEMPERATURE

1. Power on the TEC module. The power switch is located near the power inlet.

The digital display of the temperature controller will show a test message while it starts up.
When the test message stops flashing, the current temperature displays. If the current temperature
and a message such as ErA¢ displays, press the P (Program) key on the front panel of the
controller. The ErAt message should stop and only the current temperature will display.

Up and
Down keys

Program key

2. Press P. SP 1 displays followed by the current setpoint (SP ). Use the Up or Down key to set the
temperature.

3. Press P to accept the temperature. The controller will now start heating or cooling to achieve the
setpoint

The TEC module uses a fan to remove heat. The fan is located on the underside of the
instrument. The fan pulls air into the instrument and the air is exhausted through ventilation
slots on the rear panel. The exhaust slots must remain unobstructed.

Do not allow papers or other debris to be pulled across the fan as this will stop the
necessary air flow. The TEC system will be unable to control temperature, and may
become damaged.
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OPERATE THE TEC MODULE

When the TEC controller shows the correct temperature, there may be a small difference between the
temperature on the TEC unit and the AccuPyc display because two different sensors are being used. The
AccuPyc sensor and electronics are calibrated together to compensate for any component differences
between the sensor and the circuit board components. Micromeritics considers the AccuPyc temperature
display to be a more accurate reflection of the sample temperature than the reading from the controller.
The controller and the sensor used with the controller cannot be calibrated.

The TEC controller may be adjusted to compensate for the small difference. If the AccuPyc temperature
is a little high, then reduce the setpoint of the TEC controller by the difference. Wait for stabilization.
Readjustment may need to be repeated until the correct AccuPyc temperature is achieved.

The AccuPyc volume must be calibrated at the analysis temperature. Perform the volume calibration in
the normal way until it is time to insert the reference volume (sphere or spheres). After installing the
reference volume, wait at least 20 minutes to allow the volume to achieve the same temperature as the
AccuPyc. Then continue as normal.

When it is necessary to perform AccuPyc tests at a different temperature, re-calibrate the system
volume at the new temperature.

VOLUME CHANGE WITH TEMPERATURE FOR THE 10 cm3 AccUPYC

The reference spheres supplied with the 10 cm3 AccuPyc are made from tungsten carbide. They were
measured at 20 °C. The spheres will change volume with temperature. The change is very small and is
shown in the following table. Every sphere is a slightly different size, and so the table provides the factor
to be used if the value used during calibration needs to be adjusted. Multiply the volume provided with
the reference spheres by the value in the right column.

Temperature (°C) Typical Volume (cm3), two balls Factor
15 6.37125 0.99991
20 6.37182 1.00000
25 6.37238 1.00009
30 6.37295 1.00018
35 6.37351 1.00027

For example, if the ball is 6.37182 cm3 at 20 °C but run at 50 °C, multiply the Volume x the Factor in the
table.

6.37182 x 1.00053 = 6.37520
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Volume Change with Temperature for the 100 cm3 AccuPyc

VoLUME CHANGE WITH TEMPERATURE FOR THE 100 cm3 AccuPYc

The stainless steel calibration standard (ball) supplied with the 100 cm® AccuPyc is made from 440

grade stainless steel. It was measured at 20 °C. Its volume will be higher when heated above 20 °C. The

following table uses the coefficient of thermal expansion of 440 grade stainless steel (0.0000101

m/m/degree C change) to provide the volume of the sphere at various temperatures.

Every ball is a slightly different size therefore the table provides the factor to be used if the value used
during calibration needs to be adjusted. Multiply the volume provided with the reference sphere by the

value in the right column.

Temperature (°C) Typical Volume (cm?) Factor
15 51.089712 0.99995
20 51.092292 1.000000
25 51.094872 1.000051
30 51.097452 1.000101
35 51.100032 1.000152

For example, if the ball is 51.092292 cm? at 20 °C but run at 50 °C, multiply the Volume x the Factor in

the table.

51.092292 % 1.000303 = 51.107773
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Asphalt Density Measurement

ASPHALT DENSITY MEASUREMENT

Samples can be analyzed in disposable cups. Any difference in the mass of the cups used for calibration
and analysis will be corrected for in the reported quantities. Performing an asphalt density measurement
requires the AccuPyc II Asphalt software and disposable sample cups. Refer to ""Parts and
Accessories" on page 13 - 1 for ordering information.

Steps 1-9 do not need to be repeated for subsequent analyses.

1.
2.

v © =N o

10.
11.
12.
13.

Set the instrument temperature and allow 12 hours for equilibration.

Go to Options > Options Presentation. Sclect Show Cup Properties. Verify that a checkmark
displays to the left.

Label each disposable cup with a permanent marker and record its mass.
Place a disposable cup in the 3.3 cm? insert and position the insert in the sample chamber.

Go to Unit [n] > Calibration > Calibrate Volume.
a. Enter the mass of the cup in the Cup mass field.

b. Enter the volume of the reference sphere in the Volume of calibration standard field.
c. Select the correct chamber insert.
d. Select Measured .
e. Click Start.
Insert the reference sphere when prompted and resume the calibration.
When the calibration is complete, remove the cup and reference sphere .
Prepare a sample in a different disposable cup and place it in the sample chamber.
Create a sample file for the analysis.
Go to Unit [n] > Sample Analysis and select the sample file created in the previous step.
Enter the mass of the cup in the Cup mass field.
Select the chamber insert that was used for calibration.

Click Start.
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I MULTIGAS OPTION

The Multigas option enables the AccuPyc to use up to four different gases. The Multigas assembly
consists of:

o Valve assembly and two retaining screws
o Gas entrance tubing for connection from the analyzer to the valve assembly

o Gas supply tubing for four gases

INSTALL THE MULTIGAS ASSEMBLY

Retaining
Screws A Ferrules
(%
g1/
6 WYZQ\
)
Swage nut

valve and remove the inlet tubing from the analyzer before installing the multigas assembly.

/ If a gas is attached to the gas inlet on the rear panel of the analyzer, close the gas cylinder
The gas can then be attached to one of the inlet valves on the assembly.

1. Remove the two retaining screws on the rear panel of the AccuPyc.

2. Position the valve assembly against the rear panel so that the retaining screw holes on the valve
assembly align with those on the rear panel of the analyzer.

3. Attach the valve assembly to the rear panel using the two screws included in the multigas kit.

4. Carefully cut and remove the cable ties holding the gas entrance tubing in position and remove the
ties.

5. Remove the protective caps from the ends of the gas entrance tubing, then remove the ferrules
from the upper end of the tubing.

6. Remove the nut from the center port and slide it onto the end of the gas entrance tubing, then
replace the front and rear ferrules.

7. Insert the tubing into the center port of the multigas assembly. Use the nut to secure the tubing to
the assembly.

8. Insert the other end of the tubing into the gas inlet. Use the self contained swage nut to secure the
tubing to the inlet.
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CONNECT GASES

1. Connect one end of the gas supply tubing to the gas supply. See "Instrument Components' on
page I - 4.

2. Insert the other end of the tubing into one of the valve inlets on the multigas assembly.

3. The faceplate of the valve assembly contains four sections; one for each gas inlet on the
assembly. Write the name of the gas in the applicable section.

the gas connected
tothe inlet.

Write th t| r7Bl
rnte the name o ll'/‘é@

SELECT GASES

After installing the gases, use the knob to select the gas. Purge the gas lines when changing gases.

Knob (turn to
selectgas)
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J INSTALLATION INSTRUCTIONS

These instructions assume that the shipping cartons have been opened and their contents checked and
verified as instructed in the AccuPyc II Installation Checklist part number 134-42870-02.

HANDLING SYSTEM COMPONENTS

CALIBRATION STANDARD

o Wear latex or nitrile, powder-free gloves to prevent transfer of oil from hands.
o Do not drop the standard into the sample cup. Roll the standard into the cup to prevent damage.

« Always return the standards to the case. Standards are unit specific.

SAMPLE CHAMBER CAP

o Wear latex or nitrile, powder-free gloves to prevent transfer of oil from hands.

« Keep the cap on the sample chamber except when inserting or removing the sample cup .

When left uncapped, the sample chamber temperature may become unstable and / or water
vapor will adsorb on the inner surface of the chamber. Either of these conditions can affect
analysis results.

« Avoid laying the chamber cap on a work surface. Debris may collect on the greased surface of the O-
ring which can also affect analysis results.

o When multiple analysis modules are connected, never interchange sample chamber caps. Caps are
unit specific.

GAS REQUIREMENTS

The pycnometer uses helium or nitrogen (99.995% pure or better) to provide rapid, accurate analyses.
The cylinder containing helium must be fitted with a gas regulator set for 19-23 psig (131-159 kPag). The
pressure input to the pycnometer should never be greater than 25 psig (172 kPag). Excessive pressures
waste gas due to a protection device contained in the pycnometer that vents the pycnometer to
atmospheric pressure if pressure exceeds 35 psig (241 kPag).

This protection device is not installed on 2000 cm? units.

/ Minimum recommended gas tank pressure is 200 psig (1379 kPag).

Other inert, dry gases can also be used and may be more applicable for some applications.
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PYCNOMETER SET UP

PYCNOMETER CONFIGURATION

Single Module Configuration

Control Module and Analysis Module Configuration

Control Analysis
module module
or
Glove G
Box Next
> module —
C e L
|
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Pycnometer Configuration

TEC Module Configuration

Control Analysis
module module
G
Next
> module =

Diagram Components

Component |Description

A

Separate power cord for external power supply. Connect cable to wall outlet.

External power supply

Hardwired 8-pin mini-DIN power cable for external power supply.

8 pin mini DIN cable.

Power adapter DIN port.

Power adapter.

Module Connection - 8-pin mini-DIN OUT port to connect next analysis module.

T|Q=HET O w

Module Connection - 8-pin mini-DIN IN port to connect the control module or
previously connected analysis module (not shown).

Hardwired power mini-DIN cable for power adapter.

Set Up Procedure

1.

S

Unpack and inventory all boxed parts. Contact your Micromeritics Service Representative if parts
are missing or broken.

Place module(s) on work surface.

Connect separate power cable(s) to external power supply(s).

Connect external power supply(s) to power outlet on the module(s).

Connect power cable to wall outlet.

Toggle the module power switch to the ON position.
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7. Check the power indicator on the front panel of the analyzer. The indicator will blink green to
indicate that power is applied to the analyzer. Once the application is running, the indicator will
stop blinking and remain illuminated.

8. On the keypad, press Alt + CHOICE + 2. Unit [n] appears in the upper left corner of the display.

Unit[n]> ) SN 1234> 10 cm3
X

- X - X

Reload
P = (current pressure)

9. Adjust the display brightness control using the Brightness Control button on the rear of the ana-
lyzer.

SET THE TEC TEMPERATURE

1. Power on the TEC module. The power switch is located near the power inlet.

The digital display of the temperature controller will show a test message while it starts up.
When the test message stops flashing, the current temperature displays. If the current temperature
and a message such as ErAt displays, press the P (Program) key on the front panel of the
controller. The ErAt message should stop and only the current temperature will display.

Up and
Down keys

Program key

2. Press P. SP I displays followed by the current setpoint (SP ). Use the Up or Down key to set the
temperature.

3. Press P to accept the temperature. The controller will now start heating or cooling to achieve the
setpoint

instrument. The fan pulls air into the instrument and the air is exhausted through ventilation

ﬂ The TEC module uses a fan to remove heat. The fan is located on the underside of the
slots on the rear panel. The exhaust slots must remain unobstructed.

Do not allow papers or other debris to be pulled across the fan as this will stop the
necessary air flow. The TEC system will be unable to control temperature, and may
become damaged.

J-4 AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



Temperature Controlled Module Hardware Setup

[M] micromeritics’

TEMPERATURE CONTROLLED MoDULE HARDWARE SETUP

Setup a Single Temperature Controlled Module

See "Pycnometer Configuration' on page J - 2 for setup instructions. When complete, connect the
circulating bath.

Attach a Circulating Bath

The rear panel of the temperature controlled AccuPyc contains connections for a circulating bath.
Provided in the accessory kit are two (2) hose fittings and a four (4) foot length of tubing.
1. Power off the controlling unit.

2. Remove the plugs from the In port and the Out port.

Circulating bath
IN port

Circulating bath
OUT port

Insert the provided hose fittings into each connector.

Cut the piece of 4 ft. tubing into two equal pieces of 2 feet each.

Install the tubing on the In and Out connectors.

Install the other end of the Out tubing to the Inlet connection of the bath circulator.
Install the other end of the In tubing to the Outlet connection of the bath circulator.

® N kW

Set the temperature using the appropriate controls on the bath circulator.

CHAMBER CAP O-RING

See ""Grease the Chamber Cap O-Ring" on page 12 - 4.
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CONNECT KEYBOARD

An optional USB keyboard can be connected to a USB port on the rear panel of the analysis module. The
keyboard is not provided by Micromeritics.

CONNECT AN ANALYTICAL BALANCE

An analytical balance can be connected to a serial port on the computer and used to transfer the
sample’s mass via a third-party software directly to the AccuPyc II application. Refer to the balance
manufacturer’s operator’s manual for transmission instructions.

Connect the analytical balance to the RS-232 port on the rear panel of the analyzer.

To configure the Analytical Balance, see "Configure an Analytical Balance" on page J - 20.

GAS CONNECTION

These instructions are for connecting inert gases only. Follow the safety procedures used by
your laboratory for connecting hazardous gases.

/ Review "Gas Requirements' on page J - 1 prior to installing gas.

Low pressure

gauge High pressure

gauge Gas bottle shut-off
\ valve
Gas regulator Tl o Y '}’_' ‘:\
shut-off valve ’ 2 5
o 3 a8 # .
5 Y

7

Copper
tubing
- &

.
Brass reducer
fitting
Regulator

control knob

Regulator
connector nut

1. Attach an appropriate regulator to the gas cylinder or gas line, then tighten with a wrench. Leave
the gas bottle shut-off valve closed until instructed otherwise.

2. Attach the gas inlet line to the regulator, reducer fitting, or regulator expansion:
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ials other than copper or stainless steel can cause operational problems as well as inac-

@ It is important to use the inlet tubing supplied with the analyzer. Gas lines made of mater-
curate data.

If Regulator has... Then...
1/4 in. outlet Attach the reducer fitting to the outlet of the regulator shut-off / isolation
valve

Tighten the nut finger-tight, then 1-1/4 turns with a wrench.

Continue with the steps given for the 1/8 in. outlet

1/8 in. outlet Insert the gas tubing into the fitting.

Enure the tubing is seated fully inside the fitting.

Tighten the nut finger-tight

While holding the fitting body steady, tighten the nut with a wrench 3/4
turn.

@ Do not overtighten the fittings. Doing so can collapse the brass fitting and cause a leak.

3. Purge the regulator and inlet tubing to prevent contamination of the analysis gas.
a. Turn the regular shut-off valve clockwise to close.

b. Turn the pressure regulator control knob counter-clockwise to open.

o

Slowly turn the gas cylinder shut-off valve counter-clockwise to open, then quickly close it.

&

Observe the high-pressure gauge.

If the pressure decreases, tighten the nut connecting the regulator to the gas cylinder. If the
pressure is stable, proceed to the next step.

ﬂ Enure the gas supply equipment is adequately vented before performing the next step.

e. Turn the pressure regulator control knob clockwise until the low-pressure gauge
indicates 19.500 psig (134.445 kPag).

f. Turn the regulator shut-off valve counter-clockwise to open.

g. Turn the gas cylinder shut-off valve counter-clockwise to open. Flow gas for 10 to
30 seconds, then close the valve.

h. Turn the gas regulator shut-off valve clockwise to close
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4. Attach the other end of the copper tubing to the gas inlet on the rear panel of the pycnometer.
Remove the inlet plug that shipped with the pycnometer.

Gas inlet port

5. Turn the nut on the tubing clockwise until it is finger-tight. Then use a 7/16 in.(1 mm) wrench to
tighten the nut an additional 1/4 turn.

6. Open the gas cylinder and regulator shut-off valves.
7. Turn the regulator control knob until the low pressure gauge indicates 21.5 psig (148 kPag).

J-8 AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



Connect the Analyzer to the Computer

[M] micromeritics®

CONNECT THE ANALYZER TO THE COMPUTER
If using the analyzer with the keypad or keyboard only, skip this section.

An Ethernet switch is required if connecting a different type of analyzer to the same computer as the
AccuPyc. If configuring multiple AccuPyc modules. they are connected together with only the Control
Module connected to the Ethernet switch. See ""Connect an Ethernet Switch' below.

CONNECT AN ETHERNET SWITCH

An Ethernet switch is required to connect one or more analyzers and one computer.

Ethernet
switch

Other
Micromeritics

analyzers Q?"
|

Control Analysis Analysis
Module Module Module

Brightness
controller

To adjust the display brightness:

1. Insert a small flat head screwdriver into the opening.

2. Rotate the screwdriver until it engages in the slot, then turn clockwise to darken and coun-
terclockwise to lighten.
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CONFIGURE THE PYCNOMETER

If using the keypad option, see ""Configure the Pycnometer using the Keypad' below and skip the
section on ""Software Installation' on page J - 15.

When using the software application, the display window on the pycnometer is disabled.

CONFIGURE THE PYCNOMETER USING THE KEYPAD

; If using the keypad to control analyses, follow these instructions for configuring the module.
If using the Windows application, skip this section.

Complete the installation process by configuring the module:

o Unit type. See "Unit Types' on page J - 13.

o System setup (date / time / language). See "System Setup' below.

o Calibrate. See "Calibrate Volume' on page 10 - 15.

e Reports. See "Setup Reports' on page 2 - 9.

o Transmit parameters. See ""Transmit" on page 2 - 6.

« Printer setup. See ""Printer Setup' on the facing page.

System Setup

Press Alt + 2 to access the set-up function.

Display Description

Unit[n]> SN1234> 10 cm3 Setup: Choose or enter pa‘ralpeters for analysis, calibration,
reporting, and data transmission.

Setup Type? Choices: Analysis Parameters, Report Options, Calibration
Analysis Parameters Data, Communications, Unit Types

Press CHOICE to display the set up type, then press
ENTER.

The parameters for each set up type are stored and used to
control the pycnometer until new ones are specified.

At the completion of each set up, the display returns to the Setup type? prompt.
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o Press SAVE to save the information and return to the Reload prompt.

o Choose another set up type. Do not press SAVE until all parameters have been entered. The display
will return to the Reload prompt.

o Press Alt + CLEAR to discard the information entered and return to the Reload prompt.

Printer Setup

Printers are connected to the AccuPyc II via a USB port. See "Specifications' on page 1 - 10 for a list
of supported printers. Using the keypad:

1. On the display, select Setup > Report Options.
2. Press ENTER until the Printer? prompt is displayed.
3. Press CHOICE until the appropriate printer driver is displayed.

Communications

module, skip this section. All setup functions will be done in the analysis software applic-

/ Use these instructions for keypad installations only. If a computer will be attached to the
ation.

Communications enables specification of communications criteria, such as baud rate, parity, etc.

Display Text Description

Setup Type? Press CHOICE until Communications is displayed.

Communications

Communications Enables selection of the manner in which the IP address is assigned. With
IP Address? an [P address, analysis results can be access via a web browser.

[choice] Typically, after an analysis (or calibration) is started, results from the

previous operation cannot be reviewed. However, results from five
analyses are stored in the controller. A web browser enables review of
these results. An IP address must exist for this operation. An IP address
can be detected and assigned automatically, or one can be specified.

Ensure the Ethernet cable is plugged into the Ethernet port on the analyzer
and to the network. Choose DHCP to have an IP address assigned
automatically, or Specify to specify an address. Press CHOICE until the
option is displayed.

If using DHCP, an IP Address should be assigned within a minute.
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Display Text

Description

Communications
Requesting Address *
[ENTER] to continue

Displays the first-time selection of DHCP.

Press ENTER. The system automatically attempts to assign an [P
address. If the system is able to determine an address, the assigned
address is displayed.

Unit[n]> SN1234> 10 cm3
Communications

Assigned Address:

(assigned address)

Communications
Requesting Address
[ESCAPE] to cancel

If an address cannot be determined, this prompt is displayed:

Unit[n]> SN1234> 10 cm3
Communications

Requesting Address

[ESCAPE] to cancel

Press Alt + CLEAR to cancel the operation and return to the Reload
prompt. Contact your IT department, or choose the Specify option and
enter the appropriate information.

Communications
IP Address *
(user entered)

Displays when the Specify option is selected. Enables entry of an
appropriate IP address. This is a numerical field in the following format:
nnn.nnn.nun.nnn. Enter the address.

Communications
Subnet Mask *
(user entered)

Enables entry of the subnet mask number. Enter the subnet mask number.

Communications
Gateway *
(user entered)

The Gateway address is used for communicating outside the local
network. The Gateway address is often the same as the IP address, with a
“1” after the last dot instead of the last three characters (nnn.nnn.nnn. I).
Contact your IT department with any questions.

Communications
E-mail Address:

When connected to a network, analysis or calibration results can be e-
mailed automatically upon their completion. This prompt enables entry of
the e-mail address where results are to be sent.

If not using DHCP and the e-mail address is outside the local network,
specify a gateway address (see previous prompt). A keyboard is required
to type in the e-mail address.

Communications
E-mail Server:

Enables entry of the numerical address of the SMTP server. If this
address is unknown, contact your IT department.

J-12
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Display Text

Description

IT may need to configure
the server to accept email
from the AccuPyc. The
following information
may be required:

¢ IP address for the
AccuPyc

« Sender line: Micro-
meritics-1340

IT may need to configure the server to accept e-mail from the AccuPyc.
The following information may be required:

o IP address for the AccuPyc

¢ Sender line: Micromeritics-1340

Communications Press CHOICE to select proper baud rate.

Baud Rate?

Communications Press CHOICE to select 8 or 7.

Data Bits?

Communications Press CHOICE to select 1 or 2.

Stop Bits?

Communications Press CHOICE until the required option (None, Even, or Odd) is dis-
Parity? played.

Communications Transmits data through the Xon/Xoff protocol. Press CHOICE to select
Xon / Xoff Protocol? Disabled or Enabled.

* Does not display for DHCP.

Unit Types

If not using the analyzer software, these keypad prompts enable selection or entry of:

e units of measurement
« operating language

o current date and time

Pressure units?

Display Text Description

Set-up Type? Press CHOICE until Unit Types is displayed, then press ENTER.
Unit Types

Unit Types Enables selection of unit type for reports. Press CHOICE to select the

desired unit.
Options are:

 psig (pounds per square inch gauge)

« kPag (kilopascal gauge)
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Date (DD/MM/YY)?

Display Text Description

Unit Types Enables selection of operating language. Pressing SAVE is not required.

Language?
Error messages that may be in the message queue will remain in English
(or the current selected language). Error messages that occur after
selecting the language will display in that language.
Keypad overlays containing translations for the alternate functions are
available for each language. Choose the language.

Unit Types The date is entered in a two digit format for the day, month, and year. For

example; to set the date for September 1, 2014, enter 01/09/14
(day/month/year). Use the . (decimal) key to enter a slash (/).

Unit Types
Time (HH:MM:SS)?

The time (in 24 hour format) at which an analysis begins and ends is
shown on all reports. The time shown on the display may not match the
current time.

The time is entered in a two digit format for the hour, minutes, and
seconds. For example; to set the time to 1:05 pm, enter 13:05:00
(hour:minutes:seconds). Use the . (decimal) key to enter a colon (:).

Setup Date, Time , and Language

. On the keypad, press Alt + 2 to enter Setup mode.

. Press Choice until Date displays, then press Enter and enter the current date.

1
2
3. Press Choice until 7ime displays, then press Enter and enter the current time.
4

. Press Choice until Language displays, then press Enter and select the correct language.

Calibration

See ""Calibrate Volume' on page 10 - 15.

J-14
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SOFTWARE INSTALLATION

If installing multiple analyzers, connect the Ethernet switch to the configured port on the
/ computer, connect the analyzers to the Ethernet switch, then turn the analyzers on.

The application should not be installed on a network drive with shared access. Multiple
/ users cannot operate the application at the same time.

If the computer is to be connected to a network, a second Ethernet port on the computer
/ must be used for that purpose.

These prerequisites must be completed prior to installing the software:

o Configure an Ethernet port on the computer to communicate with the analyzer. The IP address must
be 192.168.77.100. Reference the computer operator manual for instructions on changing the
IP address.

o Attach the analyzer to the computer’s configured Ethernet port. Use an Ethernet switch if multiple
analyzers will be attached.

1. Insert the installation CD into the CD-ROM drive. The program automatically starts the install-
ation. If the installation does not immediately start, navigate to the CD-Rom drive, then locate and
double click the setup.exe file.

2. On the Ethernet Introduction window, verify that all prerequisites have been met.
a. Ifnot, click Cancel and complete the steps, then restart the installation program. Do not
proceed with installation until these tasks have been completed.

b. If the prerequisites have been met, click OK.
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Ethemet Introduction L=

-
- - om
M| micromeritics’
NOTE: Be sure you have completed the fallowing tasks before continuing with this operation

1. Canfigure an ethernet port on this PC to communicate with the analyzer. Refer to the
‘Configuring the Ethernet Port topic in the 'Ethemet Configuration’ appendix of the Operatar's
Manual

2. Attach the analyzer to the configured ethernet port on this PC and apply power to the
analyzer. Referto the 'Hardware Installation' topic in the System Installation Instructions on
this CD.

If any of these steps have not been completed, please click Cancel and follow the instructions
indicated. Then start this program again

[s]3 Cancel

3. On the New Installation window, verify that sufficient disk space is available to continue the
installation. If not, click Exitand free up the minimum required disk space. If the disk space is
OK, click Next to accept the default installation directory, or click Browse to change the install-

ation location.

a. To add a shortcut to the desktop, select the Add the application icon to the Desktop.....

checkbox.

b. To allow all computer users access to the software application , select Install this applic-

ation for All Users.all users of the computer.

c. Click Next.

New Installation (=]

-
- - =
D'" micromeritics’
Welcome to the Micromeritics application setup program. This program provides installation and configuration

aperations for 1340 FoamPyc Version 1.09.

Setup will install this application in the following folder. Toinstallinto  difierent folder, click Browse, and selectanather
folder. “rou can choase to notinstall this application by dlicking Exitto exit Setup.

Destination Folder

i1 340foam Brows e,

Disk space required 8127k
Disk space remaining 234772418 k

 Add the application icon 1o the Deskiop o you can run the application from there.

Select fenter the name of the Start Menu Programs folder to which the application icon will be addech

[Micromeritics | Installthis application for All Users.

MNext Exit

4. On the Analyzer Configuration window, select I for the number of analyzers to be installed and

enter the analyzer serial number in the text box.

J-16
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Analyzer Configuration ==
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Step 1 Step 2
Select the number of For each unit, enter the necessary information below.
analyzers thatwil be The analyzer serial number is on the analyzer identification label. typically
attached to tis PC. located nearthe power switch

Select 0inthe case
thatyou are doing

oftine data reduction

anthis PC oryou are Unit Analyzer
maving an analyzer + Serel#
from another PG1a this

PC. 1
Analyzers foll1)

&1

couck cance

10. On the Ethernet Ports window, select one option from the following table:
Ethernet Ports. ﬂ‘

[M] micromeritics®

Please selectthe ethemet partinthis PC to which the analyzer will be attached

P Address Ethermet Port Name: Description

192168.77.100 ¢—
192168.77.100 ¢—

Ifthe portis notin the list sither

1. You have not configured the ethemet partin this PC ar you have nat attached the analyzer ta this PC
and turned! the analyzer on. Cancel this setup. perform the corective acion, and then un this setup
program again

2. YYour operating system did not provide information to this setup about the ethemst g
ports in this PC. Click the Specify butian to specify the portyou have configurad. [y

<Back Cancel

If... Then...
the configured port is listed Select the port, then click Next.
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If...

Then...

the configured port is not listed

Click Specify and enter the remaining portion of the

IP Address, then click Next.

/‘ The IP Address must be 192.168.77.100

Specify Ethemet Part

Enter the IP Address ofthe ethernet port

gz [7 Jim
The Subinet kask of the ethermet port:
o m

[Mi micromeritics®

Prowide information abowt the ethermet portin this PC to which the analyzer is connected

The third humber must be in the range
110 253,

The fourth number must be in the
range 2 to 253

Cancel

11. If prompted to configure a balance, select either 0 or /. The balance should be connectd to Com
Port 1. The default parameters should be OK. If not prompted for a balance, skip this step.

Balances - u‘
|
1

Mumber of Scientech balances:

Communications port:

o |

Parameters:

9600.n7.2

(]84 | Cancel |

12. On the Installation Complete window, click Finish.
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Installation Complete ]

[M] micromeritics®

1340 FoamPyc has been successfully installed.

Press the Finish bution to exitthis installaion.  Remove the setup media when this installation has exited
Reatme.new content
[AccuPyc 111340 FoamPyc

1. Improved validation of calibration data,

version 1.08
1. Supportior large sample cells was added

2. Supportior high-pressure analysis modules was added

3. Percent parosity calculation was added,

4.P1 equilibration data can be collected and reported -

START THE APPLICATION

To start the application, click the application shortcut on the desktop or select the application from the
Windows program list.

SPECIFY UNIT SELECTIONS
Options > Units

Use to specify how data should appear on the application windows and reports.

'8 Unit Selections @

Pressure ” kPag

1].4 | LCancel
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CONFIGURE AN ANALYTICAL BALANCE

Options > Configure Balance

Used to connect and set up an RS-232 balance to the analyzer. See ""Connect an Analytical Balance"

on page J - 6.

The analytical balance tested by Micromeritics is Scientec® model #ZSA120. See "Parts and

Accessories" on page 13 - 1.

(El Configure Balance

==

Serial Port:

Senal Parameters:

" Enable

[9600.n.7.2

COM1

Lancel

Configure Balance Fields and Buttons Table

Field or Button

Description

Enable / Disable

Select to enable or disable the attached balance.

Serial Parameter

Used to set the baud rate, parity, data bits, and stop bits. This field should
not require modification from the default values.

Serial Port

Select which serial port is used to connect the balance to the analyzer.
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REINSTALL OR MODIFY THE SOFTWARE

If the computer is to be connected to a network, a second Ethernet port on the computer
/ must be used for that purpose.

The Setup program is located on the installation CD. After initial software installation, if changes need
to be made to the analyzer setup, reinsert the Setup CD and follow the prompts.

o Reinstall the software version [#]

o Add an analyzer

o Move an analyzer

o Remove an analyzer

o Change analyzer setup

« Reinstall calibration files for an analyzer

o Uninstall

o Reset security to default

To access the Setup program:

1. Insert the Setup CD into the CD drive.
2. Locate and double click the Setup. EXE file.

If the IP address needs to be changed on the computer connected to the analyzer, refer to

/ the computer's operating system manual or the internet for instructions. The IP address for
the computer and the IP address specified in the setup program must match. The IP address
must be 192.168.77.100.
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UNINSTALL THE SOFTWARE

When the software is uninstalled, only the files required to run the application are removed. Parameter
files, sample files, reports, calibration files, and data files are not removed.

1. Insert the Setup CD into the CD drive.
2. Select the Uninstall option.
3. Follow the prompts.
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power on and off /- 12 volume 10 - 15
schematic 3 -9 volume scale 10- 6
show status 3 - 10 zero cell volume 10 -2
Analyzer Status 3 - 8 zero pressure 10 - 4
Analyzing, file status 3 - 6
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Calibrate Function, keypad 10 - 14
Calibration 10 - 1

Calculations B - 4

copy data 10 - 20

data, keypad 10 - 14

load data 10 - 20

load from file 10- 12

report 10 - 1

reset pressure [0-5, 10- 16

review 10- 17

save to file 70- 13

Temperature 10 - 19

verify operation 10 - 10

Zero the chamber volume (using the keypad)

10-19
Zero the pressure transducer (using the
keypad) 10- 19

Cell leaks

check for 12-6

check using software 12 -6

check using the keypad 12 -8
Chamber Cap O-Ring 12 -4
Circulating bath, attach F'- 1,J-5
Collected Data 5 -7
Combined Report

report example 7 - 24

report options & - /
Common Fields and Buttons 3 - 2
Complete, file status 3 - 6
Components

handling J - /

instrument / - 4
Computer

connect to analyzer J - 9
Configuration

AccuPyc Il -8
Contact Us ii
Control chart, report 7 -5

D

Data

review 2-11

view results 2 - 13
Data Entry, Keypad 2 - /

Density and Volume Table

report options &8 - /
Density vs Cycle Number

report options & - 2
Density vs Time

report options & - 3
Diagnostics, using Software 9 - /
Display 2 -1
Dust filter, clean /2-9

E

Equilibration
Report Example 7 - 29
Equilibration Report
report options & - 4
Equipment Options /- 7
Error messages
Keypad 4 - 19
Windows 4 - 1
Ethernet Switch, connect J - 9
Expansion Chamber
check for leaks 72-6
check for leaks using software /2 -6
check for leaks using the keypad 12 - §

F

Features and shortcuts
graphs 7- 13
tabular report 7 - 19

Files
default locations 3 -6
description 3 - 6
extensions defined 3 -6
status 3 -6

FoamPyc Option /-3

G

Gas Connection J - 6
Gas Requirements J - /
Gas Supply
Connect Gases /-2
Select Gases [-2
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Gases Reports, setup 2 -9
connect a replacement gas cylinder /2 - 13
disconnect the depleted gas cylinder 12 - 12 L
guidelines for connecting 12 - /1
replace a gas cylinder 12 - 12
Glove Box -8 Leaks,check for 12 -6
Graph Leaks,check using software 12 - 6
features and shortcuts 7 - 13 Leaks,check using the keypad 12 - §
generate overlays 7 - 20 List files 3 - 11
Report Example 7- 27
zoom feature 7 - 18 M
Graph Grid Lines 7 - 18
H Maintenance
guidelines for connecting 72 - 11
replace gas cylinder /2 - 12
Handling System Components J - / Manual mode 2 -5
Hardware components, install 77 - / Manual, about this iii
Material Parameters 4 - 6
I Menu structure 3 - /
Modules, connect /7 -
Multigas Option - 7,1-1
Insert MultigGas Option
1 cm3 Install 7- 1
install G -3 MultiVolume Inserts /-7, G -1
remove G -4
Inserts G -2
0.1cm3 G-3 N
lem3 G-3
10, 3.5,and 35cm3 G - 4 No Analysis, file status 3 - 6
install and remove G - 3
Operating Parameters G - / 0
Install
Hardware components /7 - /
Software Upgrade 3 - 14 O-ring
Installation chamber cap, grease 12 -4
software J - 15 chamber cap, replace 12 - 4
Installation Instructions J - / Option presentation 3 - 5
Instrument components / - 4 Options Report
Instrument log, show 3-§ report options &8 - 5
Overlay
K Generating Graph 7 - 20
Report Example 7 - 28
Overlays
Keyboard, connect J - 6 generate 7 - 20
Keypad multiple graph 7 - 22
about 2 -2 multiple sample 7 - 21
calibrate using 10 - 14
AccuPyc II Operator Manual — (Rev -) Index - 3

134-42800-01 — Dec 2014



Index

[M] micromeritics®

P

Parameter files

about 5- 1

analysis 2-7

analysis conditions 5 - 2

directory 5 - I

FoamPyc application 5 - 4
Parts and Accessories /3 - /
Power failure, recover from /2 - 10
Presentation option

advanced 4 -2

sample files 4 -2
Pressure and Volume Table

report options & - 5
Print files 2- 13, 3- 11
Printer, setup 17-3,J-11
Pycnometer

clean 12-10

configure J - 10

High Pressure Core [ -7

Large Volume Core /-7
Pycnometer Configuration Diagrams J - 2
Pycnometer Setup J - 2
Pycnometer, configure J - 10

Q

QuickStart Analysis 6 - 6

R

Recalculate SPC values
regression report 7 - 3

Regression Report 7 - 2
recalculate SPC values 7- 3

Regulator Pressure, S set with software 12 - 14

Regulator Pressure, set 12 - 14
Regulator Pressure, set with keypad 72 - 15
Report Example

Graph 7-27

Overlay 7-28

Sample Log 7 - 30

Summary 7 - 25

Tabular 7 - 26

Report examples 7 - 24

Combined Report 7 - 24

Report header shortcuts 7 - 70
Report Options 5 - 5

Density and Volume Tabe & - 7
Density vs Cycle Number § -2
Density vs Time & -3
Equilibration Report & - 4

Options Report 8§ -5

Pressure and Volume Tabe & -5
Sample Log Report & -5
Summary Report & - 6

Total Pore Volume vs Temp. & -7
Volume vs Cycle §-8

Reports

about 7- 1

axis cross-hair 7- 17
calibration 10 - 1

Combined Report & - 1
Control Chart 7 -5

Features and Shortcuts 7 - 9
generate graph overlays 7- 22
generate sample overlays 7 - 21
graph grid lines 7- 18

open and close 7 - 1
Regression 7 -2

setup using keypad 2 - 9

SPC 7-2

start 7- 1

Tabular 8- 6

toolbar 7- 11

zoom feature 7 - I8

Reset pressure calibration /0 -5
Reset pycnometer 12 - 11
Review, data 2 - 1]

RS-232 Pin Assignment E - /
Run Precision B - 6

Sample

Load 6-1
Prepare 6- 1

Sample cups

install and remove G - 3
properties 4 -5

Index - 4

AccuPyc II Operator Manual — (Rev -)
134-42800-01 — Dec 2014



[M] micromeritics’ fndex
Sample Defaults 3-8 T
edit 3-8
Sample file
advanced 4 -2 Tabular
basic presentation option 4 - 4 Report Example 7 - 26
create 4-2 Tabular reports & - 6
defined 4 - 1 features and shortcuts 7 - 79
open 3-12 TEC Module /-2, H-1
Sample log Asphalt Density Measurement H - 4
report §-35 operate H -2
Sample Log set temperature H - 1,J - 4
Report Example 7 - 30 Temperature Controlled Module /-9, F - 1
Sample overlays 7 - 21 Add an Analysis Module F - /
Sample Volume Equation Derivation C - / hardware setup J - 5
Schematic Temperature offset, calibrate 10 - 2
instrument 3 -9 Toolbar, Report 7 - 11
shortcut menus 3 - 10 Total Pore Volume B - 6
Selected Reports & - 1 Total Pore Volume vs Temperature
Sequence Analysis 6 - & report options & - 7
Shortcuts Total Solids Concentration B - 7
application 3 -7 Trademarks 2
keyboard 3 -7 Transmit 2 - 6
menu 3 -7 Transmitted Data
report header 7 - 10 Analysis Report D - ]
schematic 3 - 10 Calibration Report D - 3
Show instrument log 3 - 8 data units D - /
Show instrument schematic 3 - 9 Troubleshooting /2 - 1
Software
about /-6 U
reinstall or modify J - 21
uninstall 3-13,J-22
Software Installation J - 15 Unit selections J - 19
SPC report 7-2 Unit types J - 13
SPC Report Variables B - &8
Specific Gravity B - 10 V
Specifications [ - 10
Start the Application J - 19
Status Volume
analyzer 3- 10 calibrate 10- 15
Summary Volume Offset B - 4
Report Example 7 - 25 Volume Scale B - 4
Summary Report 8- 6 calibrate /0- 6
System Setup J - 10 Volume vs Cycle
report options & - 8§
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